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Introduction
to Now Utilities

Congratulations on your purchase of Now Utilities—the best-selling and award-winning
collection of file and system management utilities that's guaranteed to make your
Macintosh faster and easier to use. Throughout its existence, Now Utilities has been con-
tinually enhanced to provide a complete set of file and system management tools—version
6.0 is the most complete and integrated package yet. This Introduction provides an over-
view of the software and other information that will help you get started using Now Utili-
ties.
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Now Utilities feature overview

Here are just a few of the reasons why Now Utilities 6.0 helps you get more done on your
Macintosh every day:

* Puts files at your fingertips—Custom Menus let you jump instantly to any folder, docu-
ment or application; enhanced Open and Save dialog boxes give you quick access to
your frequently-used files and folders; assign Hot Keys to your most important menu
items in a flash; pop up hierarchical menus of folders and disks on your desktop so you
can put files where they belong quickly and easily, and navigate through nested folders
to get to your applications and documents just as easily.

« Ends desktop clutter with a handy bottom-of-the-screen organizational scheme. Win-
dows are easily popped open and shut, regardless of their location on your hard disks.

» Automates the creation of text macros. Use shorthand for commonly-used text such as
your hame, address, and boilerplate— Now AutoType™ automatically expands the
shortcut to display the full text.

« Find important files and folders among the thousands on your hard disk with powerful
and versatile searching options—save your frequently-used search criteria to be used
again with no hassle.

< Quickly and easily perform repetitive Finder tasks such as labeling icons, sharing fold-
ers, and moving items to the Trash.

« Stop software conflicts immediately—when your Macintosh starts misbehaving because

you installed a few new extensions, let Now Startup Manager do the detective work,
find the conflicting items, and even reorder them for you as necessary. And if you do

crash, you're protected because Now Save is saving your documents and recording your

keystrokes as you type.

» Makes desktop publishing easier—see font names in their actual typefaces when pulling
down Font menus, and create custom Font menus for specific applications; organize and

convert image files plus text, sounds and movies.

« Save valuable disk space—archiving and transparent compression capabilities are built-

in from Now Compress. Compress files into archives for sending them over a modem or

network, and increase your available hard disk space with no slowdowns.
« Take advantage of System 7.5—Now Utilities uses the drag-and-drop technology pro-
vided by System 7.5 to make configuring your menus and other options even easier.
Plus, support for PowerTalk workgroup software lets you e-mail a system configuration
to a help desk, or a catalog of image files to a colleague, in one easy step.
All of the Now Utilities components feature a button bar that provides quick access to
main functions. “Hot Help” displays short identifying labels for all buttons when you
pass the pointer over them. Balloon Help is included in each component as well.

Introduction to Now Utilities
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The Now Utilities components

Every component of Now Utilities 6.0 has been developed to offer the best competitive
features and capabilities in its category. We've focused on providing a consistent and effi-
cient user interface across components, and a product in which each component is
smoothly and sensibly integrated with its companions.

The Now Utilities collection includes:

Now AutoType™

New to version 6.0, Now AutoType™ lets you substitute shorthand keystrokes for longer,
often-typed text. Type your initials and Now AutoType™ expands it to your full name
(and your address, if desired, and more!). Set up shortcuts on your own, or let Now
AutoType™ do it for you— eitherway, you'll save time and keystrokes. Your over-
worked fingers will thank you!

Now FolderMenus™

Say goodbye to your cluttered, messy desktop! Now there’s no reason to leave files and
folders out on the desktop, because you can move them directly into any nested folder
within a hard disk by holding the mouse button over the disk’s icon and popping up a hier-
archical menu of its contents—navigate through the hard disk’s folders, highlight the des-
tination folder and release the mouse button.

Now Menus™

With Now Menus you can create unlimited Custom Menus that give you instant access to
whatever you want—documents, folders, applications, network servers, active applications
and much more. Navigate through hierarchical menus up to ten levels deep on the Apple
menu, and any other Custom Menu you set up. Assign Hot Keys to menu items on the fly,
set up application substitutions, and group applications and documents into Worksets to
open them quickly all at once.

Now Profile™

Now Profile helps you track down system conflicts by providing an instant, detailed analy-
sis of your system and its configuration. It creates detailed reports of your hardware,
memory setup, system software, extensions, control panels, fonts, applications, aliases,
and other items. Besides the obvious troubleshooting benefits, use it to clear your hard
disk of “lost” aliases and unnecessary duplicate files.

Introduction to Now Utilities



Now QuickFiler™

The fastest way to find any file on your hard disk or on a network server—you can con-
duct complex searches with multiple criteria like text within files, file size, modification

date and more; plus you can save your search criteria and re-use them later without having
to set them up again. When you find what you're looking for, you can copy, move, alias,
delete and more with just a click. You can even combine files into compressed archives for
quick transfer and save disk space with transparent compression.

Now Save™

Now Save helps protect you against data loss in case of system crashes, power failure, or
other accidents by automatically saving your work. Files can be saved after a specified
number of minutes, keystrokes, or mouse clicks. Also, every keystroke you type is saved
into special Saved Work files by the Key Capture function.

Now Scrapbook™

Now Scrapbook helps you to organize, view and store graphics (including PICT, TIFF,
EPS and cross-platform GIF formats), text files, sounds and QuickTime movies in special
catalogs that can be opened and scanned quickly. It includes a full-featured Clipboard Edi-
tor to crop or resize graphics and edit text.

Now Shortcuts™

New in Verson 6.0, Now Shortcuts™ simplifies common tasks such as sharing folders,
moving items to the Trash, duplicating anything, and making aliases. Now Shortcuts™
will cut the mileage your mouse and fingers travel significantly.

Now Startup Manager™

Now Startup Manager lets you optimize performance by controlling the loading of exten-
sions, control panels, startup items and even fonts. Reordering any of these items is
simple—drag them where you want them. Now Startup Manager disables extensions that
crash, and offers you the option of using automatic Conflict Isolation to hunt down the
conflict and usually resolve it with a single click. Links let you set up special relationships
for extensions that require each other’s presence, or for extensions that are incompatible.

Now Super Boomerang™

Consistently praised for its convenience and speed in tracking recent files and folders,

Now Super Boomerang makes it simple to locate and open the documents and applications
you use most—from the Apple menu, from the “Open...” command in applications, and
even within Open and Save dialog boxes. Finding lost files and folders is a snap, and you
can even copy, rename and delete files within Open and Save dialog boxes instead of go-
ing back to the Finder.

Introduction to Now Utilities 5
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Now Tabs™

Clean up that cluttered desktop using the all-new Now Tabs™. Windows can be parked, or
“docked,” at the bottom of your screen merely by dragging them there. A small, neatly-
labeled tab represents your window, and a single click on the tab pops the window open.
Pop-up buttons at either end of the tab bar allow access to recently used applications, files,
and folders, as well as offering quick methods for finding files, emptying the Trash, and
more.

Now Toolbox™

Although Now Toolbox has no user-selectable settings, it stores essential information for
the Now Utilities components and makes it available to them when necessary. Because
Now Toolbox contains a substantial amount of programming code that is common to the
various components, much less system memory is required to run the entire collection.

Now WYSIWYG Menus™

Now WYSIWYG Menus unites font families and displays font names in their actual type-
faces (What You See Is What You Get), allowing you to select the perfect font for your
document quickly. You can change the order, size and color of fonts in their menus glo-
bally or for each application. Now WYSIWYG Menus gives you the ability to create dif-
ferent font sets for each application and assign Hot Keys to individual fonts. The Font Info
area of the control panel lets you know whether TrueType or PostScript versions of fonts
are installed.

Introduction to Now Utilities



Included on the disk

Your Now Utilities master CD-ROM contains the items listed here.

Components

* Now AutoType

* Now FolderMenus

* Now Menus

« Now Profile

* Now QuickFiler (extension and control panel)
¢ Now Save

« Now Scrapbook

« Now Shortcuts

* Now Startup Manager

* Now Super Boomerang
* Now Tabs

¢ Now WYSIWYG Menus

Support files

« Archive Now, Compress NowandExpand Now—Drag-and-drop applications for
Now QuickFiler.

« Macintosh Drag and Drop—An Apple extension that makes possible many of the
drag-and-drop features included in Now Utilities when you’re running System 7.5.

* Now Menus Icons—A file containing special icons for use with Now Menus Custom
Menus.

* Now SB Extractor—A special file that allows Now Super Boomerang to search within
compressed files (note that although it's stored in the Extensions folder, it doesn't load
into memory at startup).

« Now Installer—The application that you use to place the Now Utilities components in
the correct locations on your hard disk.

« Now Toolbox

+ Folders to hold plug-ins extending the capabilities of Now Shoftarnd Now Tabs.

Informational files

* Read Me Now—A text file containing any late-breaking news or special notes on the
current release of Now Utilities.

» About Now Utilities—A Now Scrapbook catalog offering tips for getting started with
Now Utilities.

e Sample Catalog—A sample file for use with Now Scrapbook.

Introduction to Now Utilities

7



8

System requirements

Every Now Utilities component is fully tested and designed to work with the other compo-
nents on any Macintosh meeting these requirements:

All Macintosh and Power Macintosh models (Now Utilities is accelerated for Power
Macintosh where applicable)

System 7.0 or later

8MB of RAM installed minimum

A hard disk and a CD-ROM drive

About this User’s Guide

This User’s Guide includes an Installation chapter, plus one chapter for each of the twelve
Now Utilities 6.0 components. The component chapters are organized alphabetically.

This User’s Guide assumes you know how to use the Macintosh to open applications, copy
files, and open control panels and Chooser devices. A working understanding of System 7
features such as aliases and startup items is important as well. If you're new to the Macin-
tosh, refer to your Macintosh User’s Guide for additional information.

Notes and Tips

We've placed special icons in the left margin throughout this User’s Guide to draw your
attention to important points about using the Now Utilities components.

Text accompanied by this icon indicates something that is important for you to know about
the software in order to avoid problems or to ensure that you're successful in using it.

Text accompanied by this icon informs you of a special or little-known feature, or of a par-
ticularly time-saving Now Utilities function.

Button bar in components

Probably the most noticeable similarity between all of the Now Utilities components is the
button bar. Each component obviously has different buttons for different functions, but in
most components the three buttons at the far right are the same.

Preferences

Provides quick access to the
component’s Preferences dialog
box for setting general options

About

Opens a dialog box

providing information
Hot Help about Now Utilities
and the people who
worked on it

Displays short
identifying labels for all
buttons when you pass
the pointer over them;
click to toggle on/off

Introduction to Now Utilities



Because these buttons are identical in all of the components, they are not individually

identified in each chapter. Only buttons that are unique to a component are pointed out in

illustrations and procedures.

When the text directs you to click a button in the button bar in order to perform a function,
the button appears in the left margin, as shown here, to help you identify it in the compo-

nent.

If you never read manuals...

...that's okay with us. We just want to make sure that the Now Ultilities components are
properly configured on your Macintosh and ready to work as they should. To ensure this,

follow these simple steps:
1. Copy the Now Utilites 6.0 Installer from the CD to your hard disk.
2. Restart your Macintosh with the Shift key down.
3. Run the Now Utilities 6.0 Installer from your hard disk.
The Now Utilities components and support files are installed on your hard disk.

4. Restart your Macintosh when the installation is complete.

As the startup process begins, you'll be prompted to personalize your new software.

5. Click “Personalize...” and enter the requested information, including the registration number
found on your Now Utilities 6.0 CD, then click “OK.”

The startup process continues.

I If this is a new installation, Now Startup Manager will open just after your
*~  Macintosh restarts. For now, just click “OK” in Now Startup Manager’s win-

dow to proceed with startup. For more information on what to do at this point,

go to Chapter 10, “Now Startup Manager,” and see the “Controlling startup
files during the startup process” section.

6. After restarting, you can start to explore the Now Utilities components at your leisure.

Even if you just go about your normal daily tasks, it won’t be long before you see the
benefits of having Now Utilities installed. Return to this User’'s Guide when you want

specific information on using a component.

Introduction to Now Utilities
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Technical support

Now Software is committed to providing prompt and courteous technical support. If you
can't find the answer to your problem in this User’s Guide, the Quick Reference Guide or
the Balloon Help, our technical support staff is glad to assist you. When calling us for
technical support, please be at your Macintosh if possible, and have the following informa-
tion ready:

* Your registration number, located on your Now Ultilities 6.0 CD.

* A description of your problem—what specifically occurs and when, how severe the
problem is, what error numbers or messages are displayed when the problem occurs, and
anything else you notice about the circumstances of the problem.

» Results of any Conflict Isolation testing you may have done using Now Startup Manager
(see Chapter 10, “Now Startup Manager” for more information).

A profile of your Macintosh (see Chapter 5, “Now Profile,” for information on creating
a profile).

Now Software can be reached for technical support through a variety of methods. The
most efficient option is our FaxBack automated information retrieval system. This system
contains a large assortment of documents that have been created to answer the most fre-
guently-asked technical support questions, and to offer helpful tips on using our products.
Just call 503-274-6370 from a voice telephone, listen to the catalog of documents, and fol-
low the simple instructions for ordering one or more documents. The system will ask you
for your fax number, and then will send the document(s) to your fax machine when you
hang up.

Our World Wide Web site (http://www.nowsoft.com) also contains many of the same
technical support documents that are available through FaxBack, as well as late-breaking
news, software updates and demonstration versions of many of our products.

Finally, the most direct route to technical support is through our live, toll-free technical
support number. Please call 206-654-7929 to reach a technical support representative.
Your first 60 days are free. There are several pay-for-support options available after the 60
day free period.

Faxback (503-274-6370)

World Wide Web Site (http://www.nowsoft.com)
AOL Forum (Keyword: Now)

MSN Forum (Keyword: Nowsoft)

Phone support (206-654-7929)
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Chapter 1
Installing Now Utilities

Installing Now Utilities is simple—the Now Installer included on the Now Utilities CD-

ROM does all of the work for you, and puts everything where it belongs. We recommend
that you follow the instructions in this chapter on using the Now Installer application, be-
cause it removes any previous versions of Now Utilities and places each component in the
correct location on your hard disk.

To Now Utilities 5.0 usersThe Now Installer handles upgrading to version 6.0 grace-

fully, so you don’t need to move or delete any files before installing. Now Utilities 5.0
components are simply replaced by their version 6.0 counterparts, and your settings for
those components are incorporated into the preferences of the new ones. The components
that are new to version 6.0 are placed where they belong, with their default settings.

To Now Compress 1.0 usershe Now QuickFiler component of Now Utilities incorpo-

rates the features and functions of Now Compress and adds many more. For this reason,
the Now Installer replaces Now Compress with Now QuickFiler, converts your Now Com-
press settings, and places the Now Compress software in a “Replaced Items” folder inside
the “Now Utilities"” folder.

Installing Now Utilities using the Now Installer ..............cccccoeiiiiiiee. 13
Where Now Utilities is installed on your hard disk................cccccceiiiieennnnn. 15
Installing Now Utilities from a Network Server ..........cccecevveeeeeeeeeeeveeeeenninnn, 16
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Installing Now Utilities using the Now Installer

The Now Installer application is designed to place the Now Utilities components in their
correct locations automatically.

To install Now Utilities:

1. Drag the Now Utilities 6.0 Installer from your master CD to your hard disk.
2. Restart your Macintosh while holding the Shift key down to turn off extensions.

This step is very important—installing any new software product while exten-
sions are active can result in corrupted files and other problems.

3. Double-click the Now Installer icon on your hard disk to open the application.

A “splash screen” appears as the Installer opens. Click the Continue button to go on.

Now Utilities 6.0

12 Waps fo Ger More fram prar Mac!

A Read Me window appears; you may save or print its contents. Do one of those, then
click Continue. A third screen appears, describing the Now Utilities and the amount of
disk space required for the installation.

4. Click “Install” to begin the installation process.

A dialog box appears, notifying you that your Macintosh will be restarted immedi-
ately after the installation. Click “Yes” to continue.

A second dialog box appears, asking you to specify a location for the parts of the Now
Utilities that do not get installed into the System Folder. Choose a location, and click
the Install button. Installation begins and the Installer displays a progress dialog box.

When the installation is complete, the Now Installer displays a results dialog box.
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5. Click “Restart.”

Your Macintosh restarts. Soon a Now Utilities personalization dialog box appears on
your screen. This dialog box offers you the option of using the software on a demon-
stration basis, or personalizing the software with a valid registration number.

5o

E\'elcome to Now Utilities 6.0!

If you have purchazsed Mow Utilities, click the
Perzonalize... button. You'll be asked for the serial
rurnber printed on your registration card. Until you |
enter it, the software operates in demo mode. i

To try out Mow Utilities for one working week , press |
the Dermo button. dfter the demonstration period i
expires, the software removes itself. To purchase |
Mow Utilities, call 1-200-629-9419. ]

]

10. Click “Personalize...”.

A personalization dialog box opens, prompting you to enter your name, organization
(optional) and the registration number found on your Now Utilities 6.0 CD-ROM.

11. Enter the required information, taking care to type your registration number correctly, then click
IIOK.!i

The startup process continues, and the new Now Utilities components are loaded into
memory. You're ready to enjoy the enhanced productivity of Now Utilities!

|  Tonew usersif this is the first time you've installed any version of Now Utili-

*  ties, Now Startup Manager will open just after your Macintosh restarts and be-
fore any other startup files are loaded into memory. For instructions on how to
proceed when Now Startup Manager appears during startup, go to Chapter 10,
“Now Startup Manager,” and see the “Controlling startup files during the
startup process” section.

12. An electronic registration form appears. If you are already registered you may so indicate. If
you are not, you may fill out the form on your screen and modem, fax, or mail the filled out
form to Now Software.
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Where Now Utilities is installed on your hard disk

During the installation process, Now Utilities files are placed on your hard disk as follows:

The Control Panels folder will contain Now AutoType, Now FolderMenus, Now Menus,
Now QuickFiler, Now Save, Now Shortcuts, Now Startup Manager, Now Super Boo-
merang, Now Tabs, and Now WYSIWYG Menus. It will also contain two folders: Now
Shortcuts Plug Ins Folder, and Now Tabs Plug Ins Folder.

The Extensions folder will contain Macintosh Drag and Drop (if you are not running
System 7.5 or higher), Now Toolbox, Now QuickFiler Extension and Now SB Extrac-
tor.

The Preferences folder will contain a folder called “Now Utilities Prefs"—inside this
folder will be preferences files for Now AutoType, Now FolderMenus, Now Menus,
Now QuickFiler, Now Save, Now Startup Manager, Now SuperBoomerang, Now
WYSIWYG Menus, plus a “Now Toolbox Prefs” file and a “Now Menus Icons” file.

The System Folder will contain these folders: Control Panels (disabled), Extensions
(disabled), Saved Work Folder, Startup Items (disabled), and System Extensions (dis-
abled). If Now Startup Manager finds a duplicate extension, it creates a new folder
named Duplicate Items in the System Folder.

The Saved Work Folder will contain a date-stamped Saved Work file (part of Now
Save’s Key Capture feature).

The Apple Menu Items folder will contain aliases of Now Scrapbook and Now Super
Boomerang.

Your hard disk will contain a folder called “Now Utilitie6.0"—this folder contains
Archive Now, Compress Now and Expand Now (drag-and-drop applications for Now
QuickFiler); Now Profile and Now Scrapbook; several sample files for Now Scrapbook,
including a Now Scrapbook catalog offering tips for getting started with Now Ultilities
(“About Now Utilities”); and the “Read Me Now” text file containing important late-
breaking news about the software.

If you're a Now Compress 1.0 user, the Now Installer removes the Now Compress soft-
ware from your System Folder and places it in a “Replaced Items” folder inside the “Now
Utilities™” folder. Your version 1.0 drag-and-drop applications (Archive Now, Compress
Now and Expand Now) are updated to the Now QuickFiler 6.0 versions.

Chapter 1—Installing Now Utilities
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Installing Now Utilities from a network server

If you support a workgroup of Macintosh users and have purchased Now Utilities for this
group, it's probably easier and faster for your users to install directly from a network
server rather than using a CD-ROM. It's simple to set up for this type of installation.

On the server volume, create a folder called “Now Utilities 6.0.” Insert the Now Utilities
CD-ROM, select all of the items it contains, and drag them into the folder. Once the copy-
ing is complete, your users can install Now Utilities 6.0 by opening the folder you created
and double-clicking the Now Installer.

If you create a special password-protected version of Now Startup Manager to specify and
preserve settings for displaying or excluding certain startup files, you can make sure it's
installed during this process by simply copying it into the “Now Ultilities 6.0” folder—
there’s no need to remove any files. The Now Installer will see the special version you've
added to the folder, and install it instead of the “generic” Now Startup Manager. The same
is true if you create special settings for Now Menus or any other component and want to
distribute them throughout your group—placing the resulting preferences file in the net-
work installation folder will cause it to be installed instead of the default file.
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Chapter 2
Now AutoType

Now AutoType makes word processing a snap, letting you write in shorthand and expand-
ing it as you go. You're able to define shorthand codes for words, phrases—even whole
paragraphs. What's more, Now AutoType keeps track of what you type and will suggest
words, phrases, and paragraphs that you should consider making shorthand codes for.

Now AutoType can be set to expand codes in the background (as you continue typing), to
expand codes if you press a triggering keystroke combination, and to automatically insert
text (no codes required) if the proper keystroke combination is pressed. Regardless of the
method(s) you use to execute these “text macros” Now AutoType will save you time and
trouble as it automates the typing of oft-entered text.

USING NOW AULOTYPE c.ceeiiitiiiiiieee e e e e e e ettt s e e e s e e e e e e e e eeeeeeeeensennnnns 19
Making a macro by hand ............cooouiiiiiiii 19
Making a macro automatically .............cceeeeiiiiiiiiiiicc e 22
Letting Now AutoType initiate the ProCeSS.........ccccvviiiiiiiie e 22
Using the Suggest Macros NOW BUHON ...........oooiiiiiiiiiiicc e 22
Making a macro based upon the Clipboard ............cccooviiiiiiiii e, 23
The EXPANSION IMENU ......uuiiiiiiiiiiiiiiieeeee e 23
Now AUtOTYpe CONLIOl PANEI ......evvieiiiiieie e 24
(0] 0@ i o TV 1 (o] o [ PP ERRRR 24
AULOTYPE LISEDULION oo 24
SENGS DULION ...eiiiiieii et e s e e e e e e 24

Chapter 2—Now AutoType 17



18 Chapter 2—Now AutoType



Using Now AutoType

Right out of the box, Now AutoType is ready to go to work for you. You can create your
own macros immediately, let Now AutoType create them for you, or both. Simply type a
code, press a key, and bingo—the text expands, as if by magic.

Now AutoType works in any application that accepts text. Besides helping with word pro-
cessing chores, Now AutoType can assist with databases, e-mail, and more—anywhere

you type.

Since Now AutoType inserts text by actually typing, just as you would if you typed it
yourself, using Now AutoType’s macros is extremely intuitive. Merely move your text
insertion point to the point where you want the text to be typed, then trigger the macro.

Making a macro by hand

Making a macro by hand means you define both the text you want Now AutoType to type
and the triggering mechanism, with no assistance from Now AutoType’s automatic macro
generation. These macros are typically easy-to-think of text strings such as your return ad-
dress and “Sincerely yours, Joe Smith.”

Regardless of what you want Now AutoType to type, you'll have three options when it
comes to triggering options. These options (shorthand code that expands when you con-
tinue typing, shorthand code that expands when you press a special key, and text-inserting
keyboard combination) are described below.

Making a macro that expands when you continue typing

1. Open the Now AutoType control panel.
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2. Click the Auto Type List button.
If you haven'’t created any macros yet the list of macros will be empty.
3. Click the New button.
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A dialog box appears. Use the pop-up menus to indicate that you want to enter a
shorthand code and to expand the code when you continue typing.

4. Type the shorthand code in the box next to “When | Type this text:”
Shorter is better, and easy-to-remember is better than that.
4. Type the full, expanded text in the “Replace it with:” box.

You can include returns and tabs (and anything else you can type) in this area. Don't
worry about making mistakes in this box—you're able to edit what you type.
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5. Click “OK.”

You're returned to the Now AutoType control panel. Your shorthand code will auto-
matically expand as soon as you type it and move on.

Making a macro that expands when you press a Hot Key
1. Repeat steps 1 and 2 from the previous example.
2. Click the New button.

Use the pop-ups to indicate that you want to enter a shorthand code and to expand it
when you press a Hot Key.
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3. Enter a Hot Key.

1. You can use the same Hot Key for all your macros. Of course, the shorthand
codes still have to be unique.

4. Click “OK.”
Your shorthand code will now expand after you type the code and press the Hot Key.

Making a macro that inserts text when you press a Hot Key

1. Repeat steps 1 and 2 from the previous example.
2. Click the New button.

Use the pop-ups to indicate that you want text to be inserted when you press a Hot
Key.
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This is different than typing a code and then pressing a Hot Key. A macro that
inserts text when you press a Hot Key doesn't require a code!

3. Enter a Hot Key

With this kind of macro it is important that each macro have a different Hot Key.
4. Click “OK.”

If you try to use a Hot Key that is already in use you will not be able to click the OK
button.
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Making a macro automatically

While it's simple to make macros by hand it's even easier to let Now AutoType make
them for you. Merely go about your daily work and Now AutoType watches what you do,
searching for text you type over and over. Examine the list, choose items that you'd like a
macro for, and assign a triggering mechanism (code alone, code plus Hot Key, or Hot Key
alone).

Letting Now AutoType initiate the process

Now AutoType will offer a list of text macro candidates every 8 hours. Rather than show
you everything you've ever typed, Now AutoType narrows the list to longer text strings
that are frequently entered. You can dismiss all of the candidates, accept all of the candi-
dates, or accept some of the candidates. (If you accept any of them you will have the op-
portunity to specify triggering mechanisms.)

Using the Suggest Macros now button

You don't have to wait eight hours to get a list of automatically-generated macro candi-
dates. You can, at any time, click a button and let Now AutoType generate an up-to-the-
minute list of macro candiates.

I This can take some time.

Generating a list of macro candidates on demand

1. Open the Now AutoType control panel
2. Click the “Settings™ button

You'll get a dialog box telling you that the process may take awhile.

The scan has begun and may take a while. You will be
s notified when it is complete!

3. Click *“OK.”

Now AutoType begins to generate the list of potential macros. When it's done, you're
presented with the list. Choose the items you’'d like to include as macros, click “OK,”
and they’re added to Now AutoType’s list of macros. From there you can edit them
(assign shorthand codes, Hot Keys, etc.). If you don’t want any of the items you can
click “Keep None.”
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Making a macro based upon the Clipboard

In addition to the manual and automatic methods of creating text macros, Now AutoType
lets you make create a macro based upon the text currently on the Clipboard. This allows
you to make macros on the fly, from within any application.

Making a macro based upon the Clipboard

1. Select and copy the text you'd like to make a macro for.

2. Press the keyboard shortcut (by default, Command-Shift-Option-Con-
trol-A).

3. Now AutoType opens, with your text entered in the “Replace it with:” box.

4. Assign a triggering mechanism and you’re done.

The Expansion Menu

Besides the three “regular” methods of triggering a macro, Now AutoType offers a fourth:
a pop-up menu displaying all currently defined macros.

Using the Expansion Menu

1. Move your cursor to where you would like to insert text.

2. Hold the proper keys (by default, Option-Command-Control) and click the mouse. Keep the
mouse button down.

A pop-up list of all defined macros appears where you click.
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3. Slide to the text you’d like to insert and let go.

The text is inserted.
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Now AutoType control panel

The Now AutoType control panel is easy to configure. Among other things, it lets you
specify the keyboard shortcuts for popping up the Expansion menu and for creating mac-
ros based on the Clipboard.

On/Off button

n The “On/Off” button lets you turn the Now AutoType functions on or off without restart-
=1 ing.

AutoType List button

Qlick the AutoType List button to display your text macros and their triggering mecha-
nisms.

Settings

- Click the Settings button to access this pane. From it, you can set triggering mechanisms
for popping up the Expansion menu (note that you must check at least one modifier key if
you want to use this feature) and for creating macros based upon the Clipboard’s contents.
You may also initiate the automatic creation of macros within this pane.
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Chapter 3
Now FolderMenus

Now FolderMenus is a simple but extremely useful component—it gives you the ability to
“pop up” a menu of any folder’s or volume’s contents just by clicking on the item and
holding down the mouse button. You can then view the contents of nested folders, and
open folders or documents within folders by selecting them and releasing the mouse but-
ton. You can even move an item into a folder simply by dragging its icon to the folder,
popping up the folder menu, and dragging it to the desired nested folder.

With Now FolderMenus, your hard disk is better organized, because instead of cluttering
up the desktop or your hard disk window by placing items there temporarily, you can eas-
ily file items in the desired locations immediately.
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Viewing @ fOlder'S CONLENTS ........ciiiiiiiiie i ee e 27
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Opening documents by dragging to applications ............cccccceeeieiieieiiineenn. 28

Now FolderMenus control panel Settings ..............uvviiiiiiiiee e, 29
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Using Now FolderMenus

Since Now FolderMenus’ functions are active as soon as you install Now Utilities, you can
see it at work immediately in the Finder. Notice that the icons of any folders that are not
empty include a small arrow (this is true in any Finder view—Icon, Small Icon or List—
whether a custom icon exists or not). Note that the small arrows can be turned off if de-
sired—see “Displaying Menus” later in this chapter.

(o

Correspondence

Hard disks and other volumes on your desktop are also available for Now FolderMenus
functions. References to “folders” in this chapter should be read as including desktop vol-
umes as well.

Viewing a folder’s contents

To see a pop-up menu of a folder’s contents, just click on its icon and hold down the
mouse button. A menu pops up, displaying the folder’'s contents.

[T Artwork

[7] correspondence

[7] Databases

To see the contents of any folder located inside the folder, just highlight its name to dis-
play a submenu of its contents.
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To open a window in the Finder for one of these folders, just highlight its name and re-
lease the mouse button. You can move up to ten levels deep through the hierarchy of the
folder.
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Moving items into folders

The Finder already allows you to drag an item to a folder icon to place it inside the folder.
But with Now FolderMenus installed, you can drag an item to a folder and place it inside a
folder nested within, up to ten levels deep.

To do so, just drag the item to the outer folder and hold down the mouse button. The
folder’'s contents are listed in a pop-up menu; navigate through the menu until you find the
desired folder, then “drop” the item inside it by releasing the mouse button. Hold down the
Option key during this process to copy the item into the folder instead of moving it.
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Opening documents by dragging to applications

Though you can easily open documents in their creating applications by double-clicking
them, Now FolderMenus makes it easy to open a document in a different application than
the one that created it (opening a SimpleText document in Microsoft Word, for example,
or opening an application in ResEdit), or in a specific copy of an application of which you
have multiple copies stored on your hard disk.

As with moving items, just drag the document’s icon to the folder containing the applica-
tion (or an outer folder), hold down the mouse button, and navigate through the pop-up
menus as necessary to locate the desired applications. When you find it, highlight the ap-
plication name and release the mouse button. The application opens the document.

This technique is also very handy for drag-and-drop applications, like those included with
Now QuickFiler (Archive Now, Compress Now and Expand Now). To reduce clutter on
your desktop, place all of your drag-and-drop applications in a folder and then drag docu-
ments to the folder icon to use the applications.
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Now FolderMenus control panel settings

The Now FolderMenus control panel is quite straightforward. Among other things, it lets
you specify how long the delay is between clicking on a folder and popping up the menu,
and lets you control the display of icons in the menus.

On/Off button

The “On/Off” button lets you turn the Now FolderMenus functions on or off without re-
starting.

Activating folder menus

To view and modify these settings, click the “Activating Menus” button, if this area isn’t
already active.
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The settings for this area are listed below.

This option... Specifies that...

Menu pop-up delay Once you click on a folder icon, Now FolderMenus
will wait the amount of time selected here before pop-
ping up the menu of its contents. This allows you to
prevent the Now FolderMenus functions from interfer-
ing with dragging folder icons in the Finder. You may
want to experiment with this setting to balance the
speed of the pop-up menu with your working style.

Pop up immediately if pressing The pop-up menu will appear immediately when you
click on a folder icon while pressing the key(s) se-
lected here.
<1, Ifyou frequently hold down the Command key to

align items to the grid as you drag them in the
Finder, you may not want to select this key
alone for popping up a folder menu instantly.

Never pop up if pressing The pop-up menu will not appear when you click on a
folder icon while pressing the key(s) selected here.
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Displaying menus
‘g To view and modify these settings, click the “Displaying Menus” button, if this area isn't
already active.

=3 ki Foldaiinis
| ] o]
Sy iy TR

E!-l-a-'\- Eldary with HTEey

[ Sierw ol i W

The settings for this area are listed below.

This option... Specifies that...
Show folders with arrows Folder icons will show small arrows in all views, indicating
that you can pop up a menu of their contents.
Show icons in menus Icons will be displayed next to the items appearing in pop-up
folder menus.
... Deselecting this option can speed up the appearance

v of pop-up folder menus.
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Chapter 4
Now Menus

Now Menus helps you to be much more productive with your Macintosh in many different
ways. You can create convenient menus in the menu bar that give you quick and easy ac-
cess to whatever items and functions are most important to you. You get constantly-up-
dated lists of your recently-used folders, documents, applications and more. You can
assign your own custom Hot Keys to any menu item, even replacing the Hot Keys as-
signed to menu commands in your applications. You can even configure applications so
that they open with special color and sound level settings that you specify, to suit the kind
of work you do with them.
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Now Menus Concepts

Now Menus provides a wealth of functions to help you work faster and more efficiently on
your Macintosh; this section is a brief overview of the areas in which Now Menus en-
hances your system.

Enhanced Apple menu

The Apple menu is System 7’s built-in “Custom Menu,” providing relatively quick and
customizable access to control panels, desk accessories, folders, and other items that you
place in the Apple Menu Items folder. Now Menus gives you greatly-enhanced control of
the Apple menu, with hierarchical submenus for folders up to ten levels deep, plus exten-
sive options for rearranging the menu contents and changing the overall appearance of the
menu—and you never have to open the Apple Menu Items folder.

The Apple menu is significantly different from the Custom Menus that Now Menus can
create, because the items it displays represent the contents of the Apple Menu Items folder
inside the System Folder. When you add or remove items in the Apple menu using the
Now Menus control panel, you're actually creating or deleting aliases (and sometimes ac-
tual files) in the Apple Menu Items folder.

The System 7.5 Apple menu provides certain new functions like hierarchical submenus
and access to recently-used documents and applications, but you'll find that Now Menus
offers much more functionality and customizability, plus much easier access to configur-
ing its options. For example, highlighting the Monitors control panel in the Control Panels
submenu displays an additional submenu allowing you to choose a color depth setting
without having to open the control panel; and highlighting the Sound control panel lets
you choose a sound level immediately.

Custom Menus

Custom Menus can be pulled down from virtually any location in the menu bar, or popped
up by clicking on the desktop or while holding down a key combination. When you set up
a Custom Menu, you're not manipulating aliases in a folder as with the Apple menu—
you're just adding items by name to appear in the menu. Just as in the Apple menu, you
can display applications, documents, folders and more in Custom Menus. In addition,
however, Custom Menus can include Smart Items, which let you find files, display re-
cently-used files, switch between active applications, and much more.

Using the available options, you can create Custom Menus that display all active applica-
tions plus the contents of the menu bar, all recently-used documents, the contents of the
System Folder, a list of network servers, or many other possibilities. By default, there are
Custom Menus at the far left and right edges of your menu bar—the “Left Pull-Down”
menu on the left side shows a list of your recently-used applications, and the menu on the
right side shows a list of recently-used documents. In the middle of the menu bar are two
Movable Pull-Down Custom Menus—one, titled the “Now Ultilities Menu,” gives you in-
stant access to the Now Utilities components; the other, titled “Drive Menu,” displays the
contents of your startup disk for easy access. These are simply the default settings for
these menus—you can set them up any way you like.
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I If you're upgrading from Now Utilities 5.0, Now Menus 6.0 reads your version 5.0 prefer-

*~ ences and sets up your menus as they were under the previous version. If you want the
Now Utilities Menu or the Drive Menu in your menu bar, you can set them up easily (see
“Creating Custom Menus” later in this chapter).

Hot Keys

For applications in which some menu items don’t have predefined Hot Keys, or keyboard
shortcuts (8-S” for Save, for example), or in which you want to change the original ones,
Now Menus lets you easily assign your own or even redefine existing ones. You can create
Hot Keys for commands in the Finder and any other application program, as well as any
item in the Apple menu or a Custom Menu. Hot Keys usually include one or more modi-
fier keys (Command, Control, Shift, and Option), along with any character on the key-
board; the function keys on an extended or adjustable keyboard work alone, as well.

Dragging Finder items into menus

For the ultimate time-saver, Now Menus lets you use your custom-configured menus to
open, move, copy and even delete items in the Finder. Just drag the icon of a document
into the menu bar and down into any location on a menu. If you drag it to its creator
application’s name, it's opened by the application; if you drag it to a folder name, it's
placed in that folder; if you drag it to an alias of the Trash, it's moved to the Trash.
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Worksets

While the Macintosh system software lets you open multiple applications and documents
simultaneously by selecting their icons in the Finder and choosing “Open” from the File
menu, you're limited to selecting only items displayed in the same window. This limita-
tion makes it difficult to open multiple applications and documents at once. When you cre-
ate Worksets with Now Menus, however, you can quickly open multiple applications and
documents simultaneously without searching through folders to locate and open each ap-
plication and document one at a time. For example, you can create a Workset called “Fi-
nancial Reports” that contains FileMaker Pro, Microsoft Word, and Microsoft Excel and
open it whenever you want to create a report.

Each Workset you create contains a list of applications and documents. The Workset ap-
pears as an icon on the desktop. To open the applications and documents in the Workset,
just double-click its icon. Just like any other file on your hard disk, you can place a
Workset on a Custom Menu and launch it quickly from there.

Application Substitution

You're probably familiar with the situation of trying to open a text document created in an
application that you don’t have (opening a WordPerfect document in Microsoft Word, for
example). Now Menus can automate this process through its Application Substitution fea-
ture. Once you specify in Now Menus that you want documents created by one application
to be opened by a different one (provided that the application is capable of opening the file
type in question), just double-clicking a document causes it to be opened by the applica-
tion you specified.
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Using the menus

This section explains how to use the menus that Now Menus can create. The table below
lists the various menus and how you can view their contents.

To view... Click...

The Apple menu The Apple icon at the left end of the menu bar.

The Left Side Pull-Down At the far left end of the menu bar (this menu and the follow-
ing ones are all referred to as Custom Menus).

The Right Side Pull-Down At the far right end of the menu bar.

A Movable Pull-Down Its icon in the menu bar (you can create as many Movable
Pull-Down menus as your menu bar space permits). You can
change the position of a Movable Pull-Down by holding
down the Command key and dragging its icon.

The Desktop Pop-Up Any visible portion of the desktop, even if the Finder isn't the
frontmost application.

A Modifier Key Pop-Up  Anywhere on the screen while holding down the modifier key
combination that you specified.

This section discusses the contents of the menus under the Now Menus default settings.
See the following sections of this chapter if you want to create new Custom Menus or
modify any of the menus.

When you’ve pulled down a menu and you want to “release” it without opening anything,
move the pointer out of the menu and release the mouse button (or, if you have “Menus
‘stick’ when pulled down” selected in Now Menus preferences, click the mouse button out-
side the menu).

Opening folders
A folder can be made to appear in a menu in three different ways:

» By specifically adding the folder to the menu using the Add Folders pop-up menu in the
Now Menus control panel.

* By adding the “(Recent Folders)” Smart Item to the menu using the Add Smart Items
pop-up menu in the Now Menus control panel—when you view the contents of the
menu, the Smart Item will display a list of folders in which you've recently opened and
saved documents and applications.

« If you're running System 7.5 or later, you can drag a folder directly from the desktop
into the menu items list of the Now Menus control panel.

See “Configuring Custom Menus” later in this chapter for information on adding items to
menus.
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To open a folder from a menu, just select the folder name and release the mouse button—
the folder’s Finder window opens, just as if you'd double-clicked the folder’s icon.
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Note that selecting a folder name and holding down the mouse button displays a submenu
listing any contents of the folder—this is a quick way to view a folder’s contents (or to
open documents it contains—see “Opening documents in their applications” later in this
section).

If the folder you want to open is nested inside another folder or folders, you can navigate
through the hierarchical menus, up to ten levels deep, until you locate the folder you
want—just drag the pointer to each successive folder you want to see. Then open it as de-
scribed above.
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.1, Ifyou find that you're often navigating through several levels of folders to get to the same
one, you can save time by adding the folder to the menu itself.
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Openlng appllcat|ons

You can open an application by choosing its name from any menu on which it appears. By
default, a list of recently-opened applications is installed in the Left Side Pull-Down menu.
If the application you want to open doesn’t appear on any menu, you can navigate through
folders as described above to find the folder containing the application, and then choose
the application’s name from the submenu attached to the folder.

Another way to open an application that doesn’t already appear on a menu is to use the
“Other..” command. Choosing this command opens a dialog box that lets you navigate
through your hard disk to find the application you want, then double-click its name to open

it.
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The dialog box also gives you the option of permanently adding the application to your list
of recent applications. Th&ther..” command must be installed on one or more of your
menus in order for you to use it—by default, it's installed at the bottom of the Left Side
Pull-Down menu (see “Using th®ther..: command” later in this chapter for more infor-
mation).
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Opening documents in their applications

Just as choosing an application name from a menu will open the application, choosing a
document name will open the document in the application that created it. There are two
ways to open documents in applications:

» By navigating through the menus to locate the folder containing the document, then
choosing the document name from the submenu attached to the folder name, or

» By navigating through the menus to locate the application that created the document,
then choosing the document name from the submenu.

Now Utilities keeps track of which documents you use, and lists them on submenus at-
tached to the applications that created them. The recent document submenu appears when-
ever you highlight an application name.
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Special submenus

Now Menus enhances your access to certain items on your system by attaching special
submenus to them that allow you to select options quickly without opening extra windows
or control panels. You can select a printer or AppleShare volume, change the sound vol-
ume or the color depth settings of your monitor, and more.

The items listed below normally appear on the Apple menu, but note that you can install
them on any Custom Menu as well.

To select... Highlight...

A printer The Chooser (usually in the Apple menu) and select a printer
driver from the submenu; the Chooser opens to display the avail-
able printers for that driver.

i, To select a printer quickly, hold down the Command key
while choosing a printer device from the submenu (there
must be only one printer available for that driver in order
for this to work).

An AppleShare volume The AppleShare item on the Chooser submenu, then choose the
desired volume from the AppleShare submenu.

| A server name appears on the AppleShare submenu only if
you have recently mounted it and opened an application or
document stored on it.

A sound level The Sound control panel (usually found in the submenu attached
to “Control Panels” on the Apple menu) and choose the desired
level from its submenu.

A color depth setting  The Monitors control panel (usually found in the submenu at-
tached to “Control Panels” on the Apple menu) and choose the
desired color depth from its submenu.

| Any changes you make to the color depth settings in this
way are temporary; the settings revert to whatever is con-
figured in the Monitors control panel the next time you re-
start.

A startup disk The Startup Disk control panel (usually found in the submenu
attached to “Control Panels” on the Apple menu) and from the
submenu, choose the desired disk to start up from on the next re-
start.

A Startup Set The Now Startup Manager control panel (usually found in the
submenu attached to “Control Panels” on the Apple menu; also
available from the Now Utilities Movable Pull-Down menu, if
it’s installed) and choose the desired Startup Set from its
submenu. Hold down the Command and Control keys while
choosing the Set to restart immediately and load the new group of
startup files into memory. (See Chapter 10, “Now Startup Man-
ager,” for more information on Startup Sets.)
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For even faster access to printers, sound levels and color depth settings, assign Hot Keys
to submenu items that you choose frequently. Assign a Hot Key to your favorite printer, or
to your preferred sound level. Better yet, if you frequently switch between two sound levels
or two color depths (black & white and 256 colors, for example), assign the same Hot Key
to both—pressing the Hot Key repeatedly will switch between them. See “Assigning Hot
Keys directly in menus” later in this chapter for more information.

Viewing pathnames for items in menus

For those situations when you're looking at a file, folder or application in a Custom Menu
or submenu and you're uncertain of the item’s location on your hard disk, Now Menus lets
you view its pathname quickly and easily. A pathname is a sequence of folder names
(separated by colons) indicating a file’s or folder’s position on your hard disk. For ex-
ample, the pathname for the Now Menus control panel would read: “My Hard
Disk:System Folder:Control Panels.”

To view the pathname for an item in a Custom Menu or submenu:

1. Pop up or pull down a menu containing files, folders or applications.
2. Highlight an item on the menu or on a submenu.
3. While continuing to hold down the mouse button, press the “P” or the “W” key.

The pathname appears over the item’s name.
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4. Release the “P” or “W” key, move the pointer off of the menu, and release the mouse button
to close the menu.
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The Now Menus control panel

The Now Menus control panel is your “command center” for creating and modifying Cus-
tom Menus, as well as setting other options. The button bar gives you quick access to com-
mands and pop-up menus, making it easy to set up your menus and adjust them later.
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Creating Custom Menus

In addition to the default Custom Menus created by Now Menus upon installation, you can
create your own pop-up or pull-down menus. For example, you may want to create a sepa-
rate menu for all of your graphics applications, or for all of the chapter documents in a re-
port. Besides the Right and Left Pull-Down menus created at installation, you can also
create Movable Pull-Downs, a Desktop Pop-Up, and Modifier Key Pop-Ups.

To create a Custom Menu:

1.

In the Now Menus control panel, click the “Create/Modify Custom Menus™ button or choose
“Edit...” from the “Menu:” pop-up menu.

The Custom Menu Editor dialog box opens.

Cumfaw Hews Ddiler

o Pira T
Exie Fiera

L't Pod o n
Maw LETR e P
Figid Fal-Lwrem

T - dppdy FHymy

g | A

42 Chapter 4—Now Menus



2. Click “New...”.

The New Custom Menu dialog box opens.
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i, Tocreate a new Custom Menu that has the same contents as an existing Cus-
tom Menu, select the Custom Menu you want to duplicate and then click “Du-
plicate...” instead of “New...” (you can't duplicate the Apple menu, however).

3. Choose the type of Custom Menu you want from the “New Custom Menu” pop-up menu and set
its options depending on its type.

To create a... Choose...

Left Pull-Down Left Pull-Down and type a name for the menu in the “Name:”
field.

Right Pull-Down Right Pull-Down and type a name for the menu.

Movable Pull-Down Movable Pull-Down and type a name for the menu.
Desktop Pop-Up Desktop Pop-Upand type a name for the menu.
Modifier Key Pop-Up Modifier Key Pop-Up, type a name for the menu, and click
the modifier keys you want to use for this new menu (the menu
will pop up when you click anywhere on the screen while
holding down these keys).
Note that you can’t select the Shift key alone for use
with a Modifier Key Pop-Up.

You can create only one of the “Right Pull-Down,” “Left Pull-Down” and
“Desktop Pop-Up” menu types—each of these options is dimmed if a menu of
the same type already exists.

4. Click “OK.”

You're returned to the Custom Menu Editor dialog box, where the Custom Menu you
created is selected.

If you created a Right Pull-Down, Left Pull-Down or a Movable Pull-Down, continue
with step 5; if you didn’t create one of these types, skip ahead to step 6.

5. Set the icon options for the Right Pull-Down, Left Pull-Down or Movable Pull-Down that you
created.

Select or deselect the “Show Icon” checkbox as desired to specify whether or not an
icon will be displayed in the menu bar for the Custom Menu.
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If you selected the “Show Icon” checkbox and want to change the default icon for the
Custom Menu, click the “Choose Icon...” button, select an icon in the dialog box and
click “OK.”

For information on adding new icons to those already available in Now Menus,
see the next section, “Selecting icons for pull-down menus.”

6. Click “OK.”

You're returned to the Now Menus control panel. See “Configuring Custom Menus”
later in this chapter for information on adding items to the new Custom Menu.

If you created a Movable Pull-Down menu, its icon now appears in the menu bar. You can
change the icon’s position in the menu bar by holding down the Command key and drag-
ging it. Movable Pull-Down menus always move to the right to accommodate the menus of
the current application. To prevent your Movable Pull-Down menus from interfering with
other items that may appear at the right end of the menu bar (menu bar clock displays,
etc.), use the “Set Rightmost...” option in the Now Menus preferences dialog box to
specify the farthest-right position your menus can occupy. If an application’s menu items
ever force a Movable Pull-Down menu past this boundary, the menu is added to the top of
your Left Pull-Down and/or Right Pull-Down menus, as long as at least one of them exists.

Deleting Custom Menus

The Custom Menu Editor dialog box also allows you to delete a Custom Menu that you no
longer want to use.

To delete a Custom Menu:

1. In the Now Menus control panel, click the “Create/Modify Custom Menus™ button or choose
“Edit...” from the “Menu:” pop-up menu.

The Custom Menu Editor dialog box opens.
Select the Custom Menu that you want to delete.

3. Click “Delete.”
The menu is removed from the list.

4. Click “OK.”

You're returned to the Now Menus control panel.
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Configuring Custom Menus

Whether you're working with an existing Custom Menu or an empty one that you just cre-
ated, it's easy to add and remove various items until the menu is set up just the way you
want it. You can add folders, applications, documents, control panels and Worksets to a
Custom Menu; you can also add Smart Items, which let you find files, display recently-
used files, switch between active applications, and much more. You can organize items on
a Custom Menu by dragging to rearrange them and by using separators.

Adding items to a Custom Menu

The recent item pop-up menus at the left end of the Now Menus button bar give you quick
access to recently-used folders, applications, documents, control panels and Worksets so
that you can add them to a Custom Menu easily.

Choose control panels Choose Smart Items

Choose documents g add to the menu to add to the menu
to add to the menu

Choose folders to 3] @| a] 5 B |&k55'::feéhﬁéﬁﬂfi”;!%'

add to the menu

Choose applications Choose Worksets to

to add to the menu add to the menu
To add one of these items to the currently-displayed Custom Menu, choose the desired
item from the pop-up menu for its type. If the specific item you want to add isn’t listed
among the recent items for its type, choose the “Other [item type]...” command from the
pop-up menu to locate and add the item manually.

If you're running System 7.5 or later, you can also add items to a Custom Menu by drag-
ging them into the list from the Finder.

One of the most useful items you can add to a Custom Menu is your hard disk or another
volume on your desktop, such as a network server. If the volume’s name doesn’t appear in
the “Add Folders” pop-up menu, choose “Other Folder...”, then locate it and add it to

your Custom Menu. Highlighting the volume’s name in the Custom Menu will give you
hierarchical access to all of the folders it contains.

Deleting items from a Custom Menu

When you want to delete an item from a Custom Menu so that it will no longer appear in
the menu, just select the item and click the “Delete Selected Iltem(s)” button—the item dis-
appears from the menu list. (You can also delete an item by selecting it and pressing De-
lete/Backspace.)

When you perform this operation, you're not deleting the actual file or folder from your
hard disk; you're simply deleting its listing from the menu.

Chapter 4—Now Menus 45



Adding Smart Items to a Custom Menu

The Smart Items available on the “Smart Items” pop-up menu in the Now Menus button
bar provide special functions that make your Custom Menus remarkably powerful. Smart
Items add “intelligent” functions to a Custom Menu that let you choose from recent files,
folders and applications; find items you want to open; view memory usage and much
more. To add a Smart Item to a Custom Menu, just choose it from the Smart Items pop-up
menu.

What the various Smart Items do
This table explains the use of each Smart Item.

This Smart Item... Does this...

---Separator--- Inserts a separator line into the Custom Menu to help organize its
contents. Drag the separator line wherever you want it.

(Recent Files) Displays a list of recently-opened files in the Custom Menu.*

(Recent Folders) Displays a list of recently-used folders in the Custom Menu.*

(Recent Apps) Displays a list of recently-opened applications in the Custom Menu.*

(Active Apps) Displays a list of the currently-running applications in the Custom
Menu. After adding this Smart Item to a menu, select it to specify
whether or not it will display background processes such as when
PrintMonitor becomes active to run a print job.

(Menu Bar) Displays a “copy” of the current menu bar in the Custom Menu, so
that you can choose commands from the current application’s menus
without going into the menu bar.

., This is very handy when added to a Desktop Pop-Up or Modi-
V' fier Key Pop-Up!

(Now Utilities) Displays a list of all installed Now Utilities components. After adding
this Smart Iltem to a menu, select it to specify whether its contents
will be displayed directly in the menu or as a submenu attached to a
“Now Utilities” item.

“Other...” Opens a dialog box that lets you select and open a file or application
that is not listed on the Custom Menu. After adding this Smart Item
to a menu, select it to specify whether it will show all files, or appli-
cations only.t

“Find...” Opens a dialog box that lets you find files, applications and folders,
then open them if you wish.t
Memory Viewer... Opens a dialog box that displays memory usage on your system.t

Memory Sizer... Opens a dialog box that lets you adjust the memory allocated to a se-
lected application. T
Edit Recent... Opens a dialog box where you can edit the Now Utilities database of

recent files, folders and applications. You can remove recent items
from the database, add items, and make items permanent.t
*See the next section for options relating to this Smart Item.

TUse of this function is described later in this chapter; see the “Using [Function
Name]” section for each function.
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Configuring the “Recent”” Smart Items

The three “Recent” Smart ltems—“Recent Files,” “Recent Folders” and “Recent Apps"—
offer options to let you control how they appear in menus and what items are displayed.

Control panel options for “Recent”” Smart Items

When you add one of these Smart Items to a Custom Menu, selecting it in the control
panel makes a number of options available. The illustration below shows the options that
appear for the “Recent Files” Smart Iltem; the options for “Recent Folders” and “Recent
Apps” are nearly identical.
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Use... In order to...
Don't list more than Specify the maximum number of items to be displayed in the
menu.
Sort by Specify whether items in the menu will be sorted alphabetically
by name, or chronologically by their last modification dates.
Permanent at topSpecify that items you’'ve marked as permanent (this will read

“files,” “folders” or “apps,” depending on the Smart Item that’s
selected) will be listed together at the top of the recent items
menu, with the temporary items listed below.

Edit... Open a dialog box where you can control the recent items in the
Now Utilities database—remove items, make them permanent,
set Hot Keys, etc. (see the next section for more information)
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Using the “Edit Recent...” dialog box

The dialog box that opens when you click “Edit...” in the control panel or when you
choose the “Edit Recent...” Smart Item from a Custom Menu gives you full access to the

database of recent items maintained by Now Utilities.
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Control which recent items are displayed Choose the desired type from the “Edit Re-
cent...” pop-up menu: “All Files,” “Applica-
tions,” “Folders,” or choose a specific
application from the bottom portion of the menu
to view only recent documents for that applica-
tion.

Select it and click “Remove.” You can select
multiple items to remove by Shift-clicking or
Command-clicking.

Click in the right-hand column next to the
item—a checkmark appears to indicate that the
item is now permanent. (Simply click a
checkmark to make it disappear, making the
item temporary again.)

Select the item, then press the desired key com-
bination—it's immediately entered into the “Hot
Key” field.

Select the item, then press Delete/Backspace—
the “Hot Key” field becomes blank.

Remove a recent item

Make an item permanent

Set a Hot Key for an item

Remove a Hot Key for an item

48 Chapter 4—Now Menus



Configuring “Recent”” Smart Items directly in menus

Many of the same functions available in the “Edit Recent...” dialog box can actually be
performed directly in Custom Menus using the keyboard. All of these functions involve
highlighting an item in a Custom Menu and holding down the mouse button while pressing
a key or keys on the keyboard. For example, in the illustration below, the spacebar is being
pressed while a recent item is highlighted, making it permanent—the item’s name is un-
derlined as soon as the spacebar is pressed.

To... Highlight the item and...

Remove a recent item Press Delete/Backspace—a line appears through the item,
and the item doesn’t appear in the menu the next time it is
displayed.

If the item has a Hot Key assigned to it, the Hot Key
is deleted first—press Delete/Backspace a second
time to delete the item itself.

Make an item permanent Press the spacebar—the item becomes underlined and will
not disappear from the menu as additional items are
opened. (To make the item temporary, highlight it and
press the spacebar again.)

Set a Hot Key for an item Press the desired key combination—it appears to the right
of the highlighted item, and you can activate the menu
item in the future just by pressing the Hot Key. (This will
work in any menu, as long as “Assign Hot Keys directly in
menus” is selected in the Now Menus Preferences dialog
box.)

Remove a Hot Key for an item Press Delete/Backspace—the Hot Key disappears. (If the
item previously had its own Hot Key—a menu command
in an application, for example—the original Hot Key reap-
pears.)
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Special settings for folders, documents and applications in
Custom Menus

Now Menus lets you set several options for folders, documents and applications that you
add by name to Custom Menus. The available options change depending upon which type
of item is selected.

I The options described here are available only for items that yobyaddmeto a menu;
*~  they are not available for items appearing in lists of recent folders, documents or applica-
tions.

Folder settings

The available folder settings mostly control how the selected folder appears in a Custom
Menu.

To set options for a folder:

1. From the “Menu:” pop-up menu above the menu list, choose the Custom Menu containing the
folder you want to set options for.

If the folder isn’t yet in a menu, add it now.
2. Select the folder in the menu items list.

The options available for the folder appear in the information area on the right side of
the control panel.
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3. Set the desired options for the folder.

Use this option... In order to...
Name Rename the folder.
Hot Key Set a key combination that you can press to open the folder.

Attach folder contents Specify that a submenu of the folder’s contents (including
nested folders and submenus of their contents, up to ten lev-
els deep) will be attached to the folder’'s name on the menu.

Inline Contents Specify that the folder’s contents will be displayed directly in
the menu you’re configuring, instead of in a submenu.

This option is available in all Custom Menu types ex-
cept the Apple menu.

4. Close the Now Menus control panel.
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Turning off folder submenus directly in menus

When you want to specify that a certain folder will not appear as a hierarchical menu item,
you can make this change quickly from the menu itself rather than using the control panel.

To turn off a folder submenu directly in the menu:

1.
2.

Open a Custom Menu.
Position the pointer over a folder name to highlight it.

Notice the arrow indicating that the folder has an attached submenu, which appears to
the right, displaying the contents of the folder.

While continuing to hold down the mouse button, press the spacebar to turn off the submenu
displaying the folder’s contents.

Pressing the spacebar turns off the submenu, and the arrow disappears; pressing the
spacebar again will turn the submenu back on.

This function applies only to the first level of a hierarchical submenu—the
folder shown in the main menu. It is not possible to turn off hierarchical
submenus for folders contained within submenus.

Document settings
The document settings let you change the document’s name and set a Hot Key for it.

To set options for a document:

1.

From the “Menu:” pop-up menu above the menu list, choose the Custom Menu containing the
document you want to set options for.

If the document isn't yet in a menu, add it now.
Select the document in the menu items list.

The options available for the document appear in the information area on the right
side of the control panel.
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Set the desired options for the document.

Use this option... In order to...
Name Rename the document.
Hot Key Set a key combination that you can press to open the document.

Close the Now Menus control panel.

Chapter 4—Now Menus 51



Application settings

Several options are available for applications. Without leaving the control panel, you can
set a color depth and sound level for an application, rename it, define a Hot Key to open it,
edit its list of recent documents, and set its memory allocation.

To set these options for an application, you must first add it to the Apple menu or a Cus-
tom Menu. Once you've configured the options, however, you can remove the application
from the menu if you wish; Now Menus will remember the settings you specified whether
or not the application is installed on a menu. (If you want to change the settings, however,
you'll need to add the application to a menu again.)

To set options for an application:

1. From the “Menu:” pop-up menu above the menu list, choose the Custom Menu containing the
application you want to set options for.

If the application isn’t yet in the menu, add it now.
2. Select the application in the menu items list.

The options available for the application appear in the information area on the right
side of the control panel.
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3. Set the desired options for the application.

Use this option... In order to...

Color Set a color depth that will be active whenever you open or
switch to the application.

Sound Set a sound level that will be active whenever you open or
switch to the application.

Name Rename the application.

Hot Key Set a key combination that you can press to open the applica-
tion or switch to it.

Attach docs Specify that a submenu of recently-used documents will be
attached to the application’s name on the menu.

Edit... Edit the list of recently-used documents for the application

(see “Using the ‘Edit Recent...” dialog box” earlier in this
chapter for information on using this function).

Application memory Set the amount of memory to be allocated to the application.
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4.

Close the Now Menus control panel.

By configuring the sound level and color depth for applications in Now Menus, you can
avoid reopening the Monitors and Sound control panels to change these settings manually
every time you open a new application or switch between applications. You may want to
configure the Finder with your preferred “normal” settings; that way, if you set an appli-
cation to run in black-and-white, returning to the Finder will always switch your monitor
back to color. Note that you can configure settings for the Finder only by adding it to a
Custom Menu—not the Apple menu.

Selecting icons for pull-down menus

The Left Pull-Down, Right Pull-Down and Movable Pull-Down Custom Menus are all
represented by icons in the menu bar. You can choose from a number of icons provided
with Now Menus, or you can paste or import additional icons.

To choose an icon for a Custom Menu:

1.

In the Now Menus control panel, click the “Create/Modify Custom Menus™ button or choose
“Edit...” from the “Menu:” pop-up menu.

The Custom Menu Editor dialog box opens.
In the list of Custom Menus, select the menu for which you want to choose an icon.

The menu must be a Left Pull-Down, Right Pull-Down, or a Movable Pull-Down.
When you select the menu, the icon that is currently selected for it appears at the
lower left.

Click “Choose Icon...” at the bottom of the dialog box.

A dialog box opens, displaying a list of icons.
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Locate and select the icon you want to use.
Scroll through the list if necessary.
Click “OK.”

You're returned to the Custom Menu Editor dialog box, where the icon you chose is
now displayed for the Custom Menu.

Click ““OK.”

The new icon now appears in the menu bar for the selected Custom Menu.
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To paste an icon into the Icon List:

1.
2.

In the Finder, select the item whose icon you want to add to the list.
Choose “Get Info...”” from the File menu.

The Get Info window opens for the selected item. Notice the icon displayed in the up-
per left.

Click the icon to select it.
A border appears around the icon.
Choose “Copy” from the Edit menu.

Follow steps 1 through 3 of the previous procedure for choosing an icon, so that the Icon List
dialog box is open.

Click “Paste.”

The icon is added to the list (you may have to scroll down to see it).

To import a file or application’s icon(s) into the Icon List:

1.

Follow steps 1 through 3 of the previous procedure for choosing an icon, so that the Icon List
dialog box is open.

Click “Import...”.

A directory dialog box opens.

Locate and select the file or application containing the icon(s) you want to add to the list.
Click “Open.”

You're returned to the Icon List dialog box, where any icons in the file or application
you selected have been added to the list (you may have to scroll down to see them).

To remove an icon from the Icon List;

In the Icon List dialog box, select the icon you want to remove.
Click “Cut.”

The icon is removed from the list and placed on the Clipboard; you can paste it into a
different location if you wish.
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Assigning Hot Keys directly in menus

The Now Menus control panel lets you assign Hot Keys to folders, documents and applica-
tions (see “Special settings for folders, documents and applications in Custom Menus” ear-
lier in this chapter). It's also possible, however, to assign these Hot Keys directly in the
menus, and even to redefine the existing Hot Keys for commands in the Finder and any
application program (and create new Hot Keys for commands that don’t have them). Hot
Keys can include one or more modifier keys (Command, Control, Shift, and Option),

along with any character on the keyboard (function keys will work alone, as well).

To assign Hot Keys directly in menus, you need to click the “Preferences” button in the
Now Menus control panel, then select the "Assign Hot Keys directly in menus” checkbox
(see “Now Menus preferences” later in this chapter for an illustration and more informa-
tion on preferences settings).

Now Menus can'’t define keyboard shortcuts for commands in pop-up menus, or menus in
applications that don’t use standard menu definitions according to Apple’s programming
guidelines.

To assign a Hot Key directly in a menu:

1. Pull down a menu in the Finder or any application (or a Custom Menu).

2. Position the pointer over a menu item to highlight it.

You can also define Hot Keys for dimmed menu items, even though they do not
appear highlighted when you select them.

3. While holding down the mouse button, type the desired Hot Key.

The Hot Key must include one or more modifier keys (Command, Option, Shift, or
Control) along with a character (function keys work alone, as well).

The new Hot Key appears to the right of the command (the illustration below shows
the modifier key symbols and the keys they represent).

Command
Shift
Option
Control

SAo®

|  Now Menus doesn’t allow you to use the Shift key alone with a character to de-

*  fine a keyboard shortcut, as this would result in a printable character that
might be inadvertently typed into a word processing or electronic mail docu-
ment.
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4. Release the menu.

As long as Now Menus is installed, typing the Hot Key will activate the menu item. If
you define duplicate Hot Keys for two or more commands in an application, Now
Menus recognizes and activates only the newest occurrence of the Hot Key.

To remove a Hot Key from a menu command:

1. Pull down the menu containing the Hot Key you want to remove.
2. Position the pointer over the menu item whose Hot Key you want to remove.

You can also remove Hot Keys for dimmed menu items, even though they do not
appear highlighted when you select them.

3. While continuing to hold down the mouse button, press Delete/Backspace.

The Hot Key disappears. If the Hot Key was assigned in place of an existing one, the
original Hot Key now appears next to the item.

4. Release the menu.

Exporting and importing Hot Keys

To make it easier for Now Utilities owners to exchange Hot Keys for applications, particu-
larly in a workgroup setting, Now Menus allows you to export the Hot Keys you've as-
signed in applications to special files that another user can import in order to use the same
Hot Keys for each application that you use. This feature is particularly useful if you sup-
port a group of network users and you want to help them by supplying the same Hot Keys
throughout the organization; you might also use the Export function to back up your Hot
Keys settings.

Exporting Hot Keys

The Export function creates an export file for each application in which you've assigned
custom Hot Keys. If you've assigned Hot Keys to any of your fonts using Now
WYSIWYG Menus, it also creates a file containing these Hot Keys, called “Font Hot
Keys.”
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To export your Hot Keys:

1.

2.

Click the ““Preferences” button in the Now Menus control panel.

The Preferences dialog box opens.
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Click “Export Hot Keys...”.

A directory dialog box appears, prompting you to choose a location for the export
files.

Because this function creates multiple export files, you will probably want to
choose an empty folder in which to save them (or create one).

Choose the desired location, then click “Export.”

The files are exported, and you're returned to the Preferences dialog box.
Click “OK.”

You're returned to the Now Menus control panel.

Importing Hot Keys

You can selectively import Hot Key files for the applications that you want, or simply im-
port several all at once.

To import Hot Key files:

1. Click the “Preferences” button in the Now Menus control panel.

The Preferences dialog box opens.
Click “Import Hot Keys...”.

A directory dialog box appears, prompting you to locate and select the Hot Key files
you want to import.
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3. If necessary, locate the folder containing the file(s) you want to import; then, depending on how
many files you want to import, choose one of these options.

In order to... Do this...

Import a single file Select it and clidknport ; skip ahead to step 5 if this was
the only file you wanted to import.

Import all of the files listed Clickmport All and skip ahead to step 5.

When importing is complete, you're returned to the Preferences dialog box.

4. If there are additional files you want to import, repeat steps 2 and 3 until you’ve imported all
of them.

5. Click “OK.”

You're returned to the Now Menus control panel. Any Hot Keys you've imported are
now available.

Dragging Finder items into menu locations

One time-saving feature of Now Menus is the ability to drag items from the Finder directly
into menus. This is essentially as simple as it sounds. For example, if you have a document
on the desktop that you want to place in a “Correspondence” folder somewhere on your
hard disk, you can drag the document’s icon up onto the Apple icon in the menu bar, down
through the Apple menu to an alias of your hard disk, and through the hard disk’s submenu
until you reach the desired folder. Then just release the mouse button when the pointer is
over the folder's name—the document is moved to the folder (if you're dragging the docu-
ment to a volume other than the one where it’s stored, it's copied instead of moved).

To copy an item instead of moving it, simply hold down the Option key as you drag, just
as you would in the Finder.

To open a document using an application that did not create it, drag the document’s icon
through the menus until you reach the desired application’s name, then release the mouse
button. If the selected application is able to, it opens your document.
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Using the “Other...” command to open applications and
documents

The “Other..” Smart Item lets you open applications and documents that are not displayed
on a Custom Menu. You can also add the selected item(s) to the Custom Menu.

To use the “Other...” Smart Item:

1. Choose “Other...” from the Custom Menu to which you added the Smart Item.

A dialog box appears, prompting you to locate the application you want to open.

% Folder File Drive Options
Select an Application to Launch

— My Hard Disk *

[ Applications [+ =My Hard Disk
[ Documents

Csystem Folder
Desktop
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2. Locate and select the application you want to open.

Select the “Install Permanently” checkbox at this point if you want to make the
application a permanent listing in the Custom Menu.

3. Click “Launch” to open the application.
The application opens.

| Toopena document with the application, you can click the “Open Document

*~  With Application” button at this point—the dialog box switches to display
documents so that you can locate and select a document, then click “Launch”
(select the “View All Documents” checkbox to view all files, as opposed to only
those created by the previously-selected application). Note that you can also
make the document permanent by selecting the “Install Permanently” checkbox
before clicking “Launch.”
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Using the “Find...”” command

Adding the ‘Find...” Smart Item to a Custom Menu gives you instant access to Now Super
Boomerang’s flexible and fast Find dialog box. To open the dialog box, just choose
“Find...” from the Custom Menu to which you added the Smart Item. You can search for
files by their names or by text they contain, and you can even search within compressed
archives. For a full explanation of how to use this dialog box, see Chapter 11, “Now Super
Boomerang.”

You must have Now Super Boomerang or Now QuickFiler installed and turned on in order
to use the “Find...” command from a Custom Menu. The Now Super Boomerang Find dia-
log box appears unless Now Super Boomerang is not running; then Now QuickFiler's Now
Find dialog box appears.

Using Memory Viewer

Memory Viewer helps you find out how much memory your Macintosh has, how much of
it is in use by the System, Finder, and active applications, and how much is still available.
You can see this information by choosing “Memory ViewER” from a Custom Menu.

This information can help you determine what actions to take when your Macintosh alerts
you that there is not enough memory available to open an application. Since Memory
Viewer can tell you the size of the largest block of free memory, and whether the memory
is fragmented, you can decide which application(s) you should quit in order to free up the
needed memory.

You can view similar but less detailed information by choosing “About This Macintosh...”
from the Apple menu in the Finder.

To view memory information using Memory Viewer:

1. Choose “Memory Viewer...”” from the Custom Menu to which you added the Smart Item.

The Memory Viewer display opens and shows the memory partitions occupied by any
currently-running applications.
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Active applications are loaded into the first available contiguous block beginning at
the top of the memory and working downward. The system software cannot load an
application into multiple blocks of memory.

You can view detailed memory information for different applications by selecting
them from the “Memory Map” pop-up menu.

If necessary, take any of the following actions to make more memory available to open applica-
tions.

« If you see that one application’s memory block has a block of free memory both
above and below it in the representation on the left, quit the application and reopen
it to defragment the memory. The blocks of unused memory will be joined and then
reloaded into the first block of available memory, leaving more memory available to
run other applications.

* Quit one or more applications to make the memory available to other applications.

* Reduce the amount of memory that an application uses by using Memory Sizer as
described in the next section.

Click “OK” to close the Memory Viewer display.
You're returned to the current application.
| Restarting your Macintosh is the surest way to defragment your memory.
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Using Memory Sizer

Memory Sizer lets you adjust the amount of memory that an application uses. For ex-
ample, you may want to increase an application’s memory allotment so that it can open
more or larger documents, or, if you have a limited amount of memory, to decrease the
allotment so that you can run more applications. While you can also adjust an
application’s memory allotment in the Finder’s Get Info window, Memory Sizer lets you
do it more quickly in most cases, and even “on-the-fly” if you wish (see the next section).

Adjusting an application’s memory allotment using Memory
Sizer

This is the “manual” approach to changing an application’s memory allotment. If you
know before trying to open an application that you want to change the amount of memory
it requires, use this method.

To adjust an application’s memory allotment:

1. Choose “Memory Sizer...”” from the Custom Menu to which you added the Smart Item.

A dialog box appears, prompting you to locate the application whose memory allot-
ment you want to change.

2. Locate and select the application, then click “Edit Size.”

The Memory Sizer dialog box opens. The “Application Memory Size” shows the
amount of memory currently set for the application.
Total amount of
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HRMOrY Saeer

Applicaisme e ioaelt Dl £0

Largest contiguous

Tatal Memory: ia5a0k .-f’:.r block of available
Lisrgai | Liniisaed BeLk: 448K A memory

Peppiiiod Momory e S000K The manufacturer’s
pinimum Seggestod Size— 000K suggested memory size for

the application

Applicelm My Size: |5|:|I:I|:I i— The preferred memory

size that will actually be
| Comamsal | § [T [ allotted to the application

The smallest memory size
recommended by the
manufacturer for running
the application safely

Memory Sizer will not allow you to adjust the memory allocation for an appli-
cation that is currently open or locked. To adjust the allocation for an applica-
tion that is currently open, quit it first.
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3. Review the manufacturer’s Suggested Memory Size and Minimum Suggested Size.

4. In the “Application Memory Size” field, type the number of kilobytes (K) that you want to allo-
cate to the application.

For the best operating performance, type in a value that is equal to or higher than the
manufacturer’s suggested memory size. Entering a memory allotment lower than the
manufacturer’s suggested memory size may cause the application to run more slowly.

If you set a memory allotment that is smaller than the manufacturer’s minimum
suggested size, the application may function improperly (crash) or not at all.

5. Click “OK.”

If you enter a memory allocation that is smaller than the manufacturer’s suggested
minimum size, an alert appears, asking you to confirm that you want to do so.

Managing low-memory situations with Memory Sizer

If you wish, Memory Sizer can also help you manage application memory allotments auto-
matically whenever your memory gets low. When you turn on this feature, Memory Sizer
displays its dialog box if you try to open an application whose memory allotment is larger
than the currently-available memory.

To activate this feature of Memory Sizer, click the “Preferences...” button in the Now
Menus control panel. Under “Open Memory Sizer dialog box...” in the Preferences dialog
box, select the “When memory is low” checkbox.
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When you try to open an application for which there isn’t enough available memory, the
Memory Sizer dialog box appears so that you can compare the Application Memory Size
to the Largest Unused Block figure, and decide on a smaller memory allotment for the ap-
plication so that it will run in the available memory. Notice that in this situation, the dialog
box includes a “Temporary Change” checkbox; it's selected by default so that the new
memory allotment is temporary only. You can make the new figure permanent by dese-
lecting the checkbox before you click “OK.”
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Note that you can also define a key combination to press as you open an application in or-
der to change the application’s memory allotment “on-the-fly” whether or not available
memory is low. Just select the checkboxes for the desired key combination under “By
pressing at application launch:”, and then press the specified keys when opening an appli-
cation to open the Memory Sizer dialog box.

| Be careful to avoid specifying a key combination that you also use for a Modifier Key Pop-
*  Up menu—doing so will cause Memory Sizer to appear whenever you launch an applica-
tion from the menu.

Worksets

The Worksets feature of Now Menus allows you to create groups of applications and
documents that you can open all at once just by double-clicking, or by choosing an item
from a Custom Menu. Using a Workset lets you quickly open multiple applications and
documents without searching through nested folders to locate and open them one at a time.

To run a Workset, just add it to any menu and choose it from the menu; the applications
and/or documents it contains are opened.

This section explains the different ways of creating and modifying Worksets.

Creating Worksets

You can create Worksets easily from the Now Menus control panel.

To create a new Workset:

1. Click the “Create/Modify Worksets™ button in the Now Menus control panel. (Do not confuse
this button with the similar-looking “Add Worksets™ button further to the left.)

A directory dialog box opens.
2. Click “New...".
A directory dialog box opens for naming and saving the new Workset.
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3. Enter a name for the new Workset, select a destination folder, and click “Save.”

The Workset dialog box opens, with the name you entered shown in the title bar. If
any applications and/or documents are open at the time you create the Workset,
they’re automatically added to it.
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4. Configure the Workset as desired.

Use this option... In order to...
Add application pop-up menu Add recently-used applications to the Workset.

Add document pop-up menu  Add recently-used documents to the Workset.

I When adding a document to a Workset,

*~ it's a good idea to include the application
that created it as well. Including the ap-
plication in the Workset causes multiple
documents to be grouped with their creat-
ing application, and reduces the number
of times that the Workset switches to the
Finder in the process of opening all of the
documents it contains.

Add... Add applications or documents that don't appear
in the pop-up menus.
Remove Remove the selected item(s) from the Workset.

5. Choose the desired option to finish configuring the Workset.

Click... In order to...
Run Workset Open the applications and documents in the Workset.
Close box in title bar Close the Workset without running it.

You can add the Workset to a Custom Menu, if you wish, or place it in the “Startup Items”
folder in the System Folder in order to open the same group of applications and docu-
ments whenever you start up your Macintosh.
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Modifying existing Worksets

You can open an existing Workset to modify it in two ways: from the Now Menus control
panel or directly in the Finder.

To modify an existing Workset from the Now Menus control panel:

Click the “Create/Maodify Worksets™ button in the control panel.

A directory dialog box opens, in which you can locate and open an existing Workset
or create a new one.

Locate and select the Workset that you want to modify, and click “Open.”

The Workset dialog box opens, with the name of the selected Workset shown in the
title bar.

Make any desired changes to the Workset according to steps 4 and 5 of the previous procedure
for creating a new Workset.

To modify a Workset from the Finder (desktop):

1.
2.

In the Finder, locate the Workset that you want to modify.
Hold down the Command key while double-clicking the Workset’s icon.

The Workset dialog box opens, with the name of the selected Workset shown in the
title bar.

Make any desired changes to the Workset according to steps 4 and 5 of the previous procedure
for creating a new Workset.
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Application substitution

At times when working on your Macintosh, you may encounter situations in which you
want documents created by one application to be opened by a different one. For example,
if you use Microsoft Word for word processing but one or more colleagues use MacWrite
Pro and they often send you their documents, you can't double-click the MacWrite Pro
documents and have them open in Word. Instead, you have to open Word first and then
select the MacWrite Pro document in a directory dialog box. Now Menus remedies this
situation by letting you specify that all documents created by MacWrite Pro will be opened
by Microsoft Word. Once you've done this, you can double-click a MacWrite Pro docu-
ment and Microsoft Word will open it directly.

Activating application substitution

To activate application substitution, you simply need to click the Application Substitution
button in the Now Menus control panel and then select the “On” button in the Application
Substitution Configuration dialog box.

Applenatisn Tubadileding Cordige alme oo o
Filayp crgqipd =il [T [ e—" T
[t |

Creating substitutions

The Application Substitution Configuration dialog box is where you create the substitu-
tions you want to be in effect.

To create a substitution:

1. Click the “Application Substitution” button in the Now Menus control panel.

The Application Substitution Configuration dialog box opens.
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2. Click “New.”

An unconfigured substitution appears in the substitutions list.
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3. From the pop-up menu on the left, choose the application whose documents you want to open
with a different application.

If the desired application doesn’t appear in the pop-up menu, choose
“Other...” from the top of the menu and locate the application in the directory
dialog box that opens. (If the application is not on your hard disk, hold down
the Option key while choosing “Other...” and you will be able to enter the
application’s creator code directly.)

4. From the pop-up menu on the right, choose the application that should open documents created
by the application on the left.

5. Click “OK.”

You're returned to the Now Menus control panel. The substitution you configured is
now active.

Modifying and removing existing substitutions

=f| T0 modify an existing subsitution, click the “Application Substitution” button in the Now
2l Menus control panel to open the Application Substitution Configuration dialog box, then
make the desired changes to a substitution by choosing new applications from either pop-
up menu.

To remove an existing substitution, select it and click “Remove.”
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“On-the-fly” application substitution

When application substitution is active, Now Menus automatically offers help when you
try to open a document whose creating application can't be found on your hard disk. The
procedure below outlines what Now Menus will do in this situation and what you should
do to substitute another application.

Normally, when you double-click a document whose creating application isn’t on your
hard disk, the system software displays a dialog box indicating that the document
“couldn’t be opened because the application program that created it couldn’t be found.”
When application substitution is active, Now Menus adds a “Pick an application...” button
to this dialog box, so that it appears as below:

The document “Annual Report” could not

0 be opened, because the application
program that created it could not be
found.

To create an “on-the-fly” substitution:
1. Click “Pick An Application...”.

A directory dialog box opens, where you can choose a substitute application.
2. Locate and select the application that you want to open the document, and click “Open.”

The document is opened in the specified application, providing that the application
supports its format.

Be sure to choose an application that supports the document’s file format—
choosing one that doesn’t can cause unpredictable (actually, predictably bad)
results.

Now Menus adds your “on-the-fly” substitutions to the Application Substitution list, and
automatically opens the substitute application the next time you double-click a document
that was created by the same original application.

Now Menus will continue to use a substitution even if the original application becomes
available; if you later install the original application, open the Application Substitution
Configuration dialog box and remove the application substitution.
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Now Menus preferences

The Now Menus preferences settings let you customize many functions to fit your working

style.

Main preferences

To open this dialog box, click the “Preferences” button in the Now Menus control panel;
the table below explains the available options.
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Use this option... In order to...
Apple menu Specify that small icons will be displayed next to

Now Menus Custom Menus
Black & white (faster)
All menus

Apple menu & Custom Menus

Custom Menus only

Show permanent items only
Tune Submenus...

continued on next page
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item names in the Apple menu.

Specify that small icons will be displayed next to
item names in Custom Menus.

Specify that icons appearing in menus will be drawn
in black & white; menus appear more quickly.
Specify that all menus will be displayed in the font
you choose in the control panel.

Specify that only the Apple menu and Custom
Menus will be displayed in the font you choose in
the control panel (application menus will appear in
the standard Chicago 12 point).

Specify that only Custom Menus will be displayed
in the font you choose in the control panel (the
Apple menu and application menus will appear in
the standard Chicago 12 point).

Specify that only permanent items—no temporary
items—uwill appear in recent file/application lists.
Open a dialog box for setting the popup delay and
the disappearance delay for submenus.



Use this option...

In order to...

continued from previous page
Set Rightmost...

Exclude...

Import Hot Keys...

Export Hot Keys...

When memory is low

By pressing at application launch

Menus “stick” when pulled down

No click needed

Auto-Hide application windows

Open a dialog box to set the furthest-right position
that a Movable Pull-Down menu can occupy in the
menu bar. This allows you to avoid display conflicts
with other items that appear in the menu bar.

Open a dialog box that allows you to specify appli-
cations in which Now Menus functions will not be
active. See the next section, “Excluding applications
from Now Menus functions,” for more information.
Open a dialog box where you can select a file of ap-
plication Hot Keys to import.

Open a dialog box where you can select a location
to save an export file containing your Hot Key as-
signments for all applications.

Specify that the Memory Sizer dialog box will ap-
pear whenever you try to launch an application
whose memory size is greater than the currently-
available memory, so you can make a temporary
adjustment to the application’s memory size.
Specify a key or key combination that you can press
while opening an application to open the Memory
Sizer dialog box. See “Using Memory Sizer” earlier
in this chapter for more information.

Specify that a single click on a menu title will pull
down the menu, allowing you to highlight menu op-
tions by moving the pointer without holding down
the mouse button. To choose a highlighted menu
item, click again.

Specify that simply moving the pointer over a menu
title will pull down the menu, with no mouse click
required. You can highlight menu options by mov-
ing the pointer without holding down the mouse but-
ton. Choose a highlighted menu item by clicking it.

Specify that Now Menus will automatically hide
application windows that are open but inactive, so
that all open windows except those of the active ap-
plication are hidden. When you switch to another
application, the new application’s windows appear
and the previous application’s windows are hidden.

Assign Hot Keys directly in menus Specify that in addition to using the control panel,

Open selected item’s folder...

you can assign Hot Keys to menu items by high-
lighting them and typing a key combination.
Specify that holding down a modifier key while
choosing a menu item will open the folder window
containing that item in the Finder.

Chapter 4—Now Menus

71



72

Excluding applications from Now Menus functions

Since problems can sometimes arise between Now Menus and some applications that use
nonstandard menu definitions according to Apple’s programming guidelines, the “Ex-
clude...” option allows you to prevent the Now Menus custom menu font and Hot Key
features from being active in such applications.

To exclude an application from Now Menus functions:

1. Click the “Preferences™ button in the Now Menus control panel.
The Preferences dialog box opens.
2. Click “Exclude...”

The Exclude dialog box opens.
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3. Click “Add...”.
A directory dialog box opens.
4. Locate and select the application you want to exclude, then click “Open.”

You're returned to the Exclude dialog box, where the application name has been
added to the list. Repeat steps 3 and 4 to exclude any additional applications.

5. Click “OK.”

You're returned to the Preferences dialog box.
6. Click “OK.”

You're returned to the Now Menus control panel.

Because of its nonstandard menu definitions, Microsoft Word is automatically excluded
from Now Menus; you do not need to exclude it manually. Also, Now Menus can determine
on its own, to some extent, when an application has nonstandard menu definitions and
might not handle custom menu font or keyboard shortcut settings smoothly. In many of
these applications, Now Menus will disable itself automatically so that you don’t have to
exclude the application manually. If you notice that an application’s menus are not dis-
played in your chosen custom menu font or that you are unable to set keyboard shortcuts,
this may be the reason.
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Chapter
Now Profile

Now Profile provides a detailed report on your Macintosh system’s hardware and software

configuration. It can list hardware specifications, configuration details, system software

versions; and provide detailed information about your installed applications, printer driv-
ers, fonts, desk accessories, and extensions. Now Profile can also help you locate “lost”
aliases and duplicate files so you can remove them from your hard disk and save space.

Creating a Now Profile report ...........oooveeiiiiiiiiiiiieee e 75
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Creating a Now Profile report

A Now Profile report is an extremely useful tool for solving system problems. For ex-
ample, you may want to generate a Now Profile report if you're experiencing a system
conflict with a particular application. This way you'll have an accurate picture of your
configuration at the time the conflict occurred. Should you call the technical support num-
ber of the software company to discuss the problem, you can print out your report and pro-
vide the company with this information so they can help you track down the system
conflict more quickly. If you're using PowerTalk (available in System 7 Pro or System

7.5), you can even mail your Now Profile report over the network in one easy step.

In a workgroup setting, Now Profile is invaluable for comparing different machines and
their configurations in order to track down conflicts and maintain consistent setups.

To create a Now Profile report:

1. Open Now Profile.

The Now Profile Preferences dialog box appears with the default options selected.
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2. Review the report categories and change the option selected in each of the eleven pop-up menus
as desired.

Select...  To specify that Now Profile will...
Detailed Report the most detailed information for a category.
Basic  Report only basic information for a category.

The “Drivers,” “Volumes” and “Duplicate Files” pop-up menus
offer the Detailed and Omit options only.

Omit Omit a particular category from the report.
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3. Specify where Now Profile will search for desk accessories, applications, aliases and duplicate
files.

Select... To specify that Now Profile will...
Startup Volume Only Scan the startup volume only.

All Local Volumes Scan all currently-mounted volumes. This includes hard disk
partitions, external hard disks, RAM disks, and floppy disks.

Now Profile does not scan network volumes, and does not list applications on

400K disks or volumes with the MFS flat file structure used by older Macintosh
models.

4. Click “OK™ to create the report.

A progress box appears on your screen, indicating Now Profile’s status as it scans

various parts of your system. When scanning is complete, the Now Profile report ap-
pears.
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5. Choose an option for reading your report.

You can:

* Read the report on your screen, scrolling as necessary.
Print the report by choosing “Print...” from the File menu.

If you're using PowerTalk with System 7 Pro or 7.5, send the report to another per-
son by choosing “Mail...” from the File menu.

Save the report to be read later by choosing “Save” from the File menu; Now Pro-
file creates a text file that can be opened by any word processing application.

6. When you’re finished using Now Profile, choose “Quit™ from the File menu.

If you haven'’t saved the report yet, you'll be prompted to do so; click “Save” to save
the report, or “Don’t Save” if you don’t want to save it.
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Information in a Now Profile report

The following is a summary of the information contained in each section of a Now Profile
report.

Report header

The header reports the Now Profile application version number, your name as specified in
the Sharing Setup control panel, and the date and time the report was generated.

System information

This section reports information about the system software, including the version,
QuickDraw support, AppleTalk and other networking information, plus other technical
aspects of the system.

Basicreports only the version number of the system software, \Witailed reports all
available information.

CPU information

The CPU (Central Processing Unit) Information section specifies details about the Macin-
tosh hardware. This category does not include memory information, which is displayed in
the next section.

Basicreports your Macintosh model, the processor (680x0 or Power Macintosh), the pres-
ence of a floating point unit, and the status of your monitdd@failed reports this infor-
mation plus information on the Macintosh ROM, sound support, the keyboard and more.

Memory information

This section provides details about the memory-related hardware and software of your
Macintosh.

Basicreports on the amount of RAM installed, the status of virtual memory, and the ad-
dressing mode in use (24-bit or 32-bidetailed adds information on more technical as-
pects of memory use.
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Drivers

The Drivers section provides information about software items currently active on your
Macintosh that are required for communication between software components or hardware
devices and the system or applications.

Now Profile reports on the installed drivers and tells you whether each is built into the
Macintosh ROM or loaded as needed by the System or another program. Many desk acces-
sories are implemented as drivers on the Macintosh, so you may see some of your desk
accessories in this listing.

Standard drivers include those for sound, disk drives, SCSI hard drives, printer and mo-
dem ports, and video displays.

Extension loading order

Now Profile scans the System Folder and identifies extensions (INITs), control panels
(cdevs) and Chooser devices (RDEVs, PRESs, PRERS). It determines which of these con-
tain INIT code in their resource forks, then lists those files that were loaded during the last
startup. Invisible files or those files not located in the System Folder, Extensions Folder, or
Control Panels folder do not appear in this list.

Basiclists the names and version number of the extendizetsiled reports additional
information about their memory usage.

This is followed by a separate analysis of INIT resources for all extensions, control panels,
Chooser devices, and disabled items. Now Profile lists the names of the items, their on/off
status, their version numbers, and more technical information as well.

Fonts

This section provides a list of all fonts that are currently available from the system, or
made available by font-management utilities.

Basicdisplays font names and siz&gtailed displays the font names, the files containing
the fonts, Font IDs, font sizes, and available point sizes.

Desk accessories (DAS)

Now Profile lists all desk accessories found on either the startup volume or on all mounted
volumes, depending on the option selected in the Preferences dialog box before creating
the report.

Basicdisplays the name of each desk accessory and itDst&ijed displays this infor-
mation plus the name of the file containing each desk accessory and its driver ID number.
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Applications

Now Profile lists all applications found on either the startup volume or on all mounted vol-
umes, depending on the option selected in the Preferences dialog box before creating the
report.

Basicdisplays the names and sizes of applicati@®ailed displays this information plus
the four-character creator code and the version number of each application.

Volumes

This section provides a list of all locally-attached volumes, with the total amount of hard
disk space, the amount of free space and the number of files on each volume.

Aliases

Now Profile lists all aliases found on either the startup volume or on all mounted volumes,
depending on the option selected in the Preferences dialog box before creating the report.

Basicdisplays aliases whose original files have been deleted or are located on a volume
that is not currently mounte®etailed displays the names afl aliases on the disk—first
those whose original files can be found, followed by those whose original files are miss-
ing. With both options, Now Profile specifies the pathname of each alias so that you can
locate it easily.

You might periodically set Now Profile to report on this category only, so that you can re-
move unreferenced aliases from your hard disk(s) to save space.

Duplicate files

Now Profile lists all files with duplicate names found on either the startup volume or on all
mounted volumes, depending on the option selected in the Preferences dialog box before
creating the report. The report specifies the pathname of each duplicate file so that you can
locate it easily.

While it's normal to have a few duplicate files on your hard disk, there may be some that
you don’t know about. For example, the installers for many software products place a
copy of TeachText on your hard disk without first checking to see if one is already present.
It's a good idea to have Now Profile report on this category from time to time so that you
can remove duplicate files from your hard disk and save valuable space.
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Chapter 6
Now QuickFiler

With hard disk sizes growing larger and larger, it gets harder and harder to keep track of
all your files and keep them organized. Now QuickFiler is a valuable tool in this effort,
allowing you to view your hard disk and the files it contains in a comprehensive Inspector
window, and perform file management functions directly within the window. Simply by
clicking a button, you can copy, move, alias, delete and print files—plus much more.

When you can't find the one file out of thousands that you want to work with, Now
QuickFiler's powerful Now Find function helps you locate it quickly and perform the
same file management functions, if you wish. You can search based on a wide range of
criteria—up to ten different criteria simultaneously. Finding a file on a local or remote vol-
ume is a snap.

For sending files to colleagues, backing up and deleting files from your hard disk, or any
number of other purposes, Now QuickFiler also provides fast and straightforward
archiving functions. You can even compress files on your hard disk transparently to save
space.
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Managing files

Now QuickFiler improves on the Finder's basic functions of copying, moving and aliasing
files, and more—plus it lets you do so faster and more easily. You'll find you can perform
these and other file management tasks both locally and across a network more efficiently
than before using commands in the Now QuickFiler menu or the buttons in the Inspector
window.

Now QuickFiler Finder menu

When Now QuickFiler is loaded at startup and the “Finder Menu” option is turned on in
the General Options pane of the Now QuickFiler control panel, the Now QuickFiler Finder
menu appears in the Finder menu bar. This menu provides access to the same Now
QuickFiler file management commands that are available through the Inspector window’s
button bar (see the next section, “Inspector window”).
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The “Settings...” command in the Finder menu opens the Now QuickFiler control panel.
See the following sections for details on the other commands.

From this point on, the Now QuickFiler Finder menu is referred to simply as the “Finder
menu” in this chapter.
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Inspector window

The Now QuickFiler Inspector window provides more detailed information on files, fold-
ers and volumes than the Finder and allows you to perform all file management functions
more easily than in the Finder. In fact, with one or more Inspector windows open, you'll
rarely need to use standard Finder functions. Double-clicking folder icons and opening
numerous Finder windows to manipulate files are a thing of the past. This section details
the information and functions available in the Inspector window.

Using the Inspector window

To open the Inspector window, select a volume, folder or file in the Finder that you want
to inspect, and then choose “Inspecfrdm the Now QuickFiler Finder menu. The In-
spector window opens, and if the selected item is a folder or disk, its contents are listed.
To view the contents of any folder or volume appearing in the list, double-click the item
and its contents appear in the window. The name of the opened folder or volume appears
in the pop-up hierarchy menu in the window’s title bar. (If no item is selected when you
choose “Inspect...”, the Inspector window will display the Desktop level of your file sys-

tem.)

You can also open the Inspector window with a Hot Key if you've assigned one for this
function. Use the Button Bar/Menu Options pane of the Now QuickFiler control panel to

do this.
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buttons are active or inactive depending on the Click to navigate upward
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Status bar — Contents list

Indicates the total number of files compressed
or archived, the total original and compressed
size, and the percentage of savings through
compression if a folder or volume is selected.
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Displays the contents of the
folder or volume named in
the pop-up hierarchy menu;
several types of information
are displayed for each item.



Types of information displayed

The table below lists the types of information displayed for each item in the Inspector win-
dow (depending on the size of the window, you may have to scroll horizontally to see all
of the information).

This column...  Displays information on the item’s...

File Name Name.

Original Original size.

Compressed Compressed size.

Saved Space savings through compression.

Status Compression status (or its contents)—whether or not the item is transpar-
ently compressed or archived, or whether it's excluded from compression.

Creator Four-letter creator code.

Type Four-letter file type.

Label Assigned label, if any.

Last Modified Last modified date and time.

Changing the information display

Changing the sort order of information in the Inspector window, as well as resizing or
moving columns, is as easy as clicking and dragging. This table provides details on these
options.

In order to... Do this...

Sort by a type of information Click the column heading for the desired information
type—the contents of the Inspector window are re-
sorted based on the new criterion.

Change column widths Hold down the Control key and drag the dotted lines
to the desired widths.

Move columns to different locations Hold down the Control key, place the pointer in the
heading of the column you want to move, and drag it
to the desired location.

Calculating folder sizes

The Inspector window displays size information for folders, which can take time to calcu-
late (Now QuickFiler waits until there is no mouse or keyboard activity before calculating
folder sizes). If you want folder sizes displayed in the Inspector window, select the “Cal-
culate folder sizes” checkbox in the General Options pane of the Now QuickFiler control
panel.
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Opening additional Inspector windows
To open an additional Inspector window, click the “Inspect...” button in the button bar or
=1 choose “Inspect...” from the Finder menu. You can continue to open additional Inspector
windows and then configure each to view the contents of any volume or folder at any hier-
archical level. Multiple windows let you view your hard disk’s hierarchy at different lev-
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... When you highlight the “Inspect...” command in the Finder menu, a submenu appears

/- providing a direct path to any of the open Inspector windows, as well as an option to open
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a new one.
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File management functions

This table details the file management functions that are available in the Now QuickFiler
Finder menu and in the Inspector window button bar.

This function...

Does this...

Move To...*
Copy To...*
Alias To...*
IE
Print

Get Info

Open

Moves the selected item(s) to a new location; a dialog box opens to
let you specify a destination. Locate and open the folder where you
want the item(s) to go, then click “Move.”

Copies the selected item(s); a dialog box opens to let you specify a
destination for the duplicate item(s). Locate and open the folder
where you want the duplicate item(s) to go, then click “Copy.”

Creates an alias (or aliases) of the selected item(s); a dialog box
opens to let you specify a destination. Locate and open the folder
where you want the alias(es) to go, then click “Alias.”

Opens the selected document, application or folder (or multiple
items if selected). If a document or application is selected, it opens;
if a folder is selected, its window opens in the Finder.

Prints the selected document(s). Any selected document opens in
its creating application and is sent to the printer. When the print job
is complete, the document closes and the application quits.

Opens the Info window for the selected item (the same function as
the “Get Info...” command in the Finder’s File menu).

*The Finder menu displays a submenu of likely destinations for the item being copied,
moved, or aliased. Choose “Other...” to specify a destination other than those shown in
the submenu. When “Copy To...” is highlighted an additional “Current Folder” option
appears, to let you make a duplicate of the selected item within its enclosing folder.
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Customizing the Finder menu and Inspector window

Now QuickFiler has default settings for which commands appear in the Finder menu and
which buttons appear in the Inspector window. If you want to change these settings to add
or remove commands or buttons, click the “Open Now QuickFiler Settings” button in the
Inspector window, or choose “Settings...” from the Finder menu.

In the Now QuickFiler control panel, click the “Button Bar/Menu Options” button to dis-
play the pane shown here.

Nuu.l Iluu:kFlIer

Command EE Hot Key

.Now’ Find™ o
Add to File List o
Dpen ar Launch P
Get Infa o
Print Documents o
Move To o
Copg Tao P
Alias To o

To add or remove a menu command or button, scroll through the list to find the desired
function. Notice that there are two columns beside each function—one for the Finder
menu, and one for the Inspector window. A checkmark in a column indicates that the func-
tion will appear in the corresponding location; just click in the column to make the
checkmark appear or disappear as desired.
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Finding files and folders

Now QuickFiler's Find feature works in much the same way as the Finder’s “Find...”
command, but with greater flexibility, handling up to ten levels of search criteria. When a

search is complete, any items found are displayed together in one Find Inspector window.
Select one of the items found, and the special Find Inspector window indicates the item’s

location and how it matches the search criteria. You can then perform any file manage-

ment function directly on the items. In addition, you can save Sets of search criteria so that

you can conduct repeated searches without having to enter your criteria all over again.

Using Now Find™

The Now Find function is easily available whenever you need to search for an item.

To search for a file or folder:

1.

In the Inspector window, click the “Now Find” button, or choose “Now Find™” from the Finder

menu.

The Now Find dialog box opens.

Now Find™

Mow Find™ Set: Standard w

Perform search on "My Hard Disk * w

for items whose

| narmne V” contains V”

[ 4dd to File List [ Faapr £ ey

) [ ceen )

D Search in archives [ More Choices } [ Fud ]

If you select the “Use Now Find...” checkbox in the General Options pane of
the Now QuickFiler control panel, pressing Command-F in the Finder will also

open this dialog box.

Specify the volume(s) to be searched using the “Search” pop-up menu.

Choose...

To search...

on “[name of startup volume]”
on All Volumes

inside “[name of open window]’

the selected items

The startup volume.

All mounted disks, including network and local
volumes and removable media.

The frontmost open window in the Finder.

Any folders or volumes that you have selected.
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3. Specify the search criteria.

The search options have three parts. In the first pop-up menu, choose the item at-
tribute you want to search by. In the other two menus and/or text fields, choose or
supply the additional information for how items should be matched.

First choose...  then in the second menu choose... and then...

name how names should match the text Type the text to search for—capi-
talization and complete words are
not needed for the search.

size is less than/is greater than Type a size.

kind contains/doesn’t contain Choose a kind of file.

label is/is not Choose a label.

date created is/is before/is after/is not Specify a date by first highlighting

the month, day, or year and typing;
or clicking the arrows.

date modified is/is beforel/is after/is not Specify a date by first highlighting
the month, day, or year and typing;
or clicking the arrows.

version contains/doesn’t contain Type a version number.

comments contains/doesn’t contain Type the text to search for.

lock [no selection necessary] Choose to search for locked or un-
locked files.

contents includes/doesn’t include Type text to search for within files.

visibility [no selection necessary] Choose to search for visible or in-
visible files.

file type isfis not Type a four-letter file type.

file creator  is/is not Type a four-letter creator code.

4. Increase or decrease the number of criteria for searching, if desired.

Click “More Choices” to make another line of criteria available; click “Fewer
Choices” to remove one line of criteria.

If you have more than one line of criteria defined, make a selection on the “for items
matching:” pop-up menu to specify whether found items must match all of the criteria
or just any of the criteria.

5. Select other options as desired to control the search.

Select... To...

Add to File List Add any found items to a Find Inspector list currently displayed.
This capability allows you to conduct repeated searches, adding
the newly-found files in turn to the same list, so that you can
perform an operation on all of the files once you've located
them (archiving, deleting, etc.).

Search in Archives Search by name and/or content for files compressed in Now
QuickFiler archives.
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6. Click “Find.”

Now QuickFiler displays a progress box as it searches. When the search is complete,
any matching items are listed together in a special Find Inspector window. If no
matching items are found, a dialog box alerts you.

Viewing found items

Matching items found during a search are listed together in a special Find Inspector win-
dow. Select an item in the list and the area above the list displays information on the item,
including how the item matches the search criteria (“Why:"), the item’s location on your
hard disk (“Where:"), and the matching portion of the file’s content, if this was a search
criterion (appears below “Where:” only when “contents” was a criterion).
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Once the items are listed in the Find Inspector window, you can perform any of the avail-
able file management functions on them. To open an item, you can double-click it or select
it and press Return, in addition to clicking the “Open” button.
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Adding to the Find list

.| The “Add to file list...” button or Finder menu command is a useful file management
function that’s active only when a Find Inspector window is open. This command allows
you to add any other items to the list of found items in order to perform an action on a
whole group of items at once, such as storing or archiving all the items in one convenient
place, or deleting them. Clicking the button opens a directory dialog box in which you can
locate and select the item you want to add. When you're done adding items, click “Done”
in the dialog box.

Using Find Sets

If you frequently use the same search criteria to find files or folders, Now QuickFiler can
save you the trouble of entering the same criteria each time you search. Using the Find
Sets feature, you can create and save sets of search criteria that you can recall later simply
by choosing them from a pop-up menu.

Creating Find Sets

Anytime you've entered search criteria in the Now Find dialog box, you can save them
into a Find Set.

The following procedure assumes that you haven't yet created any new Find Sets, so that
only the default Standard Set exists.

To create a Find Set;

1. Choose “Now Find™” from the Finder menu; or in the Inspector window, click the “Now Find”
button.

The Now Find dialog box opens, with the Standard Set selected.
2. Choose “Edit...” from the “Now Find™ Set:” pop-up menu.

The Now Find Sets dialog box opens.

Egwe yuin
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3. Click "New.”

A dialog box opens, in which you can enter a name for the new Set.
4. Type the new name and click “OK.”

You're returned to the Find Sets dialog box, where the new Set name appears.

92 Chapter 6—Now QuickFiler



5. Click “OK.”

You're returned to the Now Find dialog box, where the Standard Set is selected in the

“Now Find™ Set:” pop-up menu.
6. Choose the new Set from the “Now Find™ Set:” pop-up menu.
7. Set up the search criteria as desired, then start the search.
The search begins and the results are displayed.

From now on, whenever you open the Now Find dialog box, you can choose this Set
from the “Now Find" Set:” pop-up menu in order to conduct an identical search.

Since the Now Find dialog box always opens displaying the criteria used for the last
search, you can also save a Find Set after conducting a search. To do so, just choose
“Edit...” from the “Now Find™ Set:” pop-up menu, duplicate the current Set containing
your most recent search criteria, and rename it to whatever you want. Click “OK” and
you'll be returned to the Now Find dialog box, where the new Set is available from the
pop-up menu.

Selecting Find Sets

To select an existing Find Set for a search, just choose it from the “NoW Setd pop-

up menu in the Now Find dialog box. The criteria saved in the Set come into view in the
Now Find dialog box, and you can simply click “Find” to start the search. Any modifica-
tions you make to the search criteria before starting the search are saved in the Set.

Chapter 6—Now QuickFiler

93



94

Reducing file sizes

Now QuickFiler provides several ways that you can reduce file sizes in order to better
manage your hard disk. Archiving files that you don’t often use allows you to save disk
space, whether on your main hard disk or on backup media that you use to store the files
after removing them from your system. It's also handy to archive files when you want to
send them to colleagues over a network or online service. Archiving the multiple files
you're sending combines them a single package that's easily retrieved, plus the transfer
goes faster because the files are compressed into the archive. You can also save space on
your hard disk by turning on Now QuickFiler's transparent compression, which com-
presses files in the background when your Macintosh is idle.

Controls for both archiving and transparent compression are available in the Now
QuickFiler Finder menu and in the Inspector window.

Archiving files for backup or transfer

An archive is a collection of files compressed together into a single file to accelerate elec-
tronic file transfers and backups to floppy disks or other removable media. When you cre-
ate an archive, you have the option of making it self-extracting. A self-extracting archive
contains a small amount of application code that will automatically extract the files from
the archive when you double-click it. This means that you can send a self-extracting
archive to colleagues who don’'t have Now QuickFiler and they’ll still be able to open it. A
regular (non-self-extracting) archive has no application code and is slightly smaller than a
self-extracting archive. Regular archives are ideal for sending files to colleagues who have
a copy of Now QuickFiler (or just the freeware Expand Now application included with

Now QuickFiler), or for your own backup purposes if you're trying to save disk space.

An archive appears in the Inspector window as a folder icon with the letter “A.”

Creating archives

When you create an archive, you're creating compressed copies of one or more selected
files and combining the copies into a single file. The individual files are left in their origi-
nal places and remain in the state they were in before the archive was created.

To compress files into an archive:

1. In the Inspector window or in the Finder, select the items you want to place in an archive.
Select multiple items by Shift-clicking.

1, You can select folders as well as files to place in an archive. Placing the files
you want to archive in a folder and then selecting the folder for archiving
makes it a little easier for the person receiving the archive to keep the
dearchived files together.

Chapter 6—Now QuickFiler



. 2. Click the "Archive™ button in the Inspector window, or choose ““Archive” from the Finder menu.

A dialog box appears in which you can name the archive and choose a destination for
it.
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... When you highlight the “Archive” command in the Finder menu, a submenu

W appears that lets you choose whether you want the archive to be compressed in
“Faster” or “Smaller” mode (see “Customizing archive settings” later in this
chapter for more information).

3. Select the location where you want to place the new archive.

4. When you’ve chosen the location for the archive, type the desired name in the “Save as:” text
field.

If you've included a single file or folder in the archive, the default name that appears
in this field is that file or folder's name with “.sea” appended (indicating that the
archive will be self-extracting). If you've included multiple files or folders in the
archive, its default name is “Archive.sea”.

| Now QuickFiler's default settings specify that new archives will be self-extract-

* ing. To create a regular archive, deselect the “Self-Extracting Archive”
checkbox in this dialog box. See the “Customizing archive settings” section
later in this chapter for information on changing the default settings.

5. Click “Save.”

The Now QuickFiler animated cursor spins and a progress dialog box appears, show-
ing the name of each item being archived and the number of items remaining. When
the process is complete, your Macintosh beeps.

The application code in a self-extracting archive slightly increases the overall size of the
archive. In order to create the smallest archives possible, create regular archives; these
can be opened by anyone who owns Now QuickFiler or who has the freeware Expand Now
application (if you will be sending several archives over a period of time to someone who
doesn’t own Now QuickFiler, you may want to first send a self-extracting archive that
contains the Expand Now application in addition to the files you're sending; subsequent
archives you send can be regular ones).
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Breaking archives into segments

Occasionally when you create an archive, you may want to copy it to different media such
as a floppy disk or a removable hard disk. In some cases, the archive may be too large for
the storage media you've chosen. At other times you may need to upload the archive to an
online service that restricts the size of files being uploaded. To help you work with these
situations, Now QuickFiler allows you to break an archive into segments. You can set spe-
cific sizes for the archive segments, or you can allow Now QuickFiler to automatically

size each segment to fill the available space on each disk.

When you’re working with a multi-segment archive, you can select any segment in the
archive, and choose “Dearchive” from the Finder menu to start the dearchiving process for
that archive. Now QuickFiler will begin dearchiving, and search for the other segments of
the archive, then prompt you if it cannot find them in the same folder as the first segment
you chose. Now QuickFiler will know how many segments were created for the archive
and will prompt you for each of them.

A helpful feature of Now QuickFiler is that even self-extracting archives can be broken
into segments. In this case, only the first segment in the archive contains the self-extract-
ing application code. When you double-click the first segment of a multi-segment self-
extracting archive, the self-extracting application will search for the other segments that
belong to that archive. If the segment can’t be found because it's in a different folder or on
a different disk, the application will prompt you to locate the segment that it needs.

See “Customizing archive settings” later in this chapter for information on setting options
for archive segments.

Changing the self-extracting status of archives

Archives can be either regular (non-self-extracting) or self-extracting. You determine what
type an archive will be when you create it, but you can change its type after you create it
as well. To do so, just select the archive and choose the “Self-Extracting” command from
the Finder menu (checked if the archive is self-extracting, unchecked if not). A regular
archive can be changed to a self-extracting one within the Inspector window by selecting
the archive and clicking the “Make Self-Extracting” button. The button does not appear if
the selected archive is self-extracting already.

Click this button to change a regular archive to a self-extracting one. The presence of this
button indictates that the selected archive is not yet self-extracting.
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Dearchiving single files from archives
When you want only one of the files stored in an archive and don’t want to dearchive its
entire contents, you can easily dearchive just the single file.

To extract a file out of an archive:

1.

In the Inspector window, select the archive containing the file you want to extract, and click the
“Inspect” button.

The contents of the archive are displayed.
Select the file that you want to extract.

Click the ““Dearchive™ button in the Inspector window, or choose “Dearchive™ from the Finder
menu.

A directory dialog box appears, prompting you to select the destination for the
dearchived file.

Choose the desired destination and click “Extract.”

The file is dearchived and placed in the location you specified.

Dearchiving entire archives

Extracting items from compressed archives is as easy as creating them. Since most ar-
chives are self-extracting you can double-click an archive and a decompressed copy of its
contents is copied to your disk. Regular archives require the presence of Now QuickFiler
(or the freeware Expand Now application) in order to be opened.

To dearchive an entire archive:

1.
2.

In the Inspector window or in the Finder, select the archive you want to dearchive.

Click the ““Dearchive™ button in the Inspector window, or choose ““Dearchive” from the Finder
menu.

A dialog box appears and asks where you want to place the items stored in the
archive.

You can also dearchive an archive’s contents by dragging it onto the Expand
Now application icon, or by simply double-clicking it.

Select the destination folder.
Select any folder or create a new one.
Click “Extract.”

The Now QuickFiler animated cursor spins and a status window appears to show the
progress of the dearchiving. When the process is complete, your Macintosh beeps.

I If you're dearchiving the contents of the archive into the same folder where the
*~ original files are located or where there are files with the same name as the
archived files, a dialog box asks you to name the dearchived document(s). Type
in the desired name for each dearchived document and click “Save.” If you
don’t change the name of the item, a dialog box asks if you want the dearchived
file to replace the original.
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Customizing archive settings

Now QuickFiler offers several options for customizing the archives you create. To view or
modify these options, click the “Open Now QuickFiler Settings” button in the Inspector
window, or choose “Settings...” from the Finder menu.

In the Now QuickFiler control panel, click the “Archive Options” button to display the
pane shown here.

B Now QuickFiler

R EGH
Archive Preferences

Compression level: Srnaller i I

Size seqments to: Fit disk - l:l
D Archive aliases through ta actual file/folder
E Archives are self-extracting by default

@ Azk for file name when creating archives

ESelf—extracting archives ask for destination

Dearchive Preferences :

File replacernent : azk before Replacing  w I
fter dearchiving: | Keep Archive -

Notification Preferences:

EBeep when finished archiving or dearchiving

Use this option... To specify...

Compression level Fastecompression (with somewhat less sav-
ings in disk space) @maller compression (at a
slightly slower speed).

Size segments to The file size limit over which archives will be
broken into segments to fit the media you are
transferring them to.

Archive aliases ... to actual file/folder That you can archive an original file by select-
ing its alias.

Archives are self-extracting by default That archives will be self-extracting by default.

To override this setting, deselect the
“Self-Extracting Archive” checkbox in
the dialog box that opens when you're
creating an archive.

Ask for file name when creating... That you'll be prompted to name an archive
when you create it instead of a default name be-
ing assigned to it.

Self-extracting archives ask for... That you'll be prompted to specify a destination
for an archive when you create it.

continued on next page
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Use this option... To specify...

continued from previous page

File replacement How Now QuickFiler should handle situations
in which you dearchive files to locations con-
taining identically-named files: choogesk be-
fore Replacingto specify that a dialog box will
prompt you for a new file name; chodRe-
place without Asking to specify that the new
file will replace any file that has the same name;
chooseSkip Files in Conflict if you don’t want
a file in the archive to replace a file of the same
name. In the last case, the file will not be
dearchived.

After dearchiving What Now QuickFiler should do with an archive
once you've dearchived its contents: choose
Keep Archive to keep an archive on your hard
disk after dearchiving its contents; cho@=
lete Archive to delete an archive after
dearchiving its contents; choo&sk to Delete
Archive to be asked for a confirmation before
deleting an archive after dearchiving its con-
tents. Note that this setting is ignored when files
are dearchived by double-clicking from the

Finder.

Beep when finished... That your Macintosh will notify you with a
sound when it is finished archiving or
dearchiving.

Increasing hard disk space with transparent compression

In addition to its archiving functions, Now QuickFiler allows you to effectively double the
available space on your hard disk by compressing your files transparently. Unlike archived
files, transparently-compressed files don’t appear to be compressed in any obvious way,
and they open just like uncompressed files when you double-click them. However, they
can be as much as half their uncompressed size, freeing up substantial disk space as a re-
sult. You can allow transparent compression to take place when your Macintosh is idle, or
you can compress files manually whenever you wish.

Activating transparent compression
By default, transparent compression is turned off in Now QuickFiler. You can turn it on
easily in the Now QuickFiler control panel.

Be aware that the transparent compression functions increase Now QuickFiler's RAM re-
quirements, so if you don’t want to use the feature, you should leave it turned off.
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To activate transparent compression:

1. In the Inspector window, click the “Settings” button, or choose ““Settings...” from the Finder

menu.

The Now QuickFiler control panel opens.

E0 Now QuickFiler Si—"—

General Options :

Transparent Compression ODn @ off
Finder Menu: I@:)Dn O off
Findetr and Inspector Options:

D Caloulate falder sizes in Inspector

D Change iconz of compressed files

E Use MNow Find az Find cormand in Finder

Keep Files Compressed When Copying To:

[<] The same disk [] Remnovable hard disks
[ Hard disks O Fioppies  [] Backups
Autornatically Compress

[ % 4 wolumes ||
[ =y Hard Disk
[ =ramM risk

2. Click the “General Options™ button at the top of the control panel (if this pane isn’t already

100

being displayed).
3. Turn on “Transparent Compression” (if it isn’t already turned on).
4. Select the volume(s) on which you want files compressed during idle-time.

In the scrolling list at the bottom of the General Options pane, select the checkbox
next to one or more of the individual volumes listed, or select “All volumes” if you
want idle-time compression to take place on all volumes mounted by your Macintosh,
including floppy disks and removable hard drives (Now QuickFiler will not compress
items on network volumes). All files on the volumes you select, except the System
Folder and any files you may have excluded (see “Excluding items from compres-
sion” later in this chapter), are marked for idle-time compression.
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5. Set other transparent compression options as desired.

Select... To specify that Now QuickFiler will...

Change icons... Indicate that a file is compressed by changing its icon (as
illustrated in the control panel.

The same disk Keep a file compressed when it is copied to another location
on the same disk.

Hard disks Keep a file compressed when it is copied from any disk to

another hard disk.

Removable hard disks Keep a file compressed when it is copied from any disk to a
removable hard disk.

Floppies Keep a file compressed when it is copied from any disk to a
floppy disk.
You may want to deselect this option if you often give
copies of files on floppies to others who do not have
Now QuickFiler installed on their systems.
Backups Keep a file compressed when it is backed up. (Retrospect
Remote will keep the file compressed when backed up
across a network—other backup products may not.)

6. Close the control panel to save your settings.
7. Restart your Macintosh.

The new settings won't take effect until your Macintosh is restarted. After restarting,
you need to define your settings for transparent compression.

Setting up transparent compression

Now QuickFiler offers a number of settings for how and when transparent compression

will take place. Before any transparent compression will take place on your system, you
must either compress files manually, or select at least one option for automatic transparent
compression. To view or modify the transparent compression options, click the “Settings”
button in the Inspector window, or choose “Settings...” from the Finder menu.

In the Now QuickFiler control panel, click the “Compress Options” button to display the
pane shown here.
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Use this option... To specify...

Compression level  Fastecompression (with somewhat less savings in disk space) or
Smaller compression (at a slightly slower speed).

File cache size The size of the file cache memory. The larger the cache, the faster
Now QuickFiler can decompress files. With less than 4 MB of
RAM installed, the default file cache size is 64K; with more than 4
MB, the default is 256K. Changes made here do not take effect un-
til you restart.

If unmodified for A length of time that a file must remain unmodified before it can
be compressed.
I If you're compressing a file manually and the file has been
¢ modified more recently than this setting allows, Now
QuickFiler will ask if you want to override this setting and
compress the file anyway. During idle-time compression,
files that have been modified more recently than this setting
will not be compressed.

If system is idle A length of time that the system must be idle (no keyboard or
mouse activity) before idle-time compression can begin. The de-
fault setting is two hours.

During the time A period of time when idle-time compression will take place.

If you don’t also select the “If system is idle” option, com-
pression will take place only during the time period speci-
fied here.

At system shutdown That compression will take place when you choose “Shut Down”
from the Special menu in the Finder. Your Macintosh will shut
down as soon as compression is completed.

On battery power  Whether or not idle-time compression can take place if your
Macintosh is on battery power. To ensure maximum battery life on
a portable Macintosh, leave this option deselected.

Start Compressing A corner of the screen to place your pointer to start compression
immediately. The “None” setting deactivates this option.

Never Compress A corner of the screen to place your pointer to prevent idle-time
compression from occurring. The “None” setting deactivates this
option.

.. This option is useful when you're transferring a file elec-

V¥ tronically or sending a large document to be printed and
you don’t want background activity, such as idle-time com-
pression, to slow down the main operation.

Opening transparently-compressed files

Compressed files open virtually as fast as uncompressed ones. When you open a com-
pressed file, it's decompressed into memory. If you make no changes and close the file, it
remains compressed on your disk. If you modify the file and close it, it is saved to your
disk uncompressed. It will then be compressed again the next time your Macintosh is idle,
or you can compress it manually before then.
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Excluding items from transparent compression

At times, you may want to exclude individual files or folders from transparent compres-
sion. Now QuickFiler's Don't Compress options permit you to set criteria that will prevent
transparent compression of selected files, folders and disks. The System Folder is always
excluded from compression. To view or modify these options, click the “Open Now
QuickFiler Settings” button in the Inspector window, or choose “Settings...” from the
Finder menu.

In the Now QuickFiler control panel, click the “Don’t Compress Options” button to dis-
play the pane shown here.
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From the “Don’t Compress” pop-up menu at the top of the control panel, choose “Files,
Folders, and Disks” in order to list the files, folders, and volumes you want to exclude
from compression; or choose “Label” to exclude from compression items that have been
marked with a certain label. Select one or more of the labels by selecting the correspond-
ing checkboxes.

Click... In order to...

Add... Add an item to the exclusion list.

Remove Remove the selected item(s) from the exclusion list.
Inspector... Open the Inspector window to verify your exclusions.

In the Inspector window, you can exclude an item from transparent compression by select-
ing it and clicking the “Don’t Compress” button; or you can choose the “Don’t Compress”
command from the Finder menu in the Inspector window or in the Finder.

When you highlight the “Don’t Compress” command in the Finder menu, a submenu ap-
pears that lets you choose whether you want to exclude just the selected item itself, all
items with the same creator code as the selected item, all items with the same type code as
the selected item, or all items with the same Label as the selected item. (This is the only
place where the Creator and Type options are available.)
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Marking items for idle-time compression

Normally, if you select a hard disk in the “General Options” pane of the Now QuickFiler
control panel and turn on transparent compression, every item on the disk except the Sys-
tem Folder and its contents is marked for idle-time compression. However, since you can
exclude certain items from compression using the procedure described previously, it's also
possible to mark specific items for idle-time compression. For example, suppose there’s a
specific folder whose contents you want to be compressed during idle time, but it resides
inside a folder that you've excluded from transparent compression. Without having to turn
off the exclusion for the outside folder, you can still mark the inner one for idle-time com-
pression.

To do so, select the item you want to mark and, in the Inspector window, click the “Com-
press When ldle” button; or choose “Compress When Idle” from the Finder menu.

When you highlight the “Compress When Idle” command in the Finder menu, a submenu
appears that lets you choose whether you want the item to be compressed in “Faster” or
“Smaller” mode (see “Setting up transparent compression” earlier in this chapter for
more information).

Decompressing items
In addition to double-clicking a compressed item to open it, Now QuickFiler offers other
ways to decompress an item. Simply select it and:

* Click the “Decompress” button in the Inspector window,

e Choose “Decompress” from the Finder menu, or

 Drag the item’s icon onto the Expand Now application icon (see “Drag-and-drop com-
pression applications” later in this chapter for more information).

Remember that these three methods only decompress the item and don'’t open it. Double-
clicking a file both decompresses and opens it.

Once decompressed, a file will remain uncompressed until you compress it manually or
until it is compressed during idle-time compression.

Compressing files manually

When you find that your available disk space has become limited and you want to free up
some space immediately, rather than waiting for idle-time compression to become active,
you can compress files manually.

Simply select the item(s) you want to compress and, in the Inspector window, click the
“Compress” button; or choose “Compress” from the Finder menu. If you try to compress a
file or folder that has been excluded from compression, an alert box appears informing you
of the exclusion.
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To override this exclusion and compress the file anyway, select the appropriate checkbox
and click “OK” (if you're attempting to compress multiple items that are excluded by

more than one criterion, additional checkboxes will appear here for each type of exclu-
sion). If you don’t want to override the exclusion(s), just click “OK” without selecting any
checkbox.

When you highlight the “Compress” command in the Finder menu, a submenu appears
that lets you choose whether you want the item to be compressed in “Faster” or
“Smaller” mode (see “Setting up transparent compression” earlier in this chapter for
more information).
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Converting files compressed in other formats

If you have files or archives on your hard disk that were compressed by AutoDqubler
DiskDoublef", Compact Pr®, Stufflt” 1.5.1 or SpaceSaverNow QuickFiler can convert
them to its own compression format so that all of your files are compressed in the same
format. To convert files or archives to Now QuickFiler format, select them (or a folder
containing them) and click the “Convert” button in the Inspector window, or choose “Con-
vert” from the Finder menu. Now QuickFiler decompresses the files from their original
formats, then compresses them again in its own format.

Be aware that when you convert files, you must have enough free space on your hard drive
to decompress your largest compressed file. If Now QuickFiler runs out of space while
converting a file, it will skip that file and then ask if you want to continue with the conver-
sion, in case there are other smaller files that can still be converted with the available disk
space.
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Drag-and-drop compression applications

. .

A chive Mow Cornpress Mow

.

Expand Now

The Archive Now, Compress Now and Expand Now applications were placed in the “Now
Utilities™” folder on your hard disk at installation. We suggest that you move these appli-
cations to the desktop for easier access. The drag-and-drop applications make Now
QuickFiler easier to use because, for example, you can archive multiple items simply by
Shift-selecting their icons and dragging them to the Archive Now application icon; or de-
compress a compressed item by dragging its icon to the Expand Now application icon.

The Expand Now application is freeware, so you can give it to anyone who doesn’t have
Now QuickFiler to open compressed files and regular archives.

Defining Hot Keys for Now QuickFiler commands

You can activate any of the Now QuickFiler commands or functions with a Hot Key. De-
fault Hot Keys are already set for several of the commands; if you want to change the de-
fault settings or define a Hot Key for a command that has no default setting, click the

“Open Now QuickFiler Settings” button in the Inspector window, or choose “Settings...”
from the Finder menu.

In the Now QuickFiler control panel, click the “Button Bar/Menu Options” button to dis-
play the pane shown here.
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Locate the command that you want to define a Hot Key for, and click in the Hot Key field
for that command to select it. Press the desired key combination and it appears in the field.
You can use any combination of modifier keys (Command, Option, Shift, Control) plus a
character, function key, or numeric keypad key. Avoid using the Command-letter combi-
nations used for Finder menu commands, as any Hot Keys you define will take precedence
over previously-existing Finder menu combinations.
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Chapter 7
Now Save

Now Save can automatically save documents you're working on at regular intervals, pre-
venting data loss due to an untimely system error, power failure, or other problem.

You can configure Now Save to save documents automatically from within any applica-
tion, like a word processing, graphics or spreadsheet application, and set auto-saving to
occur after a specified time interval, number of keystrokes, and/or number of mouse
clicks. If you wish, you can set Now Save to simply remind you to save rather than carry-
ing out an automatic save.

Now Save’'s Key Capture feature works in the background, continuously recording your
keystrokes into date-stamped text files. Should you lose work because of a crash that oc-
curs before an auto-save can take place, a Saved Work file automatically opens at the next
restart, allowing you to reconstruct your work from an “audit trail” of your keystrokes.

Saving documents automatiCally ...............eeeveiiiiiiiiii 109
Activating automatic saving from the Now Save control panel.............cccoccvvvvvnnnnn. 109
Adding applications to the Application LiSt........ccccccceviiiiiiiiiiiieiiee e 110
Changing the auto-save status of an application .............ccccccveveeereee i, 110
(@] 110 8T aTe =10} (o Rt=T= /] oo [ 110
Excluding filenames from auto-Saving ..........ccccovieeiiiriee e 112
Activating auto-saving from within applications ............cccccceeeeeriiiiiiiciiiee e 113
Adding applications to the Application List automatically ................cccccvvvveennnnn. 113
Configuring auto-save settings within an application ..........ccccccceeeeiiiiiicciiiiennnn. 113
Capturing keystrokes with Key Capture..........ccccoviiiiiiiiiiiiiiiiiieeeeeeeeee 116
Activating and configuring Key Capture .........ccocveiiiiiiiieeiniiiee e 116
Opening Saved WOrK filES ... 118
Deleting Saved WOIK fIleS ........oooiiiiiiiiii e 118
NOW SaVe Prefere€NCES .....cooviiiiii et 119
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Saving documents automatically

It's easy to set up Now Save to save documents automatically while you work in applica-
tions. Automatic saving lets you work uninterrupted, with the security of knowing that all
of your work is being saved regularly without your having to think about it. You never
have to use the “Save” command or lose more than five minutes’ worth of work again.

Now Save lets you specify how frequently you want your documents to be saved, disable
the saving of documents with certain names, and other options—with independent settings
for every application. You can set these options either from Now Save’s control panel, or
directly within the applications using the Now Save Configure dialog box.

To activate automatic saving in an application, you must first add the application to Now
Save’s Application List. Once the application has been added, Now Save will automati-
cally save all documents you create in it according to the saving intervals you've specified.
The default is to automatically save after five minutes, 500 keystrokes or 250 mouse
clicks, whichever comes first.

Activating automatic saving from the Now Save control panel

Though you can turn on automatic saving from within applications, the Now Save control
panel provides a central location for reviewing your settings for automatic saving and the
applications in which it's active.

Click to Click to remove Click to view or modify Click to view or
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Adding applications to the Application List

The first step in activating auto-saving in an application is adding it to Now Save’s Appli-
cation List.

To add an application to the Application List:

1. In the Now Save control panel, click the “Add Applications™ button.

A directory dialog box opens, in which you can locate the application you want to
add.

2. Locate and select the desired application, then click “Add.”

| You can continue to add applications, if you wish, by repeating this step.

3. Click “Done.”

You're returned to the Now Save control panel, where the name of the application you
added appears in the Application List with a checkmark in front of it. The checkmark
indicates that auto-saving is turned for the application.

Changing the auto-save status of an application

To turn off auto-saving for an application temporarily, select it in the Application List and
click the “Activate/Deactivate Selected Application” button. When the checkmark disap-
pears, automatic saving is turned off.

To turn off auto-saving permanently, remove the application from the List by selecting it
and clicking the “Remove Application” button.

Configuring auto-saving

Once you've added an application to the Application List, auto-saving is active in the ap-
plication. You can then use the control panel to specify how often auto-saving should oc-
cur, as well as other options. When an application is added to the List, it initially has the
same auto-save settings as the “Default” item at the top of the Application List. The “De-
fault” item lets you specify default auto-save settings that will be in effect for each appli-
cation added to the List. This way, if you have preferences for auto-saving that are
relatively consistent across applications, you don't need to do any extra work when you
add a new application. It's easy to change these default values for a few applications that
may call for different settings.

To configure automatic saving:

1. In the Application List, select the application you want to configure (or select the “Default™ item
to configure settings for all new applications).
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Set the auto-save interval as desired.
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Under Now Save'’s initial default settings, documents will be saved automatically after
five minutes, 500 keystrokes, or 250 mouse clicks—whichever comes first. Select or
deselect the Minutes, Keystrokes and Mouse Clicks checkboxes and change their val-
ues as desired; you can select any combination of intervals in minutes, keystrokes or

mouse clicks.

i, Auto-saving according to the number of keystrokes works well in a word-pro-
cessing or spreadsheet application, but you may want to save according to
mouse clicks in a graphics or music sequencing application.

Set the options for Now Save’s behavior within the application.
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Select... To specify that...

Announce before auto-save An alert will appear when an auto-save is due.
You can specify the type of alert in the Prefer-
ences dialog box.

Add “Now Save...” to File menu The “Now Save...” command will appear in the
application’s File menu. Choosing this command
opens the Now Save Configure dialog box.*

Suppress countdown display ~ Now Save will ignore the Hot Key you've set in
the Preferences dialog box for the countdown dis-
play and not show the display when you press
those keys (see “Now Save Preferences” later in
this chapter for more information).

*For more information on the Configure dialog box, see “Activating automatic sav-
ing from within applications” later in this chapter.

Choose whether you want Now Save to save documents automatically or just remind you to
save when an auto-save is due.
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Select... To specify that...

Save document Documents will be saved automatically whenever an auto-save is
due, without interrupting your work.

Remind Only  Now Save will display a reminder to save the document whenever
an auto-save is due, instead of saving it automatically; this alert dia-
log box lets you save the document, postpone saving it for a period
of time that you specify, or choose not to save it.

Excluding filenames from auto-saving

When you want auto-saving turned on but there are certain documents that you don’t want
to be auto-saved, you can configure Now Save to exclude documents from auto-saving
according to their filenames. For example, you might specify that Now Save will not auto-
save any PageMaker documents whose filenames contain the word “template.”

To exclude a filename from auto-saving:

In the Now Save control panel, select the application in which you want to exclude a filename.

1.
2. Click the “No Action If... Page” button.

112

The “No action if the file name:” list replaces the auto-save settings area.
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3. Click “Add...”.

A dialog box opens where you can specify the text to be excluded and how Now Save
should match it.
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4. Type the desired text in the text field.

5. Choose a matching option from the pop-up menu.
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Choose... To specify that a document will not be auto-saved if its name...

Begins with Begins with the specified text.
Matches Matches the specified text exactly.
Contains Contains the specified text, whether in its beginning, middle or
end.
Doesn’t Contain Does notcontain the specified text.
6. Click “OK.”

You're returned to the Filename Exclusion area, where the exclusion you set up now
appears in the list.

You can also modify or remove an existing filename exclusion by selecting it in the list and
clicking “Edit...” or “Remove,” respectively.

Activating auto-saving from within applications

While the Now Save control panel is a convenient and central location for reviewing and
modifying your auto-save settings, you can also activate auto-saving and modify your set-
tings from within an application, without having to return to the Finder and open the con-
trol panel.

Adding applications to the Application List automatically

Now Save is set to automatically save every application’s documents by default. However,
if you prefer, you can change Now Save’s preferences so that you are asked about each
and every application. If you tell Now Save to ask (see the following section describing
preferences, you'll see a dialog box the first time you start an application, asking if you
want to add the application to the Application List.
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Selecting one of the options in the dialog box allows the application to finish opening.

Click... To specify that...

Add to List The application will be added to Now Save’s Application List, to indicate
that its documents will be saved automatically.

Don't Add  The application will not be added to Now Save’s Application List, and its
documents will not be saved automatically.

Configure... A dialog box will open in which you can set your preferences for what Now
Save should do the next time you open a new application.
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When you click “Add to List” or “Don’t Add” in the dialog box, your selection is saved
and the application finishes opening. When you click “Configure...”, the dialog box
shown below opens.
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Select... To specify that...

Ask when opening... The previous dialog box will appear each time you open a
new application, asking you if you want to add it to the Ap-
plication List.

Do not ask when opening. No dialog box will appear when you open a new application,
and applications can be added to the List only in the control
panel.

Automatically add... Applications will be added to the List automatically the first
time you open them, with no dialog box prompt.

I If you don’t add the application to Now Save’s list and later decide you do want to, you
*~ can activate and set up auto-saving from within an application using the Now Save Con-
figure dialog box or in the control panel.
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Configuring auto-save settings within an application
Now Save is available within any application to let you address the following situations:

« You're working in an application that you haven't added to the Application List, and

you decide you want to activate auto-saving.

< You're working in an application that is in the List but you've turned off auto-saving

temporarily and you want to turn it back on.

< You're working in an application that is in the List and in which auto-saving is active,

but you want to change your auto-save settings.

You can take care of any of these easily by opening the Now Save Configure dialog box.

To configure auto-save settings within an application:

1.

2.

Within an application, press Command-Shift-Option-S.

The Now Save Configure dialog box appears. Note that this dialog box contains the
options found in the control panel; your settings here affect the current application
only.
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Command-Shift-Option-S is simply the default Hot Key for the Configure dia-
log box; you can change the key combination in the Preferences dialog box (see
“Now Save preferences” later in this chapter).

Depending on the situation, choose one of the options below.

In order to... Do this...
Add the application to the List and start auto-saving Click “Begin” (modify the auto-
save settings first if you wish).

Reactivate auto-saving in the application Click “Resume.”
Change the application’s auto-save settings Change the settings as desired,
then click “OK.”

Refer to the previous section on the Now Save control panel for information on
the settings available in this dialog box.

When you click “Begin,” “Resume” or “OK,” you're returned to the document win-
dow. The document will be auto-saved at the interval(s) you've specified until you
quit the application or turn off auto-saving.

Chapter 7—Now Save 115



116

Capturing keystrokes with Key Capture

Now Save’s Key Capture option complements automatic saving by providing another level
of protection against data loss. Key Capture works in the background, recording every
keystroke you type in all applications and saving them in a standard text file. Should a sys-
tem error or other problem occur and you lose a file or the work you did since the last
save, you can open your Saved Work file and recover what you typed.

Activating and configuring Key Capture

Upon installation, Key Capture is turned on and saving your keystrokes under basic de-
fault settings. To view and configure other settings, open the Key Capture dialog box by
clicking the Key Capture button in the Now Save control panel. The Key Capture dialog
box appears.
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To turn Key Capture on or off, select the “On” or “Off” button in the upper right of the
dialog box. Other Key Capture options are listed below.

This option... Does this...

Each Restart Specifies that a new Saved Work file will be created
each time you restart your Macintosh. Saved Work
files are named “Saved Work [date created].” If mul-
tiple files are created in the same day, additional files
are named “Saved Work [date created] #2” and so on.

Every __ day(s) Specifies that a new Saved Work file will be created
at an interval of days that you enter here. If you restart
frequently during the day, selecting this option and
entering “1” day can help minimize the number of
files created.

Choose Creating Application... Lets you choose the application that will open Saved
Work files when you double-click them.

Auto-delete after __ day(s) Specifies when Now Save should automatically delete
Saved Work files. When this option is deselected,
Saved Work files continue to accumulate until you
delete them manually, either in the Finder or by click-
ing “Delete files...” in this dialog box.

continued on next page

Chapter 7—Now Save



This option... Does this...
continued from previous page

Warn before auto-deleting Specifies that a confirmation dialog box will appear
before Now Save deletes Saved Work files automati-
cally.

Delete files... Opens the Delete Files dialog box where you can se-
lect the Saved Work files you want to delete.

Record backspaces Records backspace characters as well as the text pre-

ceding and following each one, so that all of the char-
acters you type are saved. When this option is
deselected, only the actual corrected characters ap-
pear.

For example, if this option was selected and you
typedrecieve backspaced ovéeve then typeckive
Key Capture would record
recieve[DEL][DEL][DEL][DEL]eive.

With the option deselected, the waeteivewould
appear only in its final, corrected version.

Include pasted text Specifies that text you paste from the Clipboard will
be recorded in Saved Work files, as well as text you
type.

Include Application and window Specifies that in a Saved Work file, each entry of
saved keystrokes will begin with the name of the ap-
plication and the window (document name) in which
it was typed (this helps you identify the text you're
looking for when you have a large Saved Work file).

Exclude modifier keys Specifies that modifier keys you press (Command,
Option, Control, Shift) will not be recorded in Saved
Work files.

Warn if ... more than __ K Specifies that an alert dialog box will appear if the

current Saved Work file exceeds the size indicated in
the text field.

Pause/Resume Key Capture Allows you to set a Hot Key that you can press to
pause and then resume the recording of keystrokes.

i, This option is useful when you need to type a
password for logging onto a server, etc., but
you don’t want the password to be recorded in
a file that someone else could open.

“Tick” when paused Specifies that while Key Capture is paused, pressing
keys will make a ticking sound to remind you that
your keystrokes are not being recorded.

When you're finished setting the Key Capture options, click “OK” to return to the control
panel.
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Opening Saved Work files

When Key Capture is active, every keystroke you type is saved in a file called “Saved
Work [date created]”; these files are stored in the “Saved Work Folder” inside the System
Folder.

If your Macintosh crashes, Now Startup Manager will automatically open the mostrecent
Saved Work file the next time you restart your machine.

To view text that you typed when Key Capture was active, locate the “Saved Work [date
created]” file for the desired date inside the Saved Work Folder and double-click it. Unless
you've changed the creating application in the Key Capture options, the document opens
in TeachText or SimpleText. You can then view your saved keystrokes and copy and paste
them into another application to reconstruct your work, if necessary.

You may not be able to open a Saved Work file directly when Key Capture is active. To
open the file, either turn off Key Capture temporarily, or duplicate the file and open the
duplicate.

Deleting Saved Work files

= If you don't have Now Save set to delete Saved Work files automatically, you may find
that they are accumulating and you want to remove them from your hard disk to free up
space. You can do this by opening the Key Capture dialog box and clicking “Delete
files...”. A dialog box opens, listing all of the existing Saved Work files.

Debeie dlec

Sqvqd Werk 117175

Eavad Wk 11/ TR
Eavad Wk 117155
Eavad Wark 117700
Eavad Werk 11/71/%4
Eavd Wark 11772054
Eavad Wark 11/2%%

To delete Saved Work files, just select one or more files and click “Delete.” Any selected
files are permanently deleted.
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Now Save preferences

You can set global preferences for Now Save in the Preferences dialog box. To open it,
click the “Preferences” button in the Now Save control panel.

Fnkall Preforaeeny
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Use this option... To specify...

Wait for __ seconds of idle time...

Highlight File menu when saving

Announce by window

Show window for __ seconds

That a certain amount of idle time must elapse be-
fore an auto-save occurs. When this option is se-
lected and an auto-save is due, Now Save will wait
until there has been no keyboard or mouse activity
for the amount of time specified here before it
auto-saves. This prevents an auto-save from inter-
rupting your work.

That Now Save will highlight the File menu title
while auto-saving is in progress. This serves to
remind you of what's happening, since an auto-
save makes your Macintosh briefly unavailable.
That Now Save will display an Announce dialog
box before an auto-save occurs.

| o e

This dialog box will stay on your screen for the

amount of time specified in “Show window for...”

and then the auto-save will occur. While the dialog

box is on your screen, you can cancel the auto-

save by clicking “Abort” or pressing any key.

| Aborting does not disable Now Save—an

auto-save will occur the next time one is
due.

The number of seconds that the Announce dialog

box is displayed, after which the auto-save occurs.

continued on next page
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Use this option... To specify...

continued from previous page

Replace Apple with Now Save Icon That the Apple icon will be replaced by the Now
Save “NS” icon during an auto-save (and before
one, if the checkbox below is selected). When you
see this icon in the menu bar, you can cancel the
auto-save by pressing the Countdown dialog box
Hot Key.

Flash icon when ready to auto-save That the Now Save icon will flash over the Apple
menu icon when an auto-save is due. This serves
as notification to you when you're still typing or
using the mouse that Now Save is waiting for the
specified amount of idle time before auto-saving.

Configure dialog Hot Key The key combination that you press in an applica-
tion to open the Now Save Configure dialog box.

Countdown dialog key combination The modifier key combination used to display the
Countdown dialog box. This dialog box lets you
see how close you are to the next auto-save.

drili-Gaee b

0 0T 4
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Ask when opening new applications That a dialog box will appear each time you open
a new application, asking you if you want to add it
to the Application List.

Don’t ask when opening new apps That no dialog box will appear when you open a
new application, and applications can be added to
the List only in the control panel.

Automatically add new applications That applications will be added to the List auto-
matically the first time you open them, with no
dialog box prompt.
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Chapter 8

Now Scrapbook

Now Scrapbook helps you organize graphics, text documents, and other files by allowing
you to catalog PICT, Paint, TIFF, EPS, GIF, JPEG, TEXT, sound, and QuickTime movie
files all in one document. It offers many more features than the standard system Scrap-
book, and is a must for putting together presentations, desktop publishing, or writing—to
name just a few applications. Once your items are stored in a Now Scrapbook catalog, you
can easily sort, rearrange and find them. In Now Scrapbook’s Clipboard Editor you can
crop, resize or select portions of graphics as well as edit text.

Opening and creating a Now Scrapbook catalog............ccccceeevvviiviiiiinnnn, 123
Viewing a Now Scrapbook catalog ...........eeevveviiiiiiiiiiiiiiiiiiei 123
STANAAIA VIBW ...ttt nn e e 123
BULLON DA ... s 124
DELAI VIBW ...ttt ettt et 125
Detail VIEW ElEMENTS ......coiiiiiiiiie e 125
THUMDBNAI VIBW ... 126
Adding items to a Now Scrapbook catalog ...........cccccvvvviiiiiiiiiiiiiiieeeeeeen, 127
Pasting from the CHPDOAId ...........cooiiiiiiiii e 127
IMPOITING TIlES oo 127
Organizing items iN Catalogs ........ccuuiiiieiiiiiiie e 129
Changing itEM NAIMES ......coiiiiiiteee et e e e e e e e e e s e ennbbebeeeeaeas 129
ASSIGNING KEYWOIAS 10 IEIMS ...t 129
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Finding items by name or KEYWOIS .........coooiiiiiiiiiiiiiieiiie e 130
Moving items between Now Scrapbook catalogs ............ccceeiriiiiiiiiiiiiiiiieieeeeeee 131
Removing items from Catalogs .........uueiiiiiiieiii e 131

Chapter 8—Now Scrapbook 121



122

Editing catalog ITEMS .......oooiii e 132

Editing graphics in the Clipboard EditOr............ccooiiiiiiiiiiie e 132

Editing text in the Clipboard EdItOr ...........ccooiiiiiiiiiiiiiieeiieee e 134
Using catalog items outside of Now ScrapbooK............cccocovvviiiiiiiiinnnnnnn. 136
Copying items to the Clipboard ...........cc.oooiiiiiiii e 136
Deselecting item resources When COPYING .....coovveiiiiiiiiiie e 136
Exporting items as separate fileS ..o 137
EXPOrting itEMS @S MESOUITES .....o.uviiieeiiiiieee ettt e ettt e et e e e et e e e s e e e e e e 138
Printing items and catalogs ............uuuvueiiiiiii e 139
Now Scrapbook Reference ..........ccccuuuiiiiiiiiiiie e 140
Now Scrapbook Menu COMMANGS .........uuuiiiiiiee e e e enenes 140
FIlE MENU .. 140

EIE MENU .o 141

WINAOWS IMENU ..ottt e s e snn e e snneena 141
Preferences dialog DOX .......ooociiiiiiiiicc e 142
File formats supported by Now Scrapbook ... 143
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Opening and creating a Now Scrapbook catalog

To store items using Now Scrapbook, you must first open the application. Just choose it
from the Apple menu—the last Now Scrapbook catalog you worked in will open. You can
also launch Now Scrapbook by double-clicking an existing Now Scrapbook catalog, of
course; a Sample Catalog is provided for your convenience in the “Now Utilifieder.

You can place up to 500 items in a catalog; the size of each item is limited only by the
amount of available hard disk space. However, you'll get optimal performance if you limit
your catalogs to about 100 items.

To start a new catalog, choose “New” from the File menu. In the dialog box that opens,
enter a name for the new catalog, select a destination directory, and click “Save.”

Viewing a Now Scrapbook catalog

When you open a Now Scrapbook catalog, you have the option of viewing the items it
contains using any of three different views: Standard View, Detail View and Thumbnail
View.

Standard View

The default view is the Standard View. It shows item names and a screen representation of
the selected item. To see the Standard View if it isn’t the current view, click the “Standard
View” button.

Button bar

(see next section for Information on

bt‘Jtton descriptions) selected item
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The names of the items in the catalog are listed on the left, while a PICT image of the se-
lected item appears on the right. When a sound is selected, a “Play Sound” button allows
you to play it; when a movie is selected, the standard movie controls appear to let you
play, pause, and stop it. To browse through the list of items, press the up or down arrow
keys. To rearrange the items, drag the item names up or down in the list.

Button bar

The button bar at the top of the window is available in all views and provides access to
most of the commands found in the File, Edit, and Windows menus. The information area
in the button bar displays the selected item’s file size, last modified date/time, and data
type(s). This area appears only when the window is sized wide enough to accommodate it.

Click... In order to...

Standard View Display item names and a screen representation of an item.
Click a name to display the item, or press the up or down ar-
row keys to browse items.

L8]

= Detail View Display more information about a single item.

Thumbnail View Display thumbnails so you can preview multiple items at a
glance.

Sort Sort items alphabetically, or by date, size, or type.

@ Find Search for an item by name or by keywords assigned to it.

Print Print a single item, a single item with information, the con-
tents of the Clipboard, or an entire catalog.

Page Setup Select paper size and printing settings.

Import/Export menu Import TIFF, PICT, TEXT, Paint, EPS, GIF, JPEG, sound

files, and QuickTime movie files into the selected catalog;
export the selected item as a TIFF, PICT, TEXT, EPS, GIF,
sound file, or QuickTime movie file.

Mail Mail the selected item to another user (if you're using
PowerTalk and System 7 Pro or 7.5).

Clipboard Editor Open the Clipboard Editor and view or modify the item on
the Clipboard.

Clipboard icon (To copy an item to the Clipboard, drag the item’s name to
the Clipboard icon or choose “Copy” from the Edit menu. To
view and/or modify the contents of the Clipboard, double-
click this icon.)

=l B @

r_ﬂ Trash Remove an item from a catalog. To remove an item, drag the
item’s name to this icon.
Scale-to-fit Resize the selected image to fit in the current window size.
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Detail View

The Detail View, which you can display by clicking the “Detail View” button, shows de-

tailed information about the selected item.

Scroll bar for
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Detail View elements
Item Purpose
Scroll bar Lets you browse through the catalog by clicking on the scroll bar or the

scroll arrows.

Item Name Displays the name assigned to the item.

Item Resources Displays the resources that the item contains (see “Deselecting item re-
sources” later in this chapter for more information).

Date Added Displays the date and time the item was added to the catalog.

Size Displays the size of the item in bytes, kilobytes, or megabytes.

Keywords Displays keywords that you assign to the item to describe it or relate it to
other catalog items. Keywords can help you locate a particular item later;
when you've assigned keywords to an item, you can locate it quickly us-
ing the “Find...” command.
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Thumbnail View

The Thumbnail View, which you can see by clicking the “Thumbnail View” button, pro-
vides miniature previews of all items in a catalog.
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Each thumbnail is a miniature version of an item in color or black-and-white. The larger
your monitor, the more thumbnails you can display in the window. Click on a thumbnail to
select it. Notice that a moving dotted line appears around the selected thumbnail, and the
item name corresponding to the thumbnail is highlighted. You can rearrange the order of
catalog items by dragging thumbnails to new locations.

You can play a sound in this view by holding down the Command key and clicking on the
sound’s thumbnail.

When you add color graphics to a catalog while using a color monitor, Now Scrapbook
builds color thumbnails for the images. If you give the catalog to someone who has only a
black-and-white monitor, the thumbnails will not appear correctly there. To resolve this
problem, rebuild the color thumbnails for black-and-white by holding down the Option key
and clicking on each one.
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Adding items to a Now Scraphbook catalog

It's very easy to add items to a Now Scrapbook catalog. You can use the Clipboard’'s Copy
and Paste functions, or Now Scrapbook’s “Import...” command.

Pasting from the Clipboard

The easiest way to place an item in your Now Scrapbook catalog is to copy an item (Com-
mand-C) from another source to the Clipboard and then paste it (Command-V) into the
active Now Scrapbook window. Any attributes that the item contains (such as styled text
for a text item, or cropping or resizing data for a graphic pasted from a page-layout appli-
cations) is preserved in Now Scrapbook.

Newly-pasted items appear with the default name “Untitled.” Simply type the name you
want when the item is highlighted. An item’s name can contain up to 31 characters.

Importing files
If you want to place a single file or several files into a Now Scrapbook file, use the “Im-

port...” command. Now Scrapbook can directly import PICT, MacPaint, TIFF, GIF,
JPEG, EPS, TEXT, AIFF and System 7 sound files, and QuickTime movie files.

To import items into a catalog:

1. Choose “Import...” from the File menu, or from the “Import/Export™ pop-up menu in the button
bar.

A dialog box appears in which you can locate and select the files you want to import.
Notice that there are checkboxes for each of the file formats that Now Scrapbook can
import. Deselect a format if you don’t want to see files saved in that format. This can
make it easier to find the specific files you want to import; for example, to see only
MacPaint files, leave the “Paint” checkbox selected and deselect all other checkboxes.
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2. Open the folder containing the file(s) you want to import so that its contents are displayed.
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3. To import a single item, select the item and click “Import;” to import multiple documents in the
same folder, select any document in the folder and click “Import All.”

If you click “Import,” move on to step 4.

If you click “Import All,” a status dialog box appears with options for handling the
files to be imported.

File Mama! 4@ Paliaim | It |
Format; FICT/PICT 2 7
Fibe dize: T00 KBy Tos .
Date; The. Jun 5, 1995 |_limgetert i |
'
Click... To...
Import Import the item currently shown.
Skip Skip the item shown and not import it. The next item in the folder is then
displayed.

Import All Import all items in the selected folder without being prompted for each
item individually.

Done Return to the catalog window.

4. Once Now Scrapbook has finished importing the items, the catalog displays the new item
names.

Now Scrapbook preserves the names of imported items.

Now Scrapbook modifies the types of some imported items so it can store them
properly (see “File formats supported by Now Scrapbook” at the end of this
chapter).

128 Chapter 8—Now Scrapbook



Organizing items in catalogs

Once items are in a catalog, you can rename them, assign keywords to them, and find, sort
or rearrange them.

Changing item names

To help you identify the items, you may want to change their names. To change an item’s
entire name, select the item and type. To edit the name, select the portion you want to
change with the I-beam pointer and type.

Assigning keywords to items

Keywords let you associate an item with words relevant to you and can help you locate a
particular item quickly using the “Find...” command. To assign keywords to an item, click
in the Keyword box in the Detail View and type the desired keywords.

Sorting items

You can sort and quickly arrange the items in a catalog using the “Sort...” function.

To sort the items in a catalog:

1. Choose “Sort...” from the File menu, or click the “Sort™ button in the button bar.
The Sort Order dialog box appears.
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2. Select an option for how the items should be sorted.

Select... To...
A...Z  Sort item names alphabetically from A to Z. Sorting is not case-sensitive.
Z..A  Sort item names reverse-alphabetically, from Z to A.

Date  Sort items by the date they were added to the catalog. The most recently
added item appears at the top of the list.

Size Sort items by file size. The smallest item appears at the top of the list.
Type Sort items by file type.

3. Click “OK.”

The item list is sorted according to the order you specified.

| Theitem listis not re-sorted when you add a new item to the catalog.
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Rearranging items

Now Scrapbook gives you the flexibility to arrange the items in a catalog in any sequence
that you want. To rearrange items in the Standard View, just drag item names to the de-
sired locations in the list.

To rearrange items in the Thumbnail View, drag thumbnails to the desired locations.

| Ifyou later sort the list, any custom item arrangement will be lost.

Finding items by name or keywords

Use the “Find...” command to locate an item by its name or keywords. Now Scrapbook
searches only the current frontmost catalog.

To find an item in the current catalog:

1. Choose “Find...” from the File menu, or click the “Find”* button in the button bar.

The Find dialog box opens.
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2. Enter the text you want to search for in the “Text:” field.
You can enter up to 31 characters.

3. Select where and what to search.

Select... To...

Current Item Begin the search from the item selected.
Top Item Begin from the top of the item list.
Names Search item names only.

Keywords Search keywords only.

Both Search both names and keywords.

4. Click “OK™ to begin the search.

Now Scrapbook selects the first item it locates containing the search text or beeps if it
does not locate any matching items. To locate the next item containing the search text,
choose “Find Again” from the File menu.
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Moving items between Now Scrapbook catalogs

Now Scrapbook provides an easy method for copying items between catalogs: simply
open both catalogs and drag items between them. Items you move are not removed from
their original catalogs.

Removing items from catalogs

To remove an item from a catalog, drag it to the Trash icon, and then choose “Empty
Trash” from the File menu; or, select an item and choose “Cut” from the Edit menu.

When you use the “Cut‘ command, any previous information on the Clipboard is replaced
by the item you cut.
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Editing catalog items

Now Scrapbook allows you not only to catalog items, but also to edit graphics and text,
and deselect item resources for special copying purposes.

Editing graphics in the Clipboard Editor

The Clipboard Editor in Now Scrapbook lets you resize and select portions of graphics.
Once you've edited a graphic and saved the changes to the Clipboard Editor, you can paste
it back into your Now Scrapbook catalog or another application.

Any graphic item can be displayed in the Clipboard Editor if you have sufficient RAM.
Remember that a 32-bit graphic or a TIFF requires more memory than other formats.

To edit a graphic, first drag it to the Clipboard icon, or select the graphic and choose
“Copy” from the Edit menu; then, open the Clipboard Editor by clicking the “Clipboard
Editor” button, choosing “Clipboard Editor” from the Windows menu, or by double-click-
ing the Clipboard icon.

Once the graphic appears in the Clipboard Editor, you can use the graphics tools in the
vertical toolbar on the left to edit it.

To save an edited graphic or any portion of one as a new graphic, you must first click the
“Save to Clipboard” button, and then paste the new graphic into the active Now Scrap-
book catalog.

L lgleeerdl Edifni

Toolbar/button bar for editing
and selecting images—tools &
buttons described in following
table
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Image dimensions Measurement units pop-up menu
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Click the... In order to...

Editor Mode Selector Toggle between the edit graphics mode and the edit text
mode.
E Pointer tool Change the currently-selected tool to a pointer.

continued on next page
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Click the...

In order to...

continued from previous page

3] [
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Lasso tool

Marquee tool

Polygon tool

Cropper tool

Resize tool

Magpnification tool

Demagnification tool

Grabber Hand tool

Resize Graphic button

Change the pointer to a lasso for selecting irregular por-
tions of a graphic. The moving dotted lines indicate the
selection. The Lasso automatically finds the edges of
the enclosed graphic and selects them. To override this
automatic feature, hold down the Shift key before drag-
ging the Lasso.

Change the pointer to a crosshair for selecting rectangu-
lar portions of the graphic.

Change the pointer to a wand for selecting irregular
polygon portions of a graphic by creating a path of
points. Click to place a point on the path; close the path
by double-clicking the mouse or clicking the original
point. Once you've created a selection shape, you can
modify it by dragging any of the points.

Display handles on the graphic so you can crop it. Drag
a handle to crop to the desired area. Hold down the
Shift key while dragging to crop proportionally.

Display handles on the side and bottom of the graphic
SO you can resize it. Drag a handle to reduce or enlarge
the graphic. Hold down the Shift key as you drag to
resize proportionally.

Change the pointer to a magnifying glass to magnify
the view of the graphic up to nine levels. A beep sounds
when you reach the maximum enlargement. To activate
temporarily without selecting the tool, hold down the
Command key.

Change the pointer to a magnifying glass to reduce the
view of the graphic up to nine levels. A beep sounds
when you reach the maximum reduction. To activate
temporarily without selecting the tool, hold down the
Option key.

Change the pointer to a grabber hand to move the
graphic horizontally in the Clipboard Editor if a portion
of the graphic is not in view. To activate temporarily
without selecting the tool, hold down the spacebar.

Open a dialog box in which you can resize a graphic
precisely by a percentage (both non-proportionally and
proportionally) or by size in points.

To reapply the scaling value you've just set without
returning to the dialog box, click “Store as...” to record
a Hot Key. You can also change the bitmap depth if
desired.

continued on next page
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Click the... In order to...
continued from previous page

Undo button Reverse the previous resize command only.

Save-to-Clipboard button Copy the selection or resized graphic to the Clipboard.
Only the selected area will be copied.

Measurement units pop-up menu Change the unit of measure—select a different option
from the pop-up menu. To change the magnification,
use the Magnification tool. This area also shows the
actual horizontal and vertical dimensions and the mag-
nification of the current graphic.

Editing text in the Clipboard Editor

Now Scrapbook lets you edit the text in any item that contains a TEXT resource. To edit a

text item, first drag it to the Clipboard icon, or select the text item and choose “Copy”
from the Edit menu.

Next, open the Clipboard Editor by choosing “Clipboard Editor” from the Windows menu,
by clicking the “Clipboard Editor” button, or by double-clicking the Clipboard icon.
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Once the text appears in the Clipboard Editor, select text with the I-beam pointer as you
would in a word processor. Use the menu bar commands to modify the text. To save your
changes and add them to your catalog as a new item, choose “Save on Clipboard” or “Save
as PICT” from the Edit menu within the Clipboard Editor, close the Clipboard Editor, and
paste the results into the catalog.

To copy and paste text, choose commands from the Edit menu.

To change font attributes, choose the desired options from the Font, Size, and Style menus.
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To save your changes, choose one of three options from the Edit menu:

Choose... In order to...

Save on Clipboard Save the text to the Clipboard.

Save with Clippings  Append the text to any material already contained on the Clip-
board. The text is saved with the TEXT and “styl” types, which
are added to any existing types already on the Clipboard.

Save as PICT Save the entire document to the Clipboard as a PICT. When you
choose this option, the Clipboard Editor switches to the graphics
editing mode. You can then resize or select portions of the result-
ing graphic.

To find and/or replace text, choose “Find” from the Search menu. In the Find dialog box,
enter the text to search for and how to search for it.

Find

daarch Fon || |
Beglace With: | |

Spmrth by & Woids o Charac bers
Cacm O Motters 5 0% Irrebewst | Conced || Fing ]

Search option Function

Search Forfield Enter the target search text of up to 31 characters.
Replace Withfield Enter replacement text of up to 31 characters (optional).
Search by Words Search for complete words.

Search by Characters Search for characters.

Case Matters Make the search case-sensitive.

Case Is Irrelevant Ignore letter case in the search.

Click “Find” to locate the first occurrence of the target text. Now Scrapbook begins the
search from the position of the I-beam pointer in the text. To replace the target text, choose
“Replace” or “Replace & Find Again” from the Search menu.

To replace all occurrences of the target text, choose “Replace All” from the Search menu.
Now Scrapbook beeps if the target text can’t be located.
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Using catalog items outside of Now Scrapbook

It's very simple to transfer items out of a Now Scrapbook catalog for use elsewhere. You
can use the Clipboard’s Copy and Paste functions, or Now Scrapbook’s “Export...” com-
mand.

Copying items to the Clipboard

The easiest way to copy an item out of your Now Scrapbook file is to use the Clipboard's
Copy and Paste function. Select an item in the catalog, choose “Copy” from the Edit
menu, and then paste into the desired application.

You can do the same thing by dragging the item to the Clipboard icon and then pasting
into the other application.

Deselecting item resources when copying

One piece of information displayed in the Detail view is the resource types found in the
selected item. For example, text copied to the Clipboard from most applications includes a
text resource (“TEXT”") and one or more resources controlling the style and formatting of
the text (“styl,” “CLAP,” “RTF,” etc.). Now Scrapbook allows you to omit one or more
resource types from an item when copying it, simply by clicking. If you omit all resource
types, the item will appear blank.

When an item is displayed in the Detail view, you can deselect a resource type just by
clicking it. The resource type dims, and the item’s appearance changes to reflect the re-
maining resources. If you copy the item to the Clipboard now, only the resources that are
still selected and active will “travel” with the item when you paste it into another applica-
tion. Deselecting item resources has no effect when you're exporting catalog items.

This feature is particularly useful when working with page-layout applications. When you
copy text from a word processing application and paste it into a page-layout application,
any styles used in the word-processing document come along with the text. If you want to
paste this text into your page-layout application without the original style settings (which
will override any styles set up in the page-layout document), simply copy the text to a Now
Scrapbook catalog, switch to the Detail view, and deselect all types except TEXT. Then
copy the text to the Clipboard, switch to the page-layout application, and paste the text.
You can then apply your text formatting styles as desired.
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Exporting items as

separate files

Now Scrapbook’s Export function lets you save a copy of a catalog item as a separate file
in one of the following file formats (depending on the item’s type): TEXT, PICT, TIFF-
IBM, TIFF-MAC, GIF, JPEG, System 7 sound, AIFF sound, QuickTime movie, or EPS
file. See “File formats supported by Now Scrapbook” later in this chapter for details on the

various formats.

You can export only one item at a time.

To export a catalog item as a separate file:

1. Select the item you want to export.

2. Choose “Export...” from the File menu, or from the “Import/Export™ pop-up menu in the but-

ton bar.

The Export dialog box opens, displaying the available file formats for the exported
file, according to the catalog item'’s file type.
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3. Select the desired file type to export.

Catalog item’s type Available export file type(s)

text TEXT

graphic PICT, EPS, GIF, JPEG, TIFF.
If you select a JPEG type, the scroll bar becomes active so that you
can select a level of compression.
If you select a TIFF type, several options become available:

 Black and White—Creates a black-and-white TIFF file.

* Gray—Creates a grayscale TIFF file.

« 256 Colors—Creates a color TIFF file with 256 colors.

« Direct Color—Creates a direct color TIFF file.

* Compress—Creates an internally-compressed TIFF file.
continued on next page
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Catalog item’s type Available export file type(s)
continued from previous page
sound System 7 sound, AlIFF sound
QuickTime movie MooV: Contains only movie header information.
MooV-Full: Contains both movie header information and data.

4. Select a destination directory and click “Export” to export the file.

Now Scrapbook creates the export file. The catalog is displayed again when the export
is complete, and the original item remains unchanged in the Now Scrapbook catalog.

Exporting items as resources

Now Scrapbook allows you to export catalog items as resources. If you're working in soft-
ware development or multimedia projects, this feature allows you to incorporate graphics
or sounds directly into your work.

With an item selected, hold down the Option key and choose “Export...” from the File
menu. A dialog box appears in which you can specify details of the new resource. Change
the Resource type, ID, Type or Creator as desired.

To save the file into an existing file, click “Add To.” To create a new file in which to store
the item, click “New.”
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Printing items and catalogs

Use the “Print...” command to print a single item, a single item with accompanying infor-
mation, the current contents of the Clipboard, or an entire catalog of items.

To print;

EE

3.

With an item selected, choose “Print...” from the File menu or click the “Print” button in the
button bar.

The Print dialog box appears, with special Now Scrapbook printing options at the bot-
tom.

aaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaa N
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Catalog; Aows| | Cosmms| |

Set the printing options according to what you want to print.

Select... To print...

ltem The currently selected item only.

Info The currently selected item along with the item name, keywords, and en-
try date.

Clipboard The current contents of the Clipboard.

Catalog Each item in the catalog with a representation of the item, along with its
name, keywords, size and entry date. When you select this option, the
“Rows” and “Columns” fields become active. You can print one item per
page by entering “1” in these fields, or you can print multiple items per
page by specifying other values (the printed size of the items will change
according to how many you attempt to fit on a page). The amount of
space available for each item in the printed catalog is determined by the
page size and number of rows and columns specified. If very little space
is available for an item, the accompanying comments will not be printed.

Click “Print™ to print your selection.
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Now Scrapbook Reference

This section describes Now Scrapbook’s menu commands and preferences settings, and
details the file formats that Now Scrapbook supports.

Now Scrapbhook menu commands

The following tables describe the menu commands available in Now Scrapbook, and in-
clude the button equivalent when one exists for a command.

File menu
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Choose... In order to...

New... Create a new catalog. A dialog box opens, prompting you to name
the catalog and select a destination directory. Now Scrapbook auto-
matically saves changes you make to the catalog; there is no
“Save” command.

Open... Open a catalog or convert a Scrapbook file to a catalog. You can
open as many catalogs as memory permits.

Close Close the currently active catalog. Changes are automatically saved
when you close the catalog.

Import... Import items into the currently active catalog.

Export... Save a copy of the currently selected itgm in a separate file. You
can specify the format for the exported item. You can also export
any item as a resource.

@ Find... Search for names or keywords.

Find Again Search for the next occurrence of the search text.

Sort... Sort the items alphabetically or by date, size, or type.

Empty Trash Empty the Now Scrapbook Trash.

Preferences... Change Now Scrapbook settings.

@]
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Choose...

In order to...

continued from previous page

Mail...
Page Setup...

Print...

Mail the selected item to another user (if you're using PowerTalk
and System 7 Pro or 7.5).

Select standard choices for paper size and printing enhancement.
The printing effects available depend upon which printer is se-
lected in the Chooser.

Print items. You can print a single item, a single item with informa-
tion, the contents of the Clipboard, or an entire catalog.

Quit Quit the Now Scrapbook application. Now Scrapbook remembers
the catalogs that were open when you quit and automatically re-
opens them the next time you open Now Scrapbook.

Edit menu

Choose... To do this...

Undo Undo the last command or action taken.

Cut Remove the selected item and place it on the Clipboard.
Copy Copy the selected item to the Clipboard.

Paste Copy the item on the Clipboard into the catalog.

Clear Remove the item currently on the Clipboard.

Windows menu

IWindours

Choose...

To do this...

Clipboard Editor Display the Clipboard Editor to select and resize graphics and

[catalog name]

modify text.

Bring a Now Scrapbook catalog window to the front. The
names of any open catalogs will appear here.
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Preferences dialog box

The Preferences dialog box allows you to change Now Scrapbook settings. To open the
Preferences dialog box, choose “Preferences...” from the File menu.
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Select... To specify that Now Scrapbook will...
Create new thumbnails in color Automatically create a new color thumbnail in-

stead of a black-and-white thumbnail when an
item is added to the catalog. Select this option if
your monitor supports color and you have suffi-
cient hard disk space and RAM available. Only
affects thumbnails created after selecting this op-
tion.

Include PostScript when printing Print PostScript items at full resolution. When
deselected, low resolution bitmapped items are
printed.

Display TEXT items in 12-point type Display text items in 12-point type. When this
option is deselected, text items are displayed in 9
point type. Changing this option takes effect with
the next item selected.

This option does not apply to TEXT items
that have a “styl” type since “styl” deter-
mines the font, style, and size.

Read TIFF images to show all pixels Stretch out TIFF images so that all pixels are dis-
played. For example, if you have a 1" x 2" image
at 300 dots-per-inch (dpi), every pixel will be dis-
played and the image will be 4" x 8" in Now
Scrapbook on a Macintosh with 72 dpi resolution.
When deselected, TIFF images are read using the
specified resolution. If you have a 1" x 2" image
at 300 dpi, it will be displayed at 1" x 2" in Now
Scrapbook on a Macintosh with 72 dpi resolution.
Roughly every fourth pixel will be displayed.

Closing last window quits Quit when you close the last open window.
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File formats supported by Now Scrapbook

Now Scrapbook lets you place a variety of items created in different software applications
into a catalog. Whenever possible, Now Scrapbook retains the item’s original file format,
but in some cases the format must be converted. Once you've imported an item into a cata-
log, you can see its file type by switching to the Detail View.

This section discusses the commonly-used file formats supported by Now Scrapbook and
how Now Scrapbook handles these formats.

File format Description

TEXT Text file created by a word processor. Now Scrapbook stores the characters
as a TEXT-type resource and displays them in Geneva 9 point or 12 point,
depending upon the settings in the Preferences dialog box.
Some text files include style attributes, such as font family, size, and style.
These attributes are stored as a resource type along with the TEXT type.

PNTG Paint-type graphic, created with MacPaint or another graphics application
supporting this format, that is black-and-white and fixed at a resolution of
72 dots-per-inch (dpi). When an image of this type is imported or copied in
through the Clipboard, Now Scrapbook converts it to a PICT.

TIFF Tagged Image File Format image, created with scanning software or image-
editing applications, that is bitmapped and saved with gray scale or color
information. The resolution and bit depth of a TIFF file and the amount of
memory it uses varies from image to image.

Now Scrapbook can import and export compressed, black-and-white,
grayscale, indexed color, and direct color TIFF files created by Macintosh
and PC applications.

Once imported into Now Scrapbook, TIFF images are converted to PICT
and TIFI types. The PICT type stores a screen representation of the image,
and the TIFI type records the original image size and resolution. You can
specify how Now Scrapbook modifies the resolution of imported TIFF im-
ages in the Preferences dialog box.

PICT Image created with draw-type applications such as MacDraw or SuperPaint
that can contain a collection of resolution-independent objects and
bitmapped images. PICT images may be black-and-white or color. Now
Scrapbook imports PICT and PICT2 images, and exports PICT images.

GIF Graphics Interchange Format, widely used for cross-platform image ex-
change on the Internet, CompuServe and other online services. To ex-
change graphics files with friends or colleagues who use IBM
PC-compatibles or Unix workstations, use this format.

JPEG A compressed image format created by the Joint Photographic Experts
Group which significantly reduces the size of documents containing large
grayscale and color bit-mapped graphics.

continued on next page
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File format

Description

continued from previous page

EPS

Encapsulated PostScript is a graphics format that uses the PostScript page
description language. In addition to PostScript code, an EPS image includes
a PICT screen representation of the image. When you import an EPS file,
Now Scrapbook converts it to PICT and TEXT types. The TEXT type con-
tains the PostScript code, and the PICT corresponds to the screen image, if
one exists. If the EPS file contains no PICT screen image, Now Scrapbook
displays a bounded box with the filename in the center.

When you copy the EPS catalog item back to the Clipboard, Now Scrap-
book embeds the PostScript code into the PICT file to create a PICT+PS
file, which can be pasted into most Macintosh applications. Applications
display the PICT file but will use the PostScript code when printing the im-
age. That way you can print high-resolution images from applications that
don't directly import EPS files.

Sys. 7 sound A standard sound format supported by the system software and many appli-

AlIFF

MooV

cations. Sounds using the System 7 sound file format can be moved into the
System file to be used with the Sound control panel and can be played from
the desktop by double-clicking them.

Audio Interchange File Format is a standard audio file format that is sup-
ported by sound applications such as SoundEdit Pro. The file format usu-
ally contains only a data fork.

The QuickTime movie format as defined by Apple. When you import a
movie, Now Scrapbook displays a PICT image of the first frame. You must
have the QuickTime extension running in order to import, view the first
frame of, play, and export movies in Now Scrapbook.
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Chapter 9
Now Shortcuts

Now Shortcuts offers a quick method of duplicating, trashing, and aliasing your files (and
more), without dragging your mouse all over the place. Once you've used Now Shortcuts
you'll wonder how you managed without it!

USING NOW SHOICULS .....cooiiiiiiiiiit et 147
Now Shortcuts control panel Settings ..........cooeuviieiiiiiiiiii e, 148
(O] 0@ i i o TV 11 (o] o [PPSO PUPRPRPTR 148
Specifying the ShOMCUL KEY ........eiiiiiii e 148
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Using Now Shortcuts

Now Shortcuts requires no configuration—it's ready to go as soon as it's installed. Merely
hold the Control key, click on an icon, and let go—you’ll see the Now Shortcuts menu ap-
pear right where you clicked. Choose an item from the menu and the task is accomplished.
Users with large monitors will (especially) appreciate the amount of mouse travel elimi-
nated by Now Shortcuts!
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The installed shortcut plug ins are common Finder functions. Detailed descriptions are in
your Macintosh Users Guide. The following is a brief description of what each plug in
does.

This option... does this
Duplicate Creates a copy of the selected file or folder.

Get Info Displays information box about the selected item (such as when created,
amount of memory a program needs, creation and modification dates, and
version number).

Label Changes the color or shade of gray that the icon is displayed in, and labels it
with the corresponding label.
Lock Locks the file so that no changes can be made to it.

| Note that folders cannot be locked.

Unlock Unlocks a locked file so that changes may be made to it.

Make Alias Creates an alias of the file, folder, or program. An alias serves as a remote
control; it is not a copy, merely a way of accessing the original.

Move to Trash Moves the selected item to the Trash.

Put Away Ejects disk from the disk drive, returns item to the location where it was cre-
ated (such as back to a folder from the desktop), or disconnects from a shared
disk.

Sharing... Allows other users on a network to gain accewss to the selected item.

The Now Shortcuts technology is extensible, a fancy way of saying that you can add fea-
tures and functionality to the Now Shortcuts menu merely by adding Shortcuts modules to
the Now Shortcuts Plug Ins Folder inside the Control Panels folder. Look for Shortcuts
modules on the Now Software Web site— http://www.nowsoft.com— and on the various
online services.
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Now Shortcuts control panel settings

The Now Shortcuts control panel allows you to make minor adjustments to the way Now
Shortcuts works.

On/Off button

The “On/Off” button lets you turn the Now Shortcuts functions on or off without restart-
ing.

Specifying the shortcut key

EN

Now Shortcuts

i1

Irveoke Shorteuts menu when clicking and pressing @
[ shift [ option
E Contral |:| Cormand

You can choose which key(s) must be pressed to invoke the Shortcuts menu. At least one
of the modifier keys must be checked—if only one is checked, its name is dimmed to indi-
cate that you cannot uncheck it without first checking another modifier key.
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Chapter 10
Now Startup Manager

Now Startup Manager manages the loading of extensions, control panels, Chooser docu-
ments, and other files that customize the way your Macintosh works. Now Startup Man-
ager reduces the chance of having difficulties when loading these startup files by letting
you manage them—and when you do have a conflict, Now Startup Manager can help you
resolve it, through its powerful Conflict Isolation feature.

Important: If you've turned to this chapter because you're trying to resolve a software
conflict, go to the “Resolving software conflicts” section listed below—it will walk you
through the process of letting Now Startup Manager find the problem. If you've just re-
started after installing Now Ultilities and Now Startup Manager has appeared, go to “Con-
trolling startup files during the startup process.”

Now Startup Manager CONCEPLS .....viivuiiiiiiieeeiin e eaaes 151
TypPes Of STArtUP filES ..vveeeiieie e 151
THE SLAIUP PrOCESS ..uuvuiiiiiiiiiee e e e e e e ittt e e e e e e e s e e s e r et aeaee e e s e ssaaabr e e eeeaaaeeesesannenneees 151
Folders created by NOW Startup Manager ..........cceveeeeiiiiiiiiiiiiieeeee e ee e e e 152

Controlling startup files from the control panel .............cccccceeiiiiiiiiiinnnnn, 153

Controlling startup files during the startup process.........ccccceeeeeeviiieeeninnns 154

Switching the startup diSK........ccooveeieeiiiiiiieee e 155

USING STAUP SEIS ..ooiiiiiiiiiiee ettt 156
S (o] T To ] = L (0] o TS T =] £ 156
Creating and modifying Startup SetS.......c.coii i 157
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Resolving software CONfliCtS ..........cccciiiiiiiiiii e 159

Background on CONFlICES ........oooiiiiiiiiiiii e 159
The Conflict I1SOlatioN CONCEPL .......eiiiiiiiiiee e 159
Handling Crashes at StartUp ........coooiueeiiieiiiiee et 160
The Conflict ISOIAtION PrOCESS ....ccoiiiiiiiie it 160
TwOo-way Startup CONFIICES ......coiiiiiiiiiiiie e 163
Software conflicts in @appliCatioNS ..........coocuiiiiiiii 163
Intermittent software CONFlICES .........ooiueiiiiii e 164
Using the Conflict 1SOIation reSUILS .........ccooiiiiiiiiii e 164
USING LINKS .t e e e e e e e e eeeeeaenees 165
CreatiNg LINKS ...cooiiieiieee ittt 165
Viewing Links in the control panel ... 167
Renaming and deleting LiNKS ... 167
Specifying custom extension Names for LiNKS ...........coooiiiiiiiiiiiiee e 167
Now Startup Manager preferencCes .......oooovvvviiiiieieeiie e 169
Setting Your Main PreferENCES ......coiii ittt a e e 169
Reserving SyStem NEAP SPACE .....eeiiiiiiiiiiiiiiit et e e e 170
RESOIVING GlIASES ....eeieiiiiiiie it e e e e e e e e e e e e e e 171
Extension Display PreferEnCes ... 171
Setting your Extension Display Preferences ..., 171
Excluding startup files from disSplay ... 172
Password-protecting the Extension Display Preferences ..........ccccccccoviiiiiiinnnen. 173
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Now Startup Manager Concepts

Now Startup Manager lets you control all items that load into memory when you start up
your Macintosh. While these items fall into many different categories, this chapter refers
to them collectively astartup files

Types of startup files

The table below explains the different types of startup files.

The startup file type... Isa...

extension Mini-program, stored in the Extensions folder, that adds func-
tionality to the system software or changes the way the system
software operates. (Extensions were previously known as
INITs or startup documents under System 6 and earlier.) The
File Sharing Extension is an example of an extension included
with the Macintosh system software. Extensions usually have
no user-selectable settings.

control panel Stand-alone program, stored in the Control Panels folder, that
provides access to system software functions, hardware de-
vices, or utility programs. (Control panels were previously
known as cdevs under System 6 and earlier.) The Memory,
Sound, and Now Menus control panels are a few examples.
Some control panels, including Now Startup Manager and
Now Save, contain INIT resources and must be loaded into
memory at startup in order to work properly. Other control
panels, like Monitors and General Controls, don’t contain
INIT resources and are not loaded at startup.

component/shared library* Software component that is similar to an extension except that
it provides information and “services” to other software com-
ponents.

Chooser extension Resource that controls or simulates a remote device. For ex-
ample, the LaserWriter Chooser extension lets you select a
remote printer. (Chooser extensions are sometimes referred to
as RDEVs, PRESs, and PRERS.)

Startup Item Document or application that is opened automatically when
your Macintosh starts up. Startup Items or their aliases are
stored in the Startup Items folder in the System Folder.

Font* Typeface that is stored in the Fonts folder under System 7.1 or
later (Now Startup Manager can’t control your fonts if you're
running System 7.0 or 7.0.1). If you have many fonts in-
stalled, they can significantly decrease the amount of memory
available for running applications. Now Startup Manager lets
you control which fonts load at startup so that you can better
manage your memory.

*You must change the default preferences settings in order to view and control this type of
startup file.
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The startup process

Each time your Macintosh starts up, the system software searches for startup files in three
places: the Extensions folder, Control Panels folder, and the System Folder (the Fonts
folder too, if you've set Now Startup Manager to control your fonts). The startup files are
loaded into memory in alphabetical order (or any custom order you've set up), and an icon
for each one appears at the bottom of your screen as it loads. Once the startup process is
complete, the desktop appears with the Finder menu bar at the top.

Folders created by Now Startup Manager

When you use Now Startup Manager, it creates four new folders in the System Folder of
your startup disk: “Control Panels (disabled),” “Extensions (disabled),” “Startup Items
(disabled),” and “System Extensions (disabled)"—System Extensions are a rare type of
extension that is stored in the System Folder, not inside the Extensions folder. When you
turn off a startup file to prevent it from loading, Now Startup Manager moves it into the
appropriate “(disabled)” folder. If you turn that startup file back on at a later time, Now
Startup Manager moves it back into the appropriate Extensions, Control Panels, or Startup
Items folder. Your startup files themselves are not modified in any way during this pro-
cess.

If you set Now Startup Manager to control your fonts, it creates a “Fonts (disabled)”
folder as well.

When you install a new startup file and Now Startup Manager finds a duplicate of it al-
ready installed in a different location within the System Folder, it creates a new folder
named “Duplicate Items” in the System Folder and places the older duplicate startup file in
it.
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Controlling startup files from the control panel

When you open the Now Startup Manager control panel, it displays a list of all of your
startup files. This list includes, in order, all extensions in the Extensions folder, all control
panels in the Control Panels folder and any startup files in the System Folder. A list of
startup items in the Startup Items folder appears below a separator line (if you have set
Now Startup Manager to display fonts, they appear below the Startup Items). Each of these
groups is alphabetically sorted. The first time you open the control panel after a new in-
stallation, Now Startup Manager turns on all of the startup files it finds.

Buttons for controlling
startup files (see table

below)

Buttons for using other
functions (covered
later in this chapter)
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Summary of active
Links (see “Using
Links” laterin this

chapter)

The table below lists the various ways that you can manage the startup files listed in the

control panel.
In order to...

Do this...

Select an item in the list

Turn an item on or off

Open a control panel or Startup Item

Move an item in the loading order

Click the item’s name; type the first letter of the
item’s name (type a space or “a” to go the top of
the list, and type a “~" or “z" to go to the bot-
tom); or press the Up and Down arrow keys.
Click to the left of the item’s name to

make the checkmark appear or disappear;
select it and click the “Turn Selected Item
On/Off” button; or select it and press the
Right (On) or Left (Off) arrow key.
Double-click the item; or select it and
click the “Open Selected Item” button.

Drag the item to the desired location in the
order; or select it and click the “Move
Item Down” or “Move Item Up” buttons.

continued on next page
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In order to... Do this...

continued from previous page

Sort items alphabetically & l Click the “Sort Alphabetically” button—

£%] custom loading orders that you previously

set by dragging will be lost.

Sort items by their active/inactive stat Click the “Sort by Active/lnactive” but-
ton—custom loading orders that you pre-
viously set by dragging will be preserved.

Controlling startup files during the startup process

In addition to opening the Now Startup Manager control panel after your Macintosh has
started up, you can also manage your startup files during the startup process—before your
startup files actually load into memory.

To control startup files during the startup process:

1. Turn on or restart your Macintosh.
2. When the “Welcome to Macintosh” message appears, hold down the spacebar.

Continue holding down the spacebar until the Now Startup Manager startup dialog
box appears; it is nearly identical to the control panel.
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Continues the startup process, but  Continues the
any changes you make here are startup process
temporary only—Now Startup  and makes
Manager reverts to the previous ~ your changes
settings the next time you restart ~ permanent

3. Make any desired changes to your startup files.

You can turn items on or off, change their loading order and sort the startup files, as
described in the previous section.

You can also change Startup Sets here—see “Using Startup Sets” later in this
chapter for more information.
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4. Once you’ve finished making changes to your startup files, click “Temporary” or “OK,” depend-
ing on the desired result.

Clicking “Temporary” continues the startup process, but the changes you made (in-
cluding choosing a different Startup Set) apply to this startup only—on the next
startup, Now Startup Manager will revert to the settings that were in effect before you
made your changes.

Clicking “OK” continues the startup process, and Now Startup Manager saves your
changes so that they will apply to subsequent startups.

If you changed the On/Off status of an item that loads before Now Toolbox
(above the dotted line), Now Startup Manager will restart at this point to make
the change effective.

Switching the startup disk

The Now Startup Manager control panel lets you specify which volume you want used as
the startup disk the next time you restart or turn on your Macintosh, without having to use
the Startup Disk control panel separately. You can even switch the startup disk during the
startup process.

To switch the startup disk, just choose the desired disk from the “Choose Startup Disk”
pop-up menu in the button bar. Only mounted volumes containing a System Folder appear
in this pop-up menu; network volumes and floppy disks do not appear.
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Partition names on a partitioned hard disk that contains multiple System Folders may ap-
pear as mounted volumes on the Startup Disk pop-up menu. While you can select any par-
tition name as the startup disk, Now Startup Manager cannot control which partition is
actually used as the startup volume; the Macintosh will always start up from the first par-
tition it locates regardless of which partition name you select. Use the partitioning utility
that came with the formatting software to make a different partition the startup volume.

The disk you choose becomes the active startup disk; the next time you start up, the
Macintosh will start up from that disk until you choose a new startup disk in Now Startup
Manager or the Startup Disk control panel.

You can also switch the startup disk in the Now Startup Manager startup dialog box when
you call it up during startup. When you switch to a different startup disk in this situation,
the Macintosh will restart when you click “OK,” and the startup files on the new startup
disk will load into memory.

As long as Now Menus is running, you can also switch the startup disk by choosing the
desired disk from the submenu attached to the Startup Disk control panel (usually found in
the submenu attached to “Control Panels” on the Apple menu).
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Using Startup Sets

Now Startup Manager lets you create multiple Sets of startup files and switch between
them during or after startup. This allows you to load different groups of startup files de-
pending upon the type of work you intend to do, which can result in more available
memory and can also avoid some software conflicts. Each Startup Set contains a list of
items to be loaded the next time you start up, and each Set can provide for a different load-
ing order as well.

For example, in addition to the default “Standard” Set that will probably contain the group
of startup files that you load most often, you can have a “Minimum” Set to load the most
essential startup files but no others, and a “Dial-Up” Set that includes the startup files nec-
essary for connecting to remote services.

Switching Startup Sets

The “Startup Set” pop-up menu above the list of startup files in the Now Startup Manager
control panel lets you switch Startup Sets easily. By default, the menu contains the “Stan-
dard” and the “Skip All” Sets—any additional Sets you create will appear here as well.
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To switch to a different Startup Set than the currently-active one, just choose the desired
Set from the pop-up menu. Notice that when you choose a new Set, the list of startup files
changes to reflect any change in the on/off status and/or loading order of startup files.

You can switch Startup Sets either in the control panel after startup (to take effect on the
next restart), or in the Now Startup Manager startup dialog box when you call it up during
startup (to take effect as soon as you click “OK” or “Temporary”). Additionally, you can
switch the Startup Set during startup by holding down the Hot Key you've assigned to the
Set you want to activate; this switches Sets without opening the dialog box. See the next
section, “Creating and modifying Startup Sets,” for more information.

1, To switch Startup Sets quickly, highlight Now Startup Manager in the Control Panels

v submenu on the Apple menu, or in any other menu where Now Startup Manager appears—
a submenu of your Startup Sets is attached to Now Startup Manager, and you can simply
choose the desired Set. This submenu is available as long as Now Menus is also running.
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To restart and activate the new Set right away, hold down the Command and Control keys
while choosing the Set—the Macintosh will begin restarting immediately.

When you switch Startup Sets, the Set you choose becomes the active Startup Set and its
startup files are loaded in the specified order on subsequent restarts until you switch Sets
again. The only exception is when you switch Sets in the Now Startup Manager startup
dialog box during startup and then click “Temporary”—when you do this, the Set you
choose is active for the current startup only and the one that was previously active will be
active again at the next restart.

Creating and modifying Startup Sets

Now Startup Manager makes it simple to create and modify Startup Sets. If you have a
Startup Set that you want to duplicate except for a few changes, you can easily duplicate it
and then make the changes.

You can't delete or rename the “Standard” or the “Skip All” Startup Sets.

To create or modify Startup Sets:

1. Inthe Now Startup Manager control panel, click the *“Create/Modify Startup Sets™ button, or
choose “Edit...” from the *“Startup Set:”” pop-up menu.

The Startup Sets dialog box opens.
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2. Click the button for the function you want to perform.

Some functions require that you select a Set name—make sure you've selected the
Set that you want to modify.

Click... In order to...

New Create a new Set and give it a name.

Duplicate Create a copy of the currently-selected Set and give it a new name.
Rename Give the currently-selected Set a new name.

Delete Delete the currently-selected Set.
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3.

If you wish, type a Hot Key for the currently-selected Set in the “Hot Key” field.

The Hot Key can be a single letter or number, or a combination of modifier keys and a
letter or number.

When you assign a Hot Key to a Startup Set, you can make that Set active during the
startup process just by holding down the specified key or key combination. To use a
Startup Set Hot Key, press the key or key combination as soon as you see the “Wel-
come to Macintosh” greeting during startup, and let go of it once the Now Startup
Manager icon has appeared on your screen.

The default Hot Key for the “Standard” Set is “S”; the default Hot Key for the
“Skip All” Set is “N.”

Click “OK.”
You're returned to the Now Startup Manager control panel.

Any new Startup Sets you created now appear in the “Startup Set” pop-up menu, and
the Set that was last selected in the dialog box is now selected in the menu.

You can modify the startup files in the currently-selected Set as described earlier.

You can also create and modify Startup Sets in the Now Startup Manager startup dialog
box when you call it up during startup.
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Resolving software conflicts

Now Startup Manager’s automatic Conflict Isolation feature makes it easy for you to find
the cause of a crash at startup or a software problem that occurs after startup.

Background on conflicts

Depending on the version of your installed system software, any updates that are also in-
stalled, the startup files that you normally run, the general condition of your hard disk, and
many other factors, you may experience conflicts very rarely or you may be inconve-
nienced by them several times a day. Most software conflicts occur in the form of a crash
during startup—you restart or start up your Macintosh and at some point during the pro-
cess it restarts spontaneously, or simply “locks up.” This usually happens as a result of a
conflict between two or more startup files, or between one startup file and your system
software. Now Startup Manager makes it easy to troubleshoot and resolve this kind of situ-
ation.

Software conflicts can also occur after your Macintosh has started up and you're busy
working in an application—a problem occurs and interrupts your work. Now Startup Man-
ager can help with these problems as well.

The Conflict Isolation concept

For some time, Macintosh experts have agreed that there is one sure approach to resolving
startup conflicts:

« Turn off all startup files and restart; see if the problem still occurs. If it doesn't, the
problem lies in a startup file. (If it does, the problem may be in the system software.)

« Turn on half of the normally-active startup files and restart; see if the problem still oc-
curs. If it does, the problem is in this group of startup files. (If it doesn’t, the problem
lies in the other half of the startup files and they should be turned on instead.)

« Turn on half of the previous group and restart; see if the problem still occurs.

» Proceed in this way until you've narrowed the problem down to one or two startup files
that are involved.

This is indeed the best way to resolve conflicts, but it can be very time-consuming and po-
tentially confusing, since you have to keep track of which items you turned off and when
the problem did and didn’t occur. Also, even when you determine where the problem lies,
you still have to figure out what to do to prevent it from happening.

Now Startup Manager makes this process easy, because it automates the time-tested
method of resolving startup conflicts—it does all of the wiorkyou, and simply asks you

with each restart whether or not the problem still occurs. After a few restarts, Now Startup
Manager tells you which startup files are involved in the problem. At the same time, it of-
fers simple, one-button options for resolving the conflict that will almost always get you
back up and running quickly.
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Handling crashes at startup

When you have a crash at startup, your Macintosh either restarts spontaneously or you're
forced to restart the machine yourself. When Now Startup Manager loads into memory, it

opens a dialog box informing you that a crash occurred during the last startup and giving

you the name of the startup file that was loading when the crash occurred.

Tre Lui bired ypod ol ap, T Ecbickos saned ™ Teod Bnatdb ™
afkred T b FERlE . Far e carwmndHes, T i e hamed
oA, bl b s Hiek e HeHn T Raded befors & cimdd dhis iae
i e prol e

T b comra it bl n, chik: e s i Dai s

e )

Now Startup Manager turns off the crashing startup file automatically, but you have the
option of turning it back on or starting the Conflict Isolation process to determine the exact
cause of the crash.

The Conflict Isolation process

Because the Conflict Isolation process will vary according to your system and the software
you have installed, it's not practical to cover here every situation you might encounter.
However, we can provide a representative Conflict Isolation process that you can adapt to
your particular situation.

To begin Conflict Isolation:

1. Restart you Macintosh and hold down the spacebar until the Now Startup Manager dialog box
opens.

2. Click the Conflict Isolation button.

160

Another dialog box opens, asking you to type in a description of the problem. This
description will appear in the log that Now Startup Manager creates when Conflict
Isolation is complete.
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Notice that the dialog box also indicates the minimum number of restarts that will be
required to identify the problem.

3. Type in the description and click “OK.”

A dialog box appears to inform you that you can turn on any extensions that are “es-
sential” to the use of your Macintosh.
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Click “OK.”

You're returned to the Now Startup Manager startup dialog box. Notice that all of
your startup files are turned off and that “Conflict Test” appears in the “Startup Set”
pop-up menu.

Click to the left of any essential extensions to turn them on for conflict isolation.

Turn on any extensions that you feel must be turned on in order for you to use your
Macintosh (software for a trackball, for example) or that are essential to the manifes-
tation of the conflict (for example, you won't be able to test a problem that occurs
with remote volumes unless AppleShare is loaded at startup). A bullet (¢) appears to
the left of any extensions you turn on now, to differentiate them from items that are
turned on automatically during Conflict Isolation.

Click “OK™ in the lower right of the dialog bhox.
Your Macintosh starts up with minimal startup files turned on.

When your Macintosh has finished starting up and the Finder desktop appears, test to see
whether the problem is still occurring.

Depending on whether or not Now Startup Manager turned on the troublesome exten-
sion in this Conflict Isolation group, the Macintosh may or may not crash.

To start the next cycle of Conflict Isolation:

1.

Restart your Macintosh.

As soon as the Now Startup Manager startup dialog box opens, another dialog box
opens over it, prompting you to indicate the results of the last Conflict Isolation test.

Click... To indicate that...
Passed The problem didn’t occur during the last test.
Failed The problem did occur during the last test.

Retry You’re not sure whether or not the problem occurred and want to test
again under the same settings—Now Startup Manager will restart with the
same group of startup files as last time.

Stop Test You want to stop the Conflict Isolation process.

Click the appropriate button to indicate the results of the last test.

Depending on which button you click, Now Startup Manager now either turns on the
other half of the startup files, or turaf half of the last group, and continues the
startup process..

When in Conflict Isolation mode, Now Startup Manager marks active files with
a diamond symbobj to indicate that they're only temporarily active.

When your Macintosh has finished starting up and the Finder desktop appears, test to see
whether the problem is still occurring.
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Continue repeating steps 1 through 3 until Now Startup Manager identifies the problem startup
file for you and offers to turn it off.

The number of cycles necessary to resolve the problem will depend on the number of
startup files that are active in the last-selected Startup Set, but when Now Startup
Manager has run enough cycles, a Conflict Isolation Results dialog box will appear,
telling you which extension(s) is (are) at fault).

If theResults dialog box indicates a one-way conflict—only one startup file is identi-
fied as causing the problem—you can solve the problem by simply operating your
Macintosh with that file. If the file’s functionality is important you may want to con-
sider other options (see the following section on Using the Conflictlsolation results).

If the Results dialog box indicates a two-way conflict—one involving two (or more)
extensions—skip to Two-way startup conflicts, below.

Click “OK.”

A dialog box opens, informing you that Now Startup Manager has created a log of the
Conflict Isolation process and asking if you want to save it to the main window of
your startup disk. (This file will open in Now Profile if you double-click it, or it can

also be opened by any word processor.)
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Click “OK.”
The file is saved, and you're returned to the Now Startup Manager startup dialog box.

Click “OK™ to continue the startup process without the troublesome extension turned on.
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Two-way startup conflicts

The simplest conflicts are those in which a single startup file is the problem. You may en-
counter situations in which two extensions are responsible for a startup conflict. Now
Startup Manager can identify a two-way conflict and offer you options for resolving it. In
such a case, this dialog box appears:
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This table explains how to use the buttons in the dialog box.

Click... In order to...

Change Order Have Now Startup Manager change the loading order of the two exten-
sions relative to each other—the one that currently loads before the other
will now loadafter it.

Isolate Further Continue Conflict Isolation to check for the rare situation of three exten-
sions conflicting with each other.

Done Stop Conflict Isolation and load your regular startup files again. The two
problem extensions are turned off, and you may want to reinstall them to
see if that will resolve the problem. If they’re not essential to the use of
your Macintosh, however, you may prefer to simply remove them from
your system.

Software conflicts in applications

In addition to software conflicts that occur during startup or shortly afterwards, it's pos-
sible to have problems when you’re running applications. You can use Now Startup Man-
ager to resolve these as well; it just involves determining exactly what it is that you have

to do in the application to get the problem to occur, then running the same application and
performing the same action for every Conflict Isolation cycle until Now Startup Manager
determines which startup file is causing the problem. Once you have this information, you
can remove the startup file, or possible create a Startup Set that excludes it so that you can
use that Set when you plan to use the application in which the problem occurs.
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Intermittent software conflicts

At times you may encounter a crash or other problem that doesn’t occur dependably or
repeatably. Now Startup Manager can help you resolve this kind of conflict, too—it just
may take a while. With an intermittent problem, just because one Conflict Isolation cycle
passes with no problem doesn’'t mean that repeating the same cycle wouldn’t cause the
problem to occur. The best approach here is to repeat cycles with the same startup files
several times. You can do this by clicking “Retry” in the dialog box that appears when you
restart. Continue with the same set of startup files for as long as it takes for you to be sure
that the problem definitely isn’t occurring. Then click “Passed” in the Now Startup Man-
ager dialog box the next time you restart, and continue testing. It takes a little patience, but
Now Startup Manager can help you solve even an intermittent software conflict.

Using the Conflict Isolation results

When Now Startup Manager informs you that a single startup file is causing your problem,
or when you have a multiple-extension conflict and reordering the items hasn’t solved the
problem, you have a few options:

» Simply remove the startup file that’s causing your problem, if it isn't essential to your
use of the Macintosh.

* Delete any preferences files that are used by the startup file and restart.

» Contact the publisher to find out if there is a newer version of the file that might resolve
the problem.

» Try moving the file to a different position in the startup order (first, last or another posi-
tion), restarting, and seeing if it resolves the problem; or, when you have a two-way con-
flict and automatic reordering hasn't helped, you can try placing one or both of the items
at the very beginning or end of the startup process—this can occasionally help.

* In rare situations, you may discover that a particular extension needs to load before any
others at startup (including Now Toolbox and Now Startup Manager) in order to func-
tion properly. To cause an extension to load before Now Toolbox and Now Startup
Manager, place two spaces before its name if its name precedes Now Toolbox alphabeti-
cally, or three spaces if its name follows Now Toolbox alphabetically (Now Toolbox has
two spaces at the beginning of its name). Also, make sure that the item is located in the
Extensions folder; if it's in the Control Panels folder, move it to the Extensions folder
and place an alias of it in the Control Panels folder.

 In a two-way conflict in which reordering hasn’t helped, you may want to consider
whether both files must always be running. If it's possible for you to let one load at
startup and leave the other turned off, you may want to create two different Startup
Sets—in one Set, startup file A is turned on and B turned off, and vice versa in the other
Set.

If you're successful in solving the problem by changing loading order or turning off other
startup files, it may be helpful to use Now Startup Manager’s Links function to enforce
these relationships. See the next section for information on using Links.
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Using Links

Links help you avoid recurring startup problems by setting up relationships between
startup files that let Now Startup Manager control them automatically. You can set up
Links to:

» Specify loading orders for two or more startup files that can’t be overridden by dragging
in or sorting the startup file list

« Prevent incompatible startup files from loading together

« Make sure that startup files that are dependent upon one another will be turned on to-
gether

e Turn on an entire group of startup files if any one member of the group is turned on

e Turn off an entire group of startup files if any one member of the group is turned off.

By default, Now Startup Manager contains a few pre-configured Links to handle incom-
patibilities or loading order preferences that Now Software already knows about. You may
want to open the Links dialog box and review these pre-configured Links before you cre-
ate your own. Links apply to all Startup Sets.

Creating Links

Create a Link when you've discovered a startup conflict or other situation that requires
you to set up a specific relationship between two or more startup files.

To create a Link;

1. Inthe Now Startup Manager control panel, click the “Create/Modify Links” button.

The Links dialog box opens.

Extensions that have Define the type Click to delete

Pop-up menu for
been added to the Link of Link here the current Link

choosing a Link to
view or modify
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Click to rename
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Click to remove the
extension selected
on the right from
the current Link

Click to create
a new Link

Click to add the
selected extension
to the current Link

2. Click “New Link...”.

A dialog box opens, prompting you to name the new Link.
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3. Type a name for the Link, then click “OK.”

You're returned to the Links dialog box, where the Link you just created is selected in
the “Link” pop-up menu at the upper left. Note that the “Extensions in Link” area is
blank—you need to add the relevant startup files to this Link next.

4. Inthe “Extensions™ list at left, select the startup files that are involved in this Link.

This area lists startup files that have been recently installed on your hard disk, plus a
few that Now Startup Manager knows about by default.

i, By default, this dialog box is set to show only those startup files contained in

V" the currently-selected Startup Set. If you want to see all of the possible items to
add to a Link, deselect the checkbox below the list.

Hold down the Shift key to select multiple items that are next to each other in the list;
hold down the Command key to select items that are not next to each other.

5. Click “Add” to add the selected items to the “Extensions in Link™ list.

Once you've added an item to the list, you can remove it if necessary by selecting it
and clicking “Remove.”

., You can also add individual items by double-clicking them in the “Extensions”

U list.

6. When you’ve added all of the necessary items to the “Extensions in Link “ list, choose the
“Type of Link™ option for this Link.

Choose... To specify that...

Grouped Extensions When any item in the Link is turned on, all items will be
turned on and vice versa.

Force Displayed Order The items in the Link will always load in the order that
they appear in the “Extensions in Link” list.

Drag the items in this list to set the desired order.

Needs an Extension The item(s) in the Link cannot be turned on unless the
startup file that you specify using the pop-up menu is also
turned on.

To complete this Link, choose the needed extension from
the pop-up menu.

Incompatible Extensions No more than one of the items in the Link can be turned
on at one time; turning on another of the items will turn
off the one that was previously turned on.

7. Click “OK.”
You're returned to the control panel, and your new Link is active.

If you want to create a Link for a startup file that is not currently installed on your hard
disk, see “Specifying custom extension names for Links” later in this chapter.
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Viewing Links in the control panel

The Now Startup Manager control panel lets you see a summary of each Link that you've
set up, and see which startup files are included in each Link. To see a Link summary, just
click any Link name in the Link Summary area in the lower right corner of the control
panel.
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The top line of the Link Summary area shows the Link type defined for the selected Link
(Grouped Extensions, Force Displayed Order, Needs an Extension, or Incompatible Exten-
sions), and any startup files included in the Link are selected in the list of startup files at
left.

Renaming and deleting Links

You can rename existing Links and also delete them if you decide they’re no longer neces-
sary. To perform either of these functions, open the Links dialog box as described above,
choose the Link you want to rename or delete from the “Link” pop-up menu, and click the
appropriate button.

Clicking “Rename...” opens a dialog box prompting you to type a new name. Type the
desired name and click “OK.” Then click “OK” in the Links dialog box and you're re-
turned to the control panel.

Clicking “Delete” opens a dialog box prompting you to confirm that you want to delete the
Link (unless you've turned off the confirmation option in the Now Startup Manager pref-
erences—see “Now Startup Manager preferences” later in this chapter for more informa-
tion). Click “OK,” then click “OK” again in the Links dialog box and you're returned to

the control panel.

Specifying custom extension names for Links

Now Startup Manager lets you establish Links for startup files even if they aren’t installed
on your hard disk, so that you can anticipate the future installation of certain items and
prevent potential problems.

You need to know the startup file’s name and four-character creator code in order to add it
to a Link. Use the “Edit...” command in Now Super Boomerang, or use ResEdit or a simi-
lar utility to determine a file's creator code.
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To add a custom extension name to a Link:

1. Follow steps 1 through 3 in the previous procedure for creating a Link.

2. Click “Custom...”.

A dialog box opens, prompting you to enter a name and creator code.
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If the “Custom..

3. Type the startup file’s name and creator code in the appropriate fields.

4. Click “OK.”

You're returned to the Links dialog box, where the custom extension name now ap-

." button is dimmed, you need to deselect the “Show only Ex-
tensions in current Set” checkbox to make it available.

pears in the “Extensions in Link” list.

5. Continue configuring the Link as described earlier.

Now Startup Manager will automatically enforce the Link, should you install the

startup file later.
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Now Startup Manager preferences

This section provides a general overview of the options available in Now Startup Manager.

Setting your main preferences

To open the Preferences dialog box, open the Now Startup Manager control panel or dia-
log box, and click the “Preferences” button.
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The table below explains the various options available in this dialog box.

This option...

Specifies that...

Ask before deleting Sets & Links

Display Fonts

Startup Key

Reserve System Heap Space

Run new extensions

Now Startup Manager will prompt you for
confirmation whenever you delete a Startup
Set or Link.

Fonts will be displayed in the Startup File
list so that you can turn them on and off to
suit your needs.

The key combination shown will open the
Now Startup Manager startup dialog box at
startup, before your startup files have
loaded. Change the Startup Key by clicking
in the field and typing; you can specify a
single letter or a combination of modifier
keys and a letter.

Lets you reserve system heap memory to
avoid memory-related problems. See “Re-
serving system heap space” later in this sec-
tion for more information.

Any new startup file copied into the System
Folder, Control Panels folder or Extensions
folder will be turned on automatically in
Now Startup Manager so that it will load
into memory the next time you start up.

continued on next page
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This option... Specifies that...

continued from previous page

Add new extensions to all Sets Any new startup file that you add to your
system will be turned on automatically in
all Startup Sets, rather than the current one
only.

Resolve Aliases When you put aliases of startup files in the
active System Folder, Now Startup Man-
ager will resolve the aliases and load the
actual startup files during startup. See “Re-
solving aliases” later in this chapter for
more information.

Reserving system heap space

The system heap is an area of memory used by the system software, startup files and appli-
cation programs. Normally under System 7, adjusting the system heap is unnecessary be-
cause the system software resizes it dynamically and automatically. Under certain
conditions, however, adding memory to the system heap may help your system and any
startup files that you are using to run more smoothly. At times, the system heap may not

be able to meet the memory demands of certain large applications when they are running
simultaneously; or you may have trouble because of startup files that become active at
some point during a work session and call for more memory. If you find your Macintosh is
acting strangely or crashing unpredictably, you may want to reserve additional system

heap space.

To do so, select the “Reserve System Heap Space” checkbox in the Preferences dialog
box, then type the desired values in the two fields.
[ Eeamrye G ribn b dpbid
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Enter the amount of memory you want to set aside for the system heap by typing a fixed
number of kilobytes in the “K” field, and a percentage in the “%” field. In general, “32K
or 20%" is a good setting to start with. Now Startup Manager will check the total amount
of memory needed by the system software and any extensions currently running, and then
add either the fixed number of kilobytes or the percentage figure you set, whichever is
larger.

For example, if the total memory called for at startup is 2000K, and you have set Now
Startup Manager to add 32K or 20%, the amount of memory added will be 400K, or 20%
of 2000K. If you occasionally activate different Startup Sets, it is generally a good idea to
give preference to the percentage method in this way, so that the added memory is always
sufficient but can fluctuate depending on the memory requirements of the current Startup
Set.
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Resolving aliases

The “Resolve Aliases” checkbox in the Preferences dialog box is extremely useful if you
use a RAM Disk to get faster performance on a desktop Macintosh, or to save battery life
on a PowerBook. You can substantially reduce the memory required by the RAM Disk by
selecting this option. Just duplicate your System Folder, replace the extensions and control
panels in the duplicate folder with aliases of those in the original folder (be sure to remove
the actual items from the duplicate folder after you've placed the aliases there), and copy
the duplicate System Folder containing the aliases to your RAM Disk, replacing the old,
larger System Folder. Check the size of the new System Folder on the RAM Disk, and if
necessary, open the Memory control panel and adjust the size of the RAM Disk to take
advantage of the additional available space (the system software requires that you to re-
move all files from the RAM Disk before changing its size). Then open the Now Startup
Manager control panel, choose the RAM Disk as the startup disk using the “Choose
Startup Disk” pop-up menu, and restart. As your Macintosh starts up, Now Startup Man-
ager will read into memory the original startup file referenced by each alias that you put in
your RAM Disk’s System Folder.

Extension Display Preferences

Now Startup Manager allows you to control which startup files will appear in its list, so

that you can choose the types of startup files you want to manage. In addition to setting the
types of startup files to display, you can also exclude specific startup files from appearing
in the list. If you support other Macintosh users who might inadvertently disable exten-
sions that are important to leave turned on at all times, you can use this option to limit the
items that they have access to. The security of this feature is reinforced by the ability to set
a password for access to these settings.

Setting your Extension Display Preferences
You can gain access to these settings through the Preferences dialog box.

To set your Extension Display Preferences:

1. Click the “Preferences” button in the Now Startup Manager control panel.
The Preferences dialog box appears.
2. Click the “Display...” button.

The Extension Display Preferences dialog box appears.
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I If the Extension Display Preferences are password-protected, you'll need to

*  type the correct password before this dialog box will open. If you don’t know
the password, see your system administrator, or see “Password-protecting the
Extension Display Preferences” later in this chapter for more information.

3. Select the option(s) for the types of startup files you want Now Startup Manager to display.

Select... To display and control...

Extensions and Control Panels Standard extensions and control panels only.

Items that load before Now Toolbox* Any items that load before Now Toolbox,
such as MacsBug, System Updates, etc.

Components & Shared Libraries* Extensions that share information with other
components.

Chooser Extensions* Extensions that control Chooser items such
as printer drivers, network servers, etc.

* You must first select “New Extension Types” in order to select this option.
4. When you’ve made your selections, click “OK.”
You're returned to the Preferences dialog box.
5. Click “OK.”
You're returned to the Now Startup Manager control panel. Any changes you made to
the types of startup files to be displayed are reflected in the list.

Excluding startup files from display

To exclude a particular startup file from being displayed in Now Startup Manager’s list,
either to avoid being distracted by it or to prevent a user from turning it off or changing its
loading order, use the Exclude option in the Extension Display Preferences dialog box.

To exclude startup files from being displayed:

1. Click the “Preferences” button in the Now Startup Manager control panel.

172

The Preferences dialog box appears.
2. Click “Exclude...”

As noted earlier, if the Extension Display Preferences are password-protected
you will need to type the correct password before this dialog box will open.

A dialog box opens where you can specify the startup file that you want to exclude.
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3. Select the startup file that you want to exclude.

4. Click *Add.”

You're returned to the Now Startup Manager control panel. The item you excluded no
longer appears in the list of startup files.

I Once you've added a startup file to the exclusion list, you can remove it later by selecting
*~ itin the list and clicking “Remove.”

., Now Startup Manager lets you exclude startup files from its list even if they aren't in-

v stalled on your hard disk; you need to know a startup file’s name and four-character cre-
ator code in order to exclude it. To exclude a startup file in this way, click “Custom...” at
step 4 above, follow the procedure explained earlier in the “Specifying custom extension
names for Links” section, and then return to step 5.

Password-protecting the Extension Display Preferences

If you support a group of Macintosh users and you want to make sure that they can’t
modify the settings you specify in this area, you should password-protect access to the Ex-
tension Display Preferences.

To password-protect the Extension Display Preferences:

1. Click the “Preferences” button in the Now Startup Manager control panel.
The Preferences dialog box appears.
2. Click “Passwords...”.

If a dialog box appears requesting that you type a password, then the Extension
Display Preferences are already password-protected—you will need to type the
correct password before the Extension Display Preferences dialog box will
open. If you don’t know the password, see your system administrator.

A dialog box opens, prompting you to type in a password.
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Type the password you want to use into the “Password” field.

Click in the *“Confirmation” field or press Tab to advance the cursor to that field.
Type the same password again to confirm that you’ve typed it correctly.

Click “OK.”

o o ~ w

You're returned to the Preferences dialog box. From now on, clicking on the Prefer-
ences buttons in the Now Startup Manager control panel will produce a dialog box
requesting the password.

If you later decide that it's no longer necessary to password-protect the Extension Display
Preferences, you can remove the protection by clicking “Remove” in the Password dialog
box. You'll be required to enter your password once more to confirm the removal.

You can set up password-protection once and then get a password-protected Now Startup
Manager onto every user’s Macintosh. Just set up password protection the way you want
it, then place the copy of Now Startup Manager that you modified in the Now Utilities in-
stallation folder on your network server (see Chapter 1, “Installing Now Ultilities” for

more information on installing over a network). When the users you support install from
this server, the password-protected Now Startup Manager will be installed on their com-
puters (this method assumes that you've purchased enough copies of the software to dis-
tribute it legally in this way).
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Chapter 11
Now Super Boomerang

Since the earliest versions of Now Utilities, Now Super Boomerang has proven so useful
to hundreds of thousands of Macintosh users that it alone has justified the purchase of
Now Utilities for many of them. Once you've been using Now Utilities for a few weeks,
you'll also be unable to imagine going back to using your Macintosh without Now Super
Boomerang. It keeps track of your most frequently-used files and lets you open them
quickly. It also enhances the Open/Save directory dialog box, letting you find, rename,
duplicate and delete files directly from the dialog box. Now Super Boomerang will also re-
launch the documents you were last using when you launch an application, and can even
open all applications and documents you were last using when you restart your Macintosh.

Tracking recent files and folders ........cccoooviieiiiiiiii e, 177
Now Super BoOOMErang MENU.........uuuuuruumuiiiaieeeeeeeeeeeeeeeesiriis e ee e 177
Now Super Boomerang DirectOpen submenu ............ccccceeeiiieiviiiiiiieeeeens 179
Now Super Boomerang directory dialog boX ...........ccoovvvvviiiiiiiiiiiiennnnnn. 180
USINg the POP-0UL MENUS ......uuiiiiiiiiiiiiiieieeee et 183
Finding files and folders ... 184
Using the “Edit...” dialog DOX.......cccoeeiiiieiiiiiiicce e, 187
USING HOL KBYS ..ttt e e e e e e e e e e e e eeeeneneannnans 188
Hot Keys in the directory dialog BOX .........ccooiiiiiiiiiiiiii e 188
Define Hot Keys dialog BOX ........ccooiiiiiiiiiiicc e 188
Now Super Boomerang control panel ...........ccccccooiiiiiiiiiiiiiiieeee 190
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Tracking recent files and folders

Whenever you open a document, application, control panel, Workset, or other item, it is
temporarily added to the Now Super Boomerang menu. Now Super Boomerang can keep
track of up to 500 items. Once you exceed this limit, Now Super Boomerang adds the most
recently opened item and removes the item that has been inactive the longest.

Now Menus also provides menu lists of recently-used items, but in a slightly different
way. Now Super Boomerang displays all file types, including applications, documents,
control panels, etc., while Now Menus filters recent items based on what kind of Smart
Item you've placed in a menu (for example, “Recent Apps” or “Recent Files”). Together,
these two components ensure that Now Utilities puts recent files and folders at your fin-
gertips in every situation that you might need them.

Now Super Boomerang menu

Once Now Super Boomerang has loaded at startup, a “Now Super Boomerang” item ap-
pears in the Apple menu and provides a submenu listing the files and folders you've re-
cently opened, as well as a powerful Find function and a direct path to any items on your
desktop, including open windows.
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To use the Now Super Boomerang menu, simply highlight “Now Super Boomerang” in the
Apple menu and then choose the item or option you want from the hierarchical submenu.

In order to... Do this...
Open a recent file Choose the file’'s name from the menu.
View the contents of a recent folder Highlight it and navigate through its contents

up to ten levels deep. Open any document or
application listed in a folder submenu by
choosing the item’s name.

1, Hold the Command key while in any
Super Boomerang folder list and the
files are sorted chronologically. With-
out the Command key they’re sorted
alphabetically.

Open a folder window on the desktop Choose the folder's name from the menu.

View items on the Finder desktop Highlight “Finder Items” and choose desired
items from the attached submenu.

Find a file or folder Choose “Find..."”. The Now Super Boomer-

ang Find dialog box appears (see “Finding
files and folders” later in this chapter for
more information).

Choosing “Now Super Boomerang”
from the Apple menu also opens the
Find dialog box.

Open a directory dialog box to locate a file Choose “Open..."”. The Now Super Boomer-
ang directory dialog box appears.

Delete a recent file/folder from the menu  Press Delete/Backspace while highlighting
the item. A line appears through the item’s
name, indicating that it will not appear the
next time you pull down the menu. (This ac-
tion does not delete the item from your sys-
tem.)

Make a recent file/folder permanent Press the spacebar while highlighting the
item. The item’s name becomes underlined to
indicate its permanent status; it will appear in
the menu at all times, even if it hasn't been
opened recently.

View a file or folder's pathname Press the “P” or “W” key while highlighting
the item. The pathname appears over the
item’s name (see “Viewing pathnames for
items in menus” in Chapter 4, “Now Menus”
for an illustration).
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Now Super Boomerang DirectOpen submenu

Now Super Boomerang also makes opening recent files and folders from within an appli-
cation very simple by listing these items on a submenu attached to every application’s
“Open...” command. This DirectOpen submenu is quite similar to the Now Super Boom-
erang menu in the Apple menu, but its list is filtered to include only recent files that can be
opened by the current application, and the folders containing those files.
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The options available from the DirectOpen submenu within an application are the same as
from the Now Super Boomerang menu in the Apple menu, except that choosing a folder
name will open a directory dialog box listing that folder’s contents, instead of opening the
folder’'s window in the Finder. The DirectOpen submenu will also be attached to the “Im-
port...” and “Place..."commands of many applications, or similar commands that typi-

cally open a directory dialog box.
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Now Super Boomerang directory dialog box

Now Super Boomerang also enhances the directory dialog box that appears when you
choose the “Open...” or “Save As...” command (or “Save” for a new, untitled document)
in an application. The Now Super Boomerang directory dialog box includes a menu bar
with powerful commands that let you manage your files without having to switch out of
the current application to the Finder.
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When Now Super Boomerang’s Rebound feature (see “Now Super Boomerang prefer-
ences”) is turned on, this dialog box appears with the most recently-used folder open and
the most recently-used file selected. (If Rebound is turned off, the folder containing the
current application is opened with the top file selected.) Even with Rebound turned on,
you can also specify a default folder that will open in this dialog box when a particular ap-
plication is active.

When you're in the Now Super Boomerang directory dialog box, clicking outside it on the
desktop (if the desktop is visible) will cause Now Super Boomerang to switch to the desk-
top in the directory list. Similarly, clicking on any open Finder window that is visible on
the desktop will switch the directory list to the corresponding folder.

This table lists the options available in the enhanced directory dialog box.

In order to... Do this...

Open a recent folder Choose it from the Folder menu.

Set a default folder for the current application Press the “D” key while highlighting the
desired folder in the Folder menu. In the
future, the contents of this folder will be
displayed when you open the directory dia-
log box to open or save a document.

Open a recent file Choose it from the File menu.

continued on next page
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In order to... Do this...

continued from previous page

Delete a recent file/folder from its menu Press Delete/Backspace while highlighting
the item. A line appears through the item’s
name, indicating that it will not appear the
next time you pull down the menu. (This
action does not delete the item from your
system.)

Make a recent file/folder permanent Press the spacebar while highlighting the
item. The item’s name becomes underlined
to indicate its permanent status; it will ap-
pear in the menu at all times, even if it
hasn’'t been opened recently.

View a file or folder's pathname Press the “P” or “W” key while highlight-
ing the item. The pathname appears over
the item’s name (see “Viewing pathnames
for items in menus” in Chapter 4, “Now
Menus” for an illustration).

Switch the volume displayed Choose the desired volume from the Drive
menu. The available space on the volume is
displayed next to its name. Unmounted vol-
umes are dimmed in the Drive menu.

Find a file or folder Choose “Find...” from the Options menu.
The Find dialog box opens. (See “Finding
files and folders” later in this chapter.)

Rename, duplicate or delete a file Display the contents of the folder contain-
ing the file(s) you want to modify, and
choose “Edit...” from the Options menu;
the Edit dialog box opens. (See “Using the
‘Edit...” dialog box” later in this chapter.)

Create a new folder Open the folder/volume where you want to
create the folder and choose “New
Folder...” from the Options menu. Type a
name for the folder and click “OK.”

View information about an item Choose “Show Info” from the Options
menu. Information for the selected file or
folder (last modified date, size, etc.) ap-
pears at the bottom of the dialog box.

I The “Always display file/folder in-

*~  formation” checkbox in the Prefer-
ences dialog box must be checked
for this information to appear. See
“Now Super Boomerang prefer-
ences” later in this chapter for more
information.

continued on next page

Chapter 11—Now Super Boomerang 181



182

In order to...

Do this...

continued from previous page

Permanently add a folder to the Folder menu Select the folder in the directory list (or

Permanently add a file to the File menu

Remove all folders from the Folder menu

Remove all files from the menu

View and modify Hot Keys

View and modify preferences

make no selection within the desired
folder) and choose “Add Permanent
Folder” from the Options menu; this lets
you add a folder to the menu that you
haven't used recently.

Select the file in the directory list and
choose “Add Permanent File” from the Op-
tions menu.

Choose “Clear Folder menu” from the Op-
tions menu; all temporary folders in the
menu are removed.

Choose “Clear File menu” from the Op-
tions menu; all temporary files in the menu
are removed.

1, You can remove individual folder
and file names from the Now Super
Boomerang menus by highlighting
them and pressing the Backspace/
Delete key.

Choose “Hot Keys...” from the Options
menu. See “Using Hot Keys” later in this
chapter for more information.

Choose “Preferences...” from the Options
menu. See “Now Super Boomerang prefer-
ences” later in this chapter for more infor-
mation.
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Using the Pop-out menus

The menus in Now SuperBoomerang's directory dialog boxes are hierarchical. That is, you
can slide down the "Folder" menu (for example) and the folder's contents will be dis-
played. This extremely powerful feature allows you to select any item on your hard disk(s)
with a minimum of effort. The behavior of each menu is described below.
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Within this menu... Now SuperBoomerang displays...
Folder The contents of the folder (including both files and folders, which
in pop out in turn, up to ten levels). The folder's enclosing, or
"parent,” folder, is also displayed, as are any intermediate folders
in the folder's pathname. The enclosing folders are displayed be-
neath list of enclosed files, and are separated from them with a
dotted line.

., You can “move up” one or more levels using this enclosing
folder list much more quickly than by using any other
method.

File Just the files, as there are no folders in the "File" list to pop.

Drive Files in the selected drive that can be opened by the current appli-
cation. Folders selected from the pop-out list are displayed in turn,
up to ten levels; files are opened.

Options Just the Options, as there is nothing to pop out.
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Finding files and folders

The Now Super Boomerang “Find...” command lets you search quickly for files and fold-
ers on your hard disk or any volume. The “Find...” command is available from the Now
Super Boomerang menu on the Apple menu, the DirectOpen submenu of any application,
or from the Options menu in a directory dialog box.

You can also install the “Find...” command in a Now Menus Custom Menu. See Chapter
4, “Now Menus” for more information.

To find a file or folder:

1. Choose “Find...”” from the Now Super Boomerang menu on the Apple menu (or choose Now
Super Boomerang itself), from the DirectOpen submenu in any application, or from the Options
menu in a directory dialog box.

The Find dialog box opens. Notice that it displays any local or remote volumes you're
connected to, plus the most recently-used folder if you're in an application other than
the Finder. Also, the search text field contains the text you last searched for, if any.
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2. Select the folder(s) and/or volume(s) where you want to search.

Press Command-A to select all of the volumes and folders shown.
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3.

Define the search criteria.

To search for... Type text in this field...

A file or folder by name File Name.You can type up to 27 char-
acters. Type an asterisk (*) to represent
a wildcard character that will match any
character (or select the “Any match”
checkbox to let spaces function as wild-
cards). This field is not case-sensitive.

To search for folders, select the
“Show folders” checkbox.

A document containing a specific text stringcan for. Type between 3 and 27 char-
acters; wildcards are not accepted in this
field, and the search is not case-sensi-
tive.

A file or folder by modification date Modified Since.Clicking in the text
box automatically enters today’s date.
To specify a different date, type it in
MM/DD/YY format.

You can search by any single criterion, or narrow your search by specifying any com-
bination of two or three criteria.

Set any additional search options as desired.

Use this option... To specify that...

Show Folders Now Super Boomerang will find and list folders matching the
search criteria, as well as files.

Any Match Spaces in the search text will be treated as wildcards.

Find Any All files matching the search criteria will be listed, whether or not
they can be opened by the current application; files that can't be
opened by the current application will be dimmed (this doesn't ap-
ply when the Finder is the current application).

In Compressed Now Super Boomerang will search for matching filenames in com-
pressed archives created with Now Compress, Now QuickFiler,
Stufflt, Compact Pro and DiskDoubler; and search for text strings
within files stored in Now Compress, Now QuickFiler and Compact
Pro archives.

Click “Find.”

A progress bar appears in the upper right corner to indicate the status of the search. As
items are found they appear in the Items Found list (the upper scrolling list). To pause
the search, click “Pause” or anywhere in the dialog box; to resume the search, click
“Find” again.

Chapter 11—Now Super Boomerang 185



186

The “Find” button dims when the search is complete. The directory path for any item
selected in the Iltems Found list will appear in the File path list (the lower scrolling

list).
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Select a file or folder in the Items Found list to display information about it, or display any

matching text string found within the file.

Information for the selected file, including type, creator, size and last modified date, is
displayed to the right of the Items Found list.

If you specified searching for text within a file, a portion of the file containing the tar-
get text string is displayed at the bottom of the dialog box. The numbers to the right of
the Text Found box indicate the number of occurrences of the text string in the file
(bottom number) and which occurrence is being displayed (top number). Click on the
up or down arrow to move through multiple occurrences.

Double-click a file to open it in the current application, or double-click a folder to re-
turn to the directory dialog box and view the folder’s contents.

Click “Define™ to start another search or “OK™ to close the Find dialog box.

If a file is selected when you click “OK,” the file is opened; if a folder is selected,
you're returned to the directory dialog box, where the folder’s contents are listed.

“OK.”
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., If you want only to locate the file and not launch it, hold down the Shift key
U~ while clicking “OK"—you’ll be returned to the directory dialog box, where the
file will be highlighted.

., If the file wasn’t created by the current application but you want to force the
v application to launch it anyway, hold down the Command key while clicking



Using the “Edit...” dialog box

You can use Now Super Boomerang’s “Edit...” command to rename, duplicate and delete
files, tasks that are otherwise possible only in the Finder.

To use the “Edit...” dialog box:

1.

Choose “Open...” from the Now Super Boomerang submenu on the Apple menu, or choose
“Open...” from an application’s File menu.

The enhanced directory dialog box opens.

You can also open this dialog box, and then the “Edit...” dialog box, by choos-
ing “Save as...” from an application’s File menu (or “Save” for a new, un-
titted document).

Open the folder containing the file(s) you want to modify, so that its contents are listed in the
directory window.

Choose “Edit...” from the Options menu.

The Edit dialog box appears, listing the files contained in the folder. A mini-icon ap-
pears to the left of each filename and identifies the file type. The top of the dialog box
shows the current folder and volume name, as well as the amount of free space on the
current volume.
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A slash through a mini-icon indicates that the file is currently open or busy and can't
be duplicated, renamed, or deleted. A padlock on a mini-icon indicates that the file is
locked. Locked files can be duplicated but not renamed or deleted.

Files whose names appear in normal type can be opened by the current application (to
open a file, double-click its filename, or select it and click “Open”). Files whose
names are dimmed can be modified here but not opened by the current application.

Select the filename that you want to modify.

Click the desired editing option at the bottom of the dialog box.
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Click... In order to...

Duplicate Make a copy of the selected file—type a filename for the duplicate file in
the dialog box that appears and then click “OK.”

Rename Give the selected file a new name—type the new name in the dialog box
that appears and then click “Rename.”

Delete Remove the selected file from your hard disk—click “OK” in the confir-
mation dialog box that appears.

6. Click “Done” when you’re finished modifying files.
You're returned to the directory dialog box; click “Cancel” to close it.

Using Hot Keys

Now Super Boomerang allows you to assign Hot Keys to menu items in the enhanced di-
rectory dialog box (except those in the Drive menu, which change dynamically according
to the volumes that are mounted). You can also define Hot Keys for certain special Now

Super Boomerang functions.

Hot Keys in the directory dialog box

It's easy to assign Hot Keys to items in the directory dialog box menus (recent files or
folders, or to commands in the Options menu). Just highlight a menu item and type the
desired key combination while holding down the mouse button. The Hot Key must include
one or more modifier keys (Command, Option, Shift, or Control) and a character; function
keys may be used alone. The Hot Key appears next to the highlighted menu item.

Items on the Options menu already have default Hot Keys; however, you can easily change
them by highlighting a menu item and typing the desired Hot Key.

Define Hot Keys dialog box

The Define Hot Keys dialog box lets you set up quick access to some special functions of
the software. To open the Hot Keys dialog box, click the Hot Keys button in the Now Su-
per Boomerang control panel (or choose “Hot Keys...” from the Options menu in a direc-
tory dialog box).
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To change a Hot Key, select the box next to the corresponding function and type the new

Hot Key. If you enter a Hot Key that’s already been used, your Macintosh beeps. To re-
move a Hot Key, select the box next to the function and press Delete/Backspace.

This Hot Key... Does this...
Open “Find...” dialog box Opens the Find dialog box without having to choose
“Find..."” from a menu.

Turn Boomerang On/Off Toggles Now Super Boomerang'’s on/off state without
going to the control panel.

Go to next folder in recent list In a directory dialog box, moves to the next folder in
your list of recent folders in a directory dialog box and
displays its contents.

Go to next file in recent list  In a directory dialog box, moves to the next file in your
list of recent files. The folder shown changes if neces-
sary, and the next-most-recent file is selected.

Mouseless Menus In a directory dialog box, turns on the Mouseless Menus
mode of Now Super Boomerang, which lets you select
any menu item using the keyboard. When you activate
Mouseless Menus, the most recently-used Now Super
Boomerang menu is pulled down, with the pointer rest-
ing on the menu title. You can then use the up/down ar-
row keys to select items in a menu, or use the right/left
arrow keys to pull down a different menu. Type the first
letter of a desired menu item, and the pointer moves
down to the first item beginning with that letter. To
choose a menu item, select it and press Return or Enter.
To turn off Mouseless Menus, click the mouse button or
press Command-period.
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Now Super Boomerang control panel

The Now Super Boomerang control panel lets you change many settings that affect Now
Super Boomerang, particularly how files and folders are displayed in menus.

Opens the Toggles the
Define Hot Keys  on/off state
dial‘og box (‘)f Hot Help
Toggles the Displays information
on/off state about Now Super
of Now Super Boomerang and the
Boomerang people who worked
functions on it.
Opens the Exclude dialog  Lets you set
box to turn off Now Super  preferences
Boomerang functions in for Now Super
specific applications Boomerang
This option... Specifies...

Files shared among applications The greatest number of shared files to be displayed in
the DirectOpen submenu in applications. Shared files
are recently-used files that can be opened by an appli-
cation but were not created by it. For example, if you
set this option to zero, Microsoft Word’s DirectOpen
submenu will display only recent Word documents. If
you set it to 1 or more, however, the DirectOpen
submenu will also list any recent MacWrite Pro and
SimpleText documents (or other text-based files) as
well as Word documents. For more information on
sharing files among applications and other ways of
doing so, see “Sharing and grouping files” later in this
chapter.

Files shown in the menus The greatest number of files to be displayed in all of
Now Super Boomerang'’s recent file menus. The maxi-
mum number is 99.

Folders shown in the menus The greatest number of folders to be displayed in all of
Now Super Boomerang’s recent folder menus. The
maximum number is 99.

Excluding Now Super Boomerang from certain applications

The Exclude function lets you create a list of applications in which Now Super Boomerang
will not be active. Setting up an exclusion list can be useful if you want to use only the
basic methods for opening and saving files in a particular application.
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The Exclude dialog box also lets you disable the Re-Launch feature for selected applica-
tions. When Re-Launch is turned on in the Preferences dialog box (see “Now Super
Boomerang preferences” later in this chapter), Now Super Boomerang remembers which
documents were open when you last quit an application, and opens the same documents
the next time you launch that application. If you turn on Re-Launch, you may find that
there are some applications in which you don’t want it active—the Exclude dialog box lets
you turn it off selectively.

You can temporarily disable Re-Launch by holding down the Control key while you open
an application.

To exclude an application or disable Re-Launch:

1. Inthe Now Super Boomerang control panel, click the *“Exclude” button.

The Exclude dialog box opens.
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2. From the pop-up menu at top right, choose the type of exclusion you want to set up.

Choose “Disable Now Super Boomerang” to exclude all Now Super Boomerang func-
tions from an application; choose “Disable Re-Launch” to disable this feature only.

3. To add an application to the exclusion list, select it in the directory on the left, and click “Add.”

If you want to exclude a desk accessory, click “Show Desk Accessories” and select
the one to be excluded.

Repeat this step to add more applications to the list; you can remove an application
from the exclusion list at right by selecting it and clicking “Remove.”

4. When you're finished excluding applications, click “Done.”

You're returned to the Now Super Boomerang control panel. The next time you open
the excluded application, the Now Super Boomerang functions you excluded will not
be active.
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Sharing and grouping files
In general, Now Super Boomerang’s default settings work well for nearly all users. If you

have specialized or unusual needs, however, or just want to understand the details of how
Now Super Boomerang tracks recent files and folders, you may want to read this section.

Now Super Boomerang provides a great deal of flexibility in letting you choose which re-
cent files and folders will be displayed in the Now Super Boomerang DirectOpen submenu
in applications and the recent file and folder menus in the enhanced directory dialog box.

Shared files

To help illustrate this flexibility, let's say you've opened and modified several documents
in SimpleText, Microsoft Word, and PageMaker over the last eight hours. The filenames
in the illustration below indicate when the files were modified and added to Now Super
Boomerang’s list of recent files. If “Files shared among applications” in the Now Super
Boomerang control panel is set to zero, the DirectOpen submenu or the File menu in the
directory dialog box for each application would show only those files listed directly below
each application in the illustration (in the light-bordered boxes)—SimpleText would list
only SimpleText files, Word would list only Word files, etc.

W e

SimpleText Microsoft Word Aldus PageMaker

g 5:00 PM % PageMaker-5PM ﬁ
2  4:.00PM ¥ Word4pm T
g 300 PM SimpleText-3PM g
= 2:00 PM W Word-2PM &
1 1:00 PM 3 Word-1PM

1200 PM SimpleText-12PM
$ 11:00 AM 3 Word 114M
% 10:00 AM [y PageMaker-10AM
3 900 AM SimpleText-9AM

# ¢ #

SimpleText Files  Word Files  PageMaker Files
How Now Super Boomerang tracks files for applications

If “Files shared among applications” is set to 5, however, then the Now Super Boomerang
menus in an application may list recent files that were created by other applications, but
can be opened by the current application. The five files that would be eligible for sharing
among the three applications under this setting are enclosed in the dark border in the illus-
tration.
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If we were to look at the DirectOpen submenu in Word, we would see that the “Page-
Maker-5PM” file wouldn’t be included in the recent file list, even though it's one of the
five eligible shared files—because Word can’t open PageMaker files. Stareopen
SimpleText files, however, the following files would appear in the list in chronological
order:

« “Word-4PM"

* “SimpleText-3PM”

« “Word-2PM"

« “Word-1PM"

« “Word-11AM"

« and any other recent Word files, up to the limit set in the control panel for “Files shown
in the menus.”

Using the Shared Files option is convenient if you frequently use several applications to
work on the same files. For example, you might write brief memos in SimpleText, but
later want to include them in a Word document; or you might write an article using Word
and later want to place it in a PageMaker publication.

You can adjust the number of shared files in the Now Super Boomerang control panel—
just type the desired number in the “Files shared among applications” field. If you changed
the number of shared files to 7, for example, then “SimpleText-12PM” would also appear
in Word’s list of recent files.

Groups

If you find you want to determine more specifically which shared files appear in the recent
file menus, you can use the Groups function. Groups let you share more files among spe-

cific applications, and restrict more closely the kinds of files that are shared. When you set
up a Group of multiple applications, you tell Now Super Boomerang to show the same list

of recent openabile files for all applications in the Group.

Referring back to the illustration, the default “Shared Files” settings would result in the
applications’ recent file lists appearing as follows:

SimpleText—"Shared Files” box + “SimpleText Files” box

Microsoft Word—“Shared Files” box + “Word Files” box

PageMaker (“Place...” submenu)—“Shared Files” box + “PageMaker Files” box

But what if you frequently use Word files in your PageMaker publications? This situation
gives you access to only three Word files plus what may be an unwanted SimpleText file.
You may be slowed down because you have to go to the directory dialog box to locate
Word files that haven't been used recently enough to appear in the menus.
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Using Groups, however, you could create one Group containing Word and SimpleText,
and another Group containing Word and PageMaker. In this situation, the applications’
recent file menus would appear as follows:

SimpleText—“Shared Files” box + “SimpleText Files” box + “Word Files” box

Microsoft Word—"Shared Files” box + “Word Files” box + “SimpleText Files” box + “PageMaker Files”

box
PageMaker (“Place...” submenu)—“Shared Files” box + “PageMaker Files” box + “Word Files” box

Clearly, you have access to more shared files under these settings, because Groups allow
you to share files among applications up to the limit set for “Files shown in the menus” in
the control panel, rather than only within the “Shared Files” limit. When you include mul-
tiple applications in a Group, Now Super Boomerang includes files in the recent file

menus of those applications based on which files were recently opened by any of them.

The folders displayed in the recent folder menus are the ones containing the recent files
shown. In addition, however, a folder made permanent for one application in a Group is
permanent foall applications in the Group. This allows you to share common folders
among the applications. To set a default folder for a Group, you need to configure it as the
default folder for each application in the Group separately.

To set up a Group:

1. Inthe Now Super Boomerang control panel, click the ““Preferences” button.
The Preferences dialog box opens.
2. Click “Groups...”

The Groups dialog box opens. Notice that the top portion is a standard directory dia-
log box. This is where you locate and select applications to be added to a Group.

The pop-up menu in the lower right of the dialog box offers a selection of seven
Groups, plus a “Universal” Group (described later)—leave “Group 1” selected for
now.
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3. Locate and select an application that you want to add to this Group.
Locate the application using the directory dialog box, then select it.
4. Click “Add.”
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The application name now appears in the bottom portion of the dialog box.
5. Repeat steps 3 and 4 to add other applications to the Group.

To create additional Groups, select another Group from the pop-up menu and repeat
steps 3 and 4.

6. When you’re finished setting up your Group(s), click “Done.”
You're returned to the Preferences dialog box.
7. Click “OK.”

You're returned to the control panel; your Group settings are active immediately,
without requiring a restart.

| = The last Group that appears on the pop-up menu in the Groups dialog box is “Universal.”
When you add an application to this Group, the Now Super Boomerang menus function
somewhat differently. The recent file menus of an application included in the Universal
Group will list any files opened by other applications, but other applicationsatillst
files opened by an application in the Universal Group.

Now Super Boomerang preferences

- The Preferences dialog box controls settings that affect Now Super Boomerang. To open
this dialog box, click the “Preferences” button in the Now Super Boomerang control panel,
or choose “Preferences...” from the Options menu in a directory dialog box.
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This option... Does this...
Rebound to last folder Specifies that the last-used folder will open

when you open a directory dialog box.
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Rebound to last file

Always show file/folder info

Remove unmounted items

Auto-Resume applications

Show startup icon

Clear temporary folders

Clear temporary files

Open last-used files (Re-Launch)

List files/folders in alphabetical order

Chapter 11—Super Boomerang

Specifies that the most recently-used file will be
selected when you open a directory dialog box
(instead of simply the first file or folder in the
list).

Specifies that information for the selected file or
folder will always be displayed at the bottom of
directory dialog boxes.

Specifies that the names of recent files and fold-
ers stored on unmounted volumes will be re-
moved from the menus when you restart.

Specifies that all applications that were open
when you last shut down or restarted your com-
puter will be opened again at startup. If Re-
Launch is also selected in this dialog box, the
documents that were open in these applications
when you shut down or restarted will be opened
as well.

Specifies that the Now Super Boomerang icon
will be displayed on the screen during startup.
Specifies that all temporary folders will be re-
moved from the recent folder menus at every
startup, so that the folder list is blank except for
any folders you've marked as permanent.

Specifies that all temporary files will be re-
moved from the recent file menus at every
startup, so that the file list is blank except for
any files you've marked as permanent.
Activates the Re-Launch function: Re-Launch
remembers the documents that were open the
last time you were using an application, and the
next time you open the application, it opens
those documents along with it.

Specifies that recent files and folders will appear

in alphabetical order, with permanent names

listed at the top of the menus; when this option

is deselected, files and folders appear in chrono-

logical order with the most recent items at the

top of the menus.

1, Holding down the Command key when

v you pull down a Now Super Boomerang

File or Folder menu temporarily switches
between chronological and alphabetical
order.

continued on next page



This option...

Does this...

continued from previous page
DirectOpen submenu in applications

Show volume names

Show all permanent items

Folder submenu above file list

Folders listed below files

No matter how opened or saved

From Open/Save dialog box only

Groups...

Specifies that the DirectOpen submenu will be
attached to the “Open...” command in the File
menu of all applications.

Specifies that the name of the volume on which

an item is stored will be displayed to the right of

the item’s name in Now Super Boomerang
menus.

.1, Remember that even if you don't select
this checkbox, you can always view an
item’s full pathname by highlighting the
item and pressing the “P” or “W” key.

Specifies that permanent items will be displayed

in Now SuperBoomerang’s menus even if it

means that recent items are forced off the list.

Specifies that recent folders will be listed above
recent files in the Now Super Boomerang
menus. When this option is selected, the “Finder
ltems” menu and “Recent Folders” item (with an
attached submenu) appear directly under
“Open...” and “Find...” in these menus.
Specifies that recent files will appear directly
below “Open...” and “Find...” in the Now

Super Boomerang menus, with “Finder Items”
and a list of recent folders below the recent files.
Specifies that Now Super Boomerang will keep
track of all files, regardless of how they were
opened.

Specifies that Now Super Boomerang will keep
track only of files opened through a directory
dialog box.

Opens the Groups dialog box. See “Sharing and
grouping files” earlier in this chapter for more
information.
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Chapter 12
Now Tabs

Now Tabs gives you another weapon in the war against desktop clutter. Finder window
can be docked at the bottom of your screen, neatly aligned, and a single click on a docked
window’s tab pops the window right back open. With Now Tabs, it's possible to dock a
deeply-buried folder in an easily accessible place without actually moving it or making an
alias. Handy pop-up menus at either end of the tab bar give access to recently used appli-
cations, files, and folders; they also offer quick methods of accessing either Now
QuickFiler's or Now SuperBoomerang’s Find... functions, emptying the Trash, and more.

USING NOW TaADS ... 201
Docking a Finder window on the Tab Bar ..., 201
Opening docked FINAEr WINAOWS ..........oeiiiiiiiiiiiiiiieee e 202

Using the Tab Bar MENU .........coooiiiiiiiiii e 203

Now Tabs control panel SEttings .........ooevvviviiiiiiiiiiie e 204
ON/OTTF DULION ... 204
TaDS CONFIQUIE ... e e e e 204
Tab Bar CONIQUIE ....cooi i e e e e e e e e e as 205
Tab Bar Menu CONfIQUIE ...t 205
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Using Now Tabs

Now Tabs’ functions are noticeable as soon as you install Now Utilities 6.0. By default, a
narrow “Tab Bar” is placed at the bottom of your monitor, and by default a small pop-up

menu is placed at each end of the bar (half a bar is shown below). Docked windows are
represented by small tabs

-| Good coffee houzes || The clouds will hold me up ]| Quick-quick-quick, slow |
The pop-up menus are identified by the Now Software logos on them.

Docking a Finder window

Now Tabs can dock any open Finder window, using any of three methods. The first uses
the View menu, the second relies on dragging, and the third uses a keyboard-mouse click
combination.

To dock an open Finder window using the View menu, simply bring the desired window
to the front (you want to be sure that you dock the right window), and choose “As Tab”

from the View menu. The window immediately disappears, and a small tab bearing the

name of the window appears in the Tab Bar.

| Uiew I

As Tab

by Small lcon
+ by lcon

by Name

by Size

by Kind

by Label

by Date

Remain Open

Now Tabs works only with Finder windows. Windows from other application cannot be
docked.
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An open Finder window can also be docked by dragging the window to the bottom of the
screen, then letting go when the arrow cursor changes to the tab cursor. As with the previ-
ous method, the window disappears and a small tab bearing the name of the window ap-
pears in the Tab Bar, right where you dragged it.

The cursor will change to indicate that you have moved the window to the proper location
when you get close to the Tab Bar.

The third way to dock an open Finder menu is as simple as holding the Control key and
clicking on the window’s title bar. As before, the window disappears and a small tab bear-
ing the name of the window appears in the Tab Bar.

Tabs can be dragged to any position on the Tab Bar. If you drag a tab on top of another
tab the Tab Bar rearranges itself to eliminate overlap.

Opening a docked Finder window

A docked window can be popped opened with a single click on its tab. A second click on
the tab (or on the one that appears at the top of a popped-open window) recloses the win-
dow. Dragging the tab away from the Tab Bar “undocks” the window—if you make a mis-
take by dragging a tab out of the Tab Bar, merely drag the now-undocked window’s titl
bar back to the bottom of the screen. The window will redock.

Hold down the Command key while clicking on a tab to pop up a menu showing the com-
plete path to the folder you've clicked on. Slide up to any folder in the menu to open that
folder.

Check the “Remain Open” menu item to prevent a popped-open folder from closing when
other tabs are clicked.
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Using the Tab Bar Menu

Now Tabs’ pop-up Tab Bar Menu provides a quick method for emptying the Trash, re-
starting or shutting down your Macintosh, checking the date and time, finding files (see
Chapter 6, Now QuickFiler, and Chapter 11, Now SuperBoomerang), examining Now
AutoType’s settings (see Chapter 2, Now AutoType), and accessing Now Menus’ Recent
Applications, Recent Files, and Recent Folders lists (see Chapter 4, Now Menus).
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If Now QuickFiler’s preference is set to use Now Find as the Find command, Now Find
will be launchedwhen you select Now Find... from the Tab Bar Menu. Otherwise, the
Finder's own Find is launched.

The Now Tabs technology, like that of Now Shortcuts, is extensible, meaning that addi-
tional functionality may be added by placing Now Tabs modules into the Now Tabs Plug
Ins Folder inside the Control Panels folder. Look for additional modules on the Now Soft-
ware Web page—http://www.nowsoft.com—and on the various online services.
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Now Tabs control panel settings

The Now Tabs control panel has an On/Off button, and three buttons for configuring Now
Tabs. As with all Now Utilities components, Hot Help is available to assist you in identi-
fying the buttons.

On/Off button

The “On/Off” button lets you turn the Now Tabs functions on or off without restarting.

Tabs Configure

To view and modify these settings, click the “Tabs Configure” button, if this area isn't al-
ready active.
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The settings for this area are listed below.

This option... Specifies that...

Font Text on tabs will be displayed in the font of
your choice.

Size Text on tabs will be displayed in the size of
your choice.

Style Text on tabs will be displayed in the style of
your choice.

Automatically close tabs after (x) seconds Docked windows that have been popped
open will automatically close after a user-
specified interval.

Play “Open” and “Close” sounds Sounds will be played as tabs are popped
open and windows are reduced to tabs.
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Tab Bar Configure

To view and modify these settings, click the “Tab Bar Configure” button, if this area isn’t

already active.
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The settings for this area are listed below.

This option...

Specifies that...

Show Tab Bar
Include Menu on the left

Include Menu on the right

The Tab Bar will be visible. Note that the tabs will be
visible whether the Tab Bar is visible or not.

The Tab Bar menu will be available at the left end of the
Tab Bar.

The Tab Bar menu will be available at the right end of
the Tab Bar.

Tab Bar Menu Configure

To view and modify these settings, click the “Tab Bar Menu Configure” button, if this

area isn't already active.
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The settings for this area are listed below.

This option...

Specifies that...

Place permanent items at top
Add Recent Folders
Add Recent Files

Add Recent Applications

Permanent items will be displayed at the top of “Re-
cent” lists (if the “Recent” lists are displayed at all).
The Recent Folders Smart Item (see Chapter 4, Now
Menus) will be included in the Tab Bar Menu.

The Recent Files Smart Item (see Chapter 4, Now
Menus) will be included in the Tab Bar Menu.

The Recent Apps Smart Item (see Chapter 4, Now
Menus) will be included in the Tab Bar Menu.
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Chapter 13
Now WYSIWYG Menus

Now WYSIWYG Menus does a simple thing that you'll apprecidte-a-it makes fonts

appear in their actual typefaces and unites font families in Font menus. You can rearrange
the order of fonts in Font menus; change font color or size in Font menus; assign keyboard
shortcuts to a font, style, or size; modify the name of a font family or style; and create cus-
tom Font menus for specific applications. Now WYSIWYG Menus is another Now Utili-

ties component that you'll never want to be without.

Now WYSIWYG Menus is compatible with outline and bitmap screen fonts, Tru€Type
fonts, Type 1 and Type 3 PostScript fonts, Adobe Multiple Master fonts, Adobe Type
Managel' (ATM), MasterJuggler, and Suitcase Il.
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About fonts

This introductory section is intended to help you understand fonts so that you can better
appreciate what Now WYSIWYG Menus does for you, and get more out of the component
as a result.

Types of fonts

You will encounter one or more of the three types of fonts currently used on the
Macintosh; namely, bitmap, TrueType, and PostScript fonts.

Bitmap or screen fonts are fixed-size fonts that describe each character as a grid of black
and white dots (a bitmap). For each point size of the font you need a separate font file. To
display 12-point Times, you need a 12-point Times bitmap file in your System Folder; to
display 9-point Times, a 9-point Times file. These fonts appear onscreen and print at a
maximum of 72 dots-per-inch (dpi) resolution. This is why they often have a slightly
jagged appearance, especially at larger sizes.

TrueType fonts are scalable outline fonts developed by Apple for System 7. They describe
each character as a mathematical formula that defines the character’s shape and point size.
You need only one TrueType Times font to display or print any point size of the Times

font you wish. The fonts supplied with System 7 Macintosh software include TrueType
fonts.

PostScript fonts comprise two elements: a fixed-size bitmap font file for the screen and a
printer font file. If you choose a size for which you don’t have a screen font, the font’s
screen appearance will be distorted. To scale PostScript screen fonts and maintain a qual-
ity appearance, you need ATM (Adobe Type Manager). With only a 10- and 12-point
screen font (which provide the metrics for scaling the font to other sizes) and the printer
font, ATM can display a font on your screen at any size without jagged edges. It also al-
lows you to print PostScript fonts on non-PostScript printers.

Although you can use both TrueType and PostScript fonts, it's generally recommended
that you use one or the other. This prevents possible problems should you switch to an-
other startup disk that has different fonts installed and print a document. Also, using
TrueType fonts when printing documents on a PostScript-capable printer can take longer
and require more memory. As an extra precaution, you may want to remove any unused
fonts from your System Folder. If you use a PostScript font and you have a TrueType font
of the same name, the TrueType font takes precedence and will be displayed instead of the
PostScript font, although the PostScript font will be printed when you use a PostScript-
capable printer.
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Font families

A font family is a set of variations of a single typeface that differ in terms of style or
weight. A font family usually has at least two members: Roman (sometimes called Plain or
Standard) and Italic (sometimes called Oblique). In addition to Plain and Italic, family
members may vary by weight (Light, Book, Medium, Demi, or Bold), by spacing (Con-
densed or Expanded), or a combination of these, sometimes leading to huge font families.
Generally, a variation in a font family is assigned a unique name. Because font vendors
often use their own conventions to assign font family member names, your list of fonts can
sometimes appear quite confusing in a standard Font menu.

Enhancing the Font menus

Once you've installed Now WYSIWYG Menus, you'll notice the enhanced appearance of
the Font, Size, and Style menus in any application displaying these menus.

Font menu

The standard Font menu displays all font names in 12-point Chicago. Now WYSIWYG
Menus displays the names of fonts in their actual typefaces, giving you an idea of what
each font will actually look like in your document.

The standard Font menu scatters members of the same font families throughout the list
because of naming variations in the fonts. Now WYSIWYG Menus organizes each font
family under one family name and creates a submenu for the related typestyles. This re-
sults in a more orderly appearance and makes it easier to locate font family members.

25tone Sans

AGaramond

AGaramond ltalic
AGaramond Semibold
AGaramond Semibolditalic
B 25tone Sans Bold

B Franklin Gothic Demi

Bl 25tone Sans Boldltalic m
Chicago Ao ]
Courier Chicags
FranklinGothic Cauriar
Geneva Frarkin Gothic L]
Helvretica GEnEia
1 28tone Sans Italic Hesedies
Monaco faraca
New York Hinw Tork
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Symbol w Turar
~Times R
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Standard Font menu Now WYSIWYG Menus Font menu
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You can see how much easier it is with Now WYSIWYG Menus to select “Stone Sans
Bold Italic” by going down the list alphabetically to “S,” highlighting “Stone Sans” and
then choosing “Bold Italic” from the submenu. Compare this to the standard Font menu,
where you have to go down the list alphabetically to “B” and select “Bl 2Stone Sans
Boldltalic.”

Size menu

The standard Size menu displays all point size numbers in 12-point Chicago. Now
WYSIWYG Menus displays them in the currently-selected font, scaled accordingly. When
Times is the currently-selected font, the menu item for 24 point appears in 24-point Times.
This enables you to preview how a font looks at the available point sizes.
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24 Point .
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Standard Size menu Now WYSIWYG Menus Size menu

Style menu

The Standard Style menu displays all of the styles in 12-point Chicago. Now WYSIWYG
Menus displays the font styles in the currently-selected typeface with the corresponding
styles applied. This way you can preview how a font looks in each of the available styles.
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Defining Hot Keys for font menu items

For easier access to a font, font size, or font style, you can assign a Hot Key to it by high-
lighting the menu item and typing a modifier key (Command, Option, Shift or Control)

and a character (function keys can be used alone, as well). The Hot Key appears to the
right of the menu item. If you define duplicate Hot Keys for two or more menu items in an
application, only the most recently-defined Hot Key will take effect.

To remove a font Hot Key, highlight the menu item and press Backspace/Delete.

Besides assigning Hot Keys directly in the Font menus, you can assign them to fonts in the
Now WYSIWYG Menus control panel. See “Using the Font Info dialog box” later in this
chapter for more information.

Now Menus must be installed and running in order for you to assign and use font Hot
Keys in Now WYSIWYG Menus. Now Menus can import and export font Hot Keys—see
Chapter 3, “Now Menus,” for more information.

Customizing Font menus in specific applications

While many use Now WYSIWYG Menus’ default settings to enhance the Font menu in all
applications, you can also create special Font menu settings for specific applications. You
can reorder fonts in the menu, change the display point size and color for individual fonts,
and omit fonts from the menu. This last feature is useful when you have many fonts in-
stalled in your System Folder but tend to use only a handful within certain applications.

For example, when you’re simply writing letters and memos in a word processing applica-
tion, you may use no more than two fonts. In this situation, choosing the font you want is
harder because you have to scroll through all the fonts you won’t use anyway. On the
other hand, when you use a desktop-publishing application to create newsletters and bro-
chures, you probably prefer to have all of your installed fonts available. Now WYSIWYG
Menus lets you specify which fonts are available on an application-specific basis, so you
can customize the Font menu to suit your varying needs.

Now WYSIWYG Menus also lets you modify a font’s family name and style name. You
can use this feature to modify font names when Now WYSIWYG Menus cannot correctly
identify or display them, or to customize font names in all main font menus and submenus.

Isolating damaged fonts

For a variety of reasons, fonts can become damaged and cause system errors. Now
WYSIWYG Menus constantly monitors the fonts in your system and helps you isolate
damaged fonts. Should a system error occur when loading a font at startup or at another
time, Now WYSIWYG Menus isolates and disables it. If the font is in a suitcase file, all
other fonts in the suitcase file are also disabled. The next time you restart your Macintosh,
Now WYSIWYG Menus tells you the name of the damaged font. You should then remove
or reinstall the damaged font to avoid another system error. If the font continues to cause
problems after being reinstalled from the master disk, contact the font’s vendor for more
information.
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Setting options for Font menus

It's easy to change the appearance of your Font menus using the Now WYSIWYG Menus
control panel. It provides options for reordering the fonts in your menus and setting special
colors for fonts, as well as changing font family and style names and other specialized
functions.

Setting basic Font menu options

In the Now WYSIWYG Menus control panel, you can rearrange fonts, determine whether
or not a particular font appears in its actual typeface, and specify which font names and
font colors appear.

To customize Font menus for applications:
1. Open the Now WYSIWYG Menus control panel.

Font Info area
o Indicates if Bitmap, PostScript
Application pop-up menu (PS) or TrueType (TT) versions
Choose which application are available, and shows
the font settings will apply ~ family and style names plus
to (choose “Global” for all  information on how the font

applications) ‘ will appear in the Font menu
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2. Using the “Applications™ pop-up menu, specify where you want the control panel settings to
apply.

To apply the settings... Choose...
To all applications Global
To a single application The name of the application

To an application not on the menkdit...

In the Application Font Settings dialog box that
appears, click “New.” Then select the application
and click “Open.” The application now appears in
the “Applications” menu.

Chapter 13—Now WYSIWYG Menus 213



214

3.

4.
5.

., You can add an application to the menu with the same custom Font menu set-
U~ tings as another application by opening the Application Font Settings dialog
box, selecting the application whose Font menu settings you want to copy,
clicking “Duplicate” in the Application Font Settings dialog box, and then se-
lecting the new application and clicking “Open.” To delete an application from
the list, select an application in the Application Font Settings dialog box and
click “Delete.”

Select a font and then specify settings for it.

In order to... Click the...
Include a font in a menu “Select Font” button or double-click the
font name.
| A checkmark next to a font name indicates
*~  the font will appear in the Font menu.
Move a font down in the list E “Move Font Down” button, or drag the font
to the desired location.
Move a font up in the list @ “Move Font Up” button, or drag the font to
the desired location.
Select color of name in menu “Select Font Color” button and choose a
color from the pop-up menu.
I Since this option is not available on black-
*~ and-white Macintosh systems, the Color
pop-up menu isn’t available in the control
panel.
Select point size of name in me A8 “Change Point Size” button and choose a
=l size from the pop-up menu.
Turn WYSIWYG display on/off E “Change WYSIWYG State” button.

I You may want to turn off WYSIWYG display

*~  for fonts consisting primarily of symbols,
such as Zapf Dingbats, Universe, or Symbol
fonts, as their names will appear in these
symbols otherwise.

Open Font Info dialog box @ “Font Info” button (or click the Font Info

area at upper right); see the next section,
“Using the Font Info dialog box.”

Repeat step 3 as necessary for other fonts.
When you’re finished setting options for fonts, sort your font list if you wish.

In order to... Click the...
Sort all fonts alphabeticall “Sort Fonts” button
p y

Sort selected fonts “Sort Selected Fonts” button
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6. Close the Now WYSIWYG Menus control panel.

Your new Font menu settings are saved.

Using the Font Info dialog box

The Font Info dialog box displays a sample of the selected font and lets you change the
font’s family and style names. By changing font family and style names, you can group
together fonts that are similar or are used for similar purposes. For example, you could
create a family called “Fun Fonts” with members such as San Francisco and Cairo; or a
family called “Monospaced” that contains the monospaced fonts Courier and Monaco.

To illustrate the latter example, you could select the Courier font in the control panel (if
the font has multiple family members, select the family member that you want to modify
from the list at bottom left) and click the “Font Info” button to open the Font Info dialog
box. Change the Family name to “Monospaced,” and change the Style name (Plain) to
“Courier.” Click “OK” to return to the control panel and repeat the procedure with any
other fonts you want to include in the new font family (such as Monaco, for example).

The new font family name now appears in the font menu with Courier, and any other fonts
you added, grouped in the submenu attached to the “Monospaced” menu item. The family
name appears in the font that's at the top of the list of font family members. You can
change the font display size and color to whatever you like.

Font Info: Castellar MT
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This option... Does this...

Family Displays the font family name; change it by selecting it and typing.

.. You can reduce the overall width of the Font menu by decreasing
"V the number of characters in the longest font names.

Style Displays the font style name; change it by selecting it and typing.

Hot Key Lets you define a Hot Key for choosing the font name and style; click in
the field and type the desired key combination. As long as Now Menus is
running, you can use Hot Keys to select fonts. To remove the Hot Key,
select it and press Delete/Backspace.
<1, You can also assign Hot Keys to fonts directly in the Font menu, as

v long as Now Menus is running. To assign a Hot Key this way,
highlight the font in the menu and press the desired key combina-
tion—the Hot Key appears next to the font name on the menu. See
“Assigning Hot Keys directly in menus” in Chapter 4, “Now
Menus” for details.

continued on next page
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This option... Does this...

continued from previous page

Sample Area  Displays the upper- and lower-case alphabet and the numbers 0-9 in the
selected font.

Default Names Resets the font’s Family and Style names to their original names if they
have been changed.

Excluding Now WYSIWYG Menus from applications

By default, Now WYSIWYG Menus displays custom Font menus in all applications. To
display only the standard 12-point Chicago Font menus in a particular application, you
must add it to the Now WYSIWYG Menus excluded applications list.

Exzludn
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To open this dialog box, click the “Exclude Apps” button in the control panel. In the dia-
log box that appears, click “Add,” locate and select the desired application in the directory
dialog box, then click “Open.” The name of the application now appears in the Exclude
dialog box.

To remove an application from the exclusion list, select it and click “Delete.”

To temporarily disable Now WYSIWYG Menus in an application, hold down the Command
key while pulling down a Font, Font Size or Font Style menu—the items in the menu will
be displayed in the standard Chicago 12-point type. (The Command key is the default key
used to temporarily disable Now WYSIWYG Menus. You can change this setting in the
Preferences dialog box.)
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Now WYSIWYG Menus preferences

The Preferences dialog box lets you modify many default settings for Now WYSIWYG
Menus. To open the Preferences dialog box, click the “Preferences” button in the Now
WYSIWYG Menus control panel.
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Basic preferences

This table lists and explains the options available in the main Preferences dialog box.

This option...

Lets you...

Enable WYSIWYG Font menus

Enable WYSIWYG Size menus

Enable WYSIWYG Style menus

Temporary Enable/Disable key

Specify that fonts will appear in the Font menu in their
actual typefaces. When deselected, the font names in
the Font menu appear in the Chicago font.

Specify that the numbers representing the available
point sizes in the Size menu will appear in the cur-
rently-selected typeface scaled to their corresponding
point sizes. For example, if the currently-selected font
is Times, the point size number for 24 point appears in
Times 24 point. This way you can preview how a font
looks at different point sizes.

Specify that the styles in the Style menu will appear in
the currently-selected typeface.

Change the key combination that temporarily enables
or disables Now WYSIWYG Menus from within an
application.

If you choose “Disable” from the pop-up menu (the
default), Now WYSIWYG Menus will be active at all
times, unless you hold down the key specified here
just before pulling down a Font, Size or Style menu—
then these menus will appear in Chicago 12 point.

If you choose “Enable” from the pop-up menu, Now
WYSIWYG Menus will be inactive at all times so that
Font menus appear in Chicago 12 point, unless you
hold down the specified key just before pulling down
a menu—then Font menus will appear in the actual
typefaces.

continued on next page
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This option...

Lets you...

continued from previous page
Display Fonts available

Colors...

Names...

Specify that the Now WYSIWYG Menus control

panel will display only currently-available fonts in its
font list. When this option is not selected, Now
WYSIWYG Menus will display all fonts it has en-
countered on your system, whether or not they are cur-
rently installed.

Open a dialog box to customize the eight colors (and
their names) available for assigning to fonts. See the
next section, “Customizing font colors.”

Open a dialog box to add to the menu names that Now
WYSIWYG Menus recognizes as Font menus. See
“Identifying Font menu names” later in this chapter.

Customizing font colors

If you're using a color Macintosh, you can customize the eight system colors and names
that are available in Now WYSIWYG Menus.

To customize colors in Now WYSIWYG Menus:

1. Click the “Preferences™ button in the control panel.

The Preferences dialog box opens.

2. Click “Colors...” in the Preferences dialog box.

The Colors dialog box opens.
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3. To change the name of a color, sele

ct the corresponding text field and type.

4. To change a color, click the corresponding color square (or click in the color’s name field and then

click *“Change Color...”).

The standard system color wheel appears.

5. Select a new color and click “OK.”

You're returned to the Colors dialog box.

6. Click “OK™ to return to the Prefere
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7.

Click “OK.”

You're returned to the control panel, where you can select font colors for a selected
font from the “Select Font Color” pop-up menu.

|dentifying Font menu names

Many applications display fonts in the Font, Size, and Style pull-down menus. Some appli-
cations display fonts in pull-down or pop-up menus with different, nonstandard names,
such as Text, Format, or Display Size. Now WYSIWYG Menus needs to know the names
of these menus in order to display custom Font menus.

Now WYSIWYG Menus already contains a list of frequently used pull-down and pop-up
menu names for application font menus. If you encounter an application in which Now
WYSIWYG Menus doesn’t seem to function, however, you may need to specify different
font menu names by adding them to this list.

To add font menu names to Now WYSIWYG Menus:

1.

Click the ““Preferences” button in the control panel.
The Preferences dialog box opens.

Click “Names...” in the Preferences dialog box.
The Menu Names dialog box opens.
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Click “Add.”

A dialog box opens where you can type the new menu name.
Enter the menu name that you want to add, then click “OK.”

You can delete a menu name from the list by selecting it and clicking “Delete.”
However, avoid deleting a name unless you are sure that it does not appear in
any of the applications you presently run or plan to run in the future.

Repeat steps 3 and 4 to add any more menu names to the list.

Click “OK.”

You're returned to the Preferences dialog box.

Click “OK.”

You're returned to the Now WYSIWYG Menus control panel.
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Checking available versions in the Font menu

In addition to viewing information on fonts in the Now WYSIWYG Menus control panel,
you can also find out quickly in a Font menu which versions of a particular font are in-
stalled. To do so, just highlight the font in the Font menu and press the tilde key (~)—a
text area pops up, showing you whether the font is available in TrueType (TT), PostScript
(PS) or bitmap versions.
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